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Calyx RIM 6.2 Release Notes

The Release Notes contain information about updated files, new functionality, resolved issues, and any open issues or
workarounds in this release of Calyx RIM®.

The details in these Release Notes supersede all similar details that appear anywhere else in this release of the product
or its other documentation.

New in Calyx RIM 6.2

Calyx RIM 6.2 includes enhancements and also addresses prioritized hotfixes and known issues from previous
versions. The following enhancements, functional changes, and updates are included with this release.

Web Browsers
Calyx RIM 6.2 provides support for the following Web browsers:
— Microsoft Internet Explorer (IE) 11 (set Compatibility View Settings to Off)
— Microsoft Edge (supported on Windows 10 only)
— Google Chrome

Note: Please note that Calyx RIM for Analytics module is not compatible with the Microsoft Edge browser.

Single Sign On (SSO)
Calyx RIM single sign on (SSO) will enable authorized users who are authenticated by your enterprise's SSO the
capability to access LIQUENT InSight without the need to login again.

Calyx RIM API
LIQUENT InSight 6.2 provides an application programming interface (API) for integration with external systems.
The Calyx RIM API enables external systems to access data within LIQUENT InSight and to perform actions such as
create, read, update, and delete. New platform components can integrate with the LIQUENT InSight API, and will
observe authentication and authorisation rules.

New Assembly Tree
Calyx RIM 6.2 completes the transition to the new version of the assembly tree introduced in Calyx RIM 6.1 CHF
3. The legacy assembly tree option is no longer available.

This release also discontinues support of the drag-and-drop node assignments between assemblies opened in separate
browser windows. The Import Assembly wizard should be used to copy content between different assemblies.

The new assembly tree enables the following functionality:
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— Drag assembly elements to in-between nodes and filter the assembly tree elements using the new assembly tree
search option.

— Set a limit to the number of assembly elements displayed on the new version of the assembly tree as a result of a
search operation.

— Set a limit to the number of nodes that can be expanded in the new version of the assembly tree.
— Drag a TOC onto the icon corresponding to a volume.
— Calyx RIM 6.2 enhances the TOC tree to allow selecting multiple nodes and dragging them in between the other

nodes when modifying a TOC.

Cross-site Scripting (XSS) Filtering
Calyx RIM 6.2 includes Cross-site Scripting (XSS) filtering that prevents users from adding malicious script codes in
the form of user input in an attempt to access data.

Performance Improvements
Calyx RIM 6.2 provides performance improvements for the following:
— Manufacturer Report Analytics Predefined Report functionality.
— XEVMPD Audit Report functionality.
— DMS Synchronization functionality invoked from the Publishing View of the Assembly.
— Updating the Publishing Settings to add or remove a DTD.
— Expanding the nodes in the Assembly Tree and refreshing the expanded Assembly Tree.
— Queries related to getting Events under Application, actions with the XEVMPD change history, and DTD change

for an Assembly have been optimized to reduce the possibility of database locks. As part of this optimization, a
new index has been added to the XEVMPD change history.

OpenText Documentum D2 Integration
Calyx RIM 6.2 enhances the capability to harmonize data between Calyx RIM and OpenText Documentum D2:
— When a Product Family is created in Calyx RIM, both a Product Registration Form and a Project Registration

Form will be created within Documentum D2.
— When an Application is created under a Product Family in Calyx RIM, a Regulatory Application Registration

Form (RARF) will be created within Documentum D2.
— When a Sequence is created within a Product Family in Calyx RIM, a Submission Registration Form (SARF) will

be created within Documentum D2.

Note: The Product Registration Form, Project Registration Form, RARF, and SARF are created only if the Product Family
type is one of the following:
— Pharmaceutical
— Pharmaceutical-Medical Device
— Any custom Product Family type that is mapped to the Pharmaceutical or Pharmaceutical-Medical Device internal type
— Any Product Family type in Data Administration that is modified and mapped to any of the Pharmaceutical or

Pharmaceutical-Medical Device internal type
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The created Product Registration Form, Project Registration Form, Regulatory Application Registration Form, and
Submission Registration Form will then be updated according to the changes made to Product Family within Calyx
RIM.

Updates to D2 forms (Product Registration Form, Project Registration Form, Regulatory Application Registration
Form, and Submission Registration Form) may result in updates to the PDS status. Allowed PDS Status values
include:
— Pending Add
— Approved
— Not Approved

The out-of-the-box configuration can be modified to match your need. To understand more about the available
Documentum D2 mapping for Product Registration Forms, Project Registration Forms, Regulatory Application
Registration Forms (RARF), Submission Registration Forms (SRF), please contact your Calyx RIM account
representative.

D2 Data Dictionaries

Starting with Calyx RIM 6.2, the following D2 Data Dictionaries are supported:
— Application Status
— Application Type
— Geographic Regions
— Regulatory Submission Type
— Route of Administration List
— Submission Country
— Submission Status
— Dosage Levels
— Dosage Forms
— Health Authority

Regulatory Updates

Australia eCTD Module 1 Specification Version 3.1
Calyx RIM 6.2 supports Australia eCTD Module 1 Specification Version 3.1. The following structural updates are
provided with this Specification Version:
— The following sections are added to the 1 Administration Information and Prescribing Information > 1.3

Medicine information and labeling folder:
• 1.3.1.3 Product information - approved
• 1.3.2.3 Consumer medicine information - approved

— The following sections are updated in the 1 Administration Information and Prescribing Information >
1.3 Medicine information and labeling folder:
• 1.3.1.3 Package Insert section now appears as 1.3.1.4 Package Insert
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• 1.3.3 Label mock-ups and specimens section is split to be 1.3.3.1 Label mock-ups and
specimens - clean, 1.3.3.2 Label mock-ups and specimens - annotated, and 1.3.3.3 Label
mock-ups and specimens approved

• 1.5.2 Orphan designation section now appears as 1.5.2 Designation applications - supporting
documents

Calyx RIM 6.2 also supports the AU NeeS v2.0 specification. This new NeeS version TGA (Therapeutic Goods
Administration) introduces Envelope Form to provide greater validation of NeeS Submissions and automation of the
uploading processes. The envelope form is an XML file with information from Envelope. The NeeS format dossier
must contain tables of contents (TOC) in PDF format. The XML file should be included in the 1001-cover
folder of the NeeS application and it should be referenced by the m1-toc.pdf.

Please note that the previous specifications versions will be acceptable for use until 30 June 2018.

This specification introduces the following updates to Data Administration:
— New sequence types has been added to the Sequence Maintenance > Filing Type Values table:

• Provisional Registration - TGA initiated variation
• Notification
• CN
• Extension of Provisional Registration
• Duplicate

— The following sequence type has been updated in the Sequence Maintenance > Filing Type Values table:
• Withdrawal filing type has been updated to be Product Withdrawal.

— New Sequence Description value has been added to the Submission Maintenance > Sequence Description
Values table:
• Provisional approval - rolling data submission - {date: d}

— New Regulatory Activity Lead value has been added to the Submission Maintenance > Regulatory Activity
Lead Values table:
• Prescription meds-biological

European Union eCTD Module 1 Specification Version 3.0.3
Calyx RIM 6.2 supports EU eCTD Module 1 Specification Version 3.0.3.

The EU eCTD Module 1 Specification has been updated to reflect clarifications of the 3.0.1 version in the 3.0.3
version. Version 3.0.3 is in force immediately and is recommended to be used as soon possible. There are no changes
to the DTD in this version (version 3.0.1 is still valid) and the validation criterion has not changed as a result of this
update.

The following updates are introduced:
— For the Centralised (CP) template, in the 1.2 Application Form > 1.2 EMA folder:

• The Application Form leaf has been renamed to be Application Form Annex (the Use Native File
parameter is set to No).

• A new leaf has been added Application Form eAF (the Use Native File parameter is set to Yes).
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— For the National (NP) and Mutual Recognition (MRP)/Decentralised (DCP) templates in the 1.2 Application
Form > Country folder:
• The Application Form leaf has been renamed to be Application Form Annex (the Use Native File

parameter is set to No).
• A new leaf has been added Application Form eAF (the Use Native File parameter is set to Yes).

STF Stylesheet v2.3 Support
Calyx RIM 6.2 introduces support for the ICH STF Stylesheet v2.3.

Best Practices for Publishing
The following topics on best practices for publishing have been updated in the Online help:
— Complying with the Study Data Technical Conformance Guide v4.1
— Updating an AU Submission to Migrate to v3.1

Withdraw Country Updates
Calyx RIM 6.2 updates how withdrawn Application Countries are filtered in the Country fields of Mutual
Recognition Procedure (MRP) and Decentralised Procedure (DCP) procedures. On application-related entities,
withdrawn application countries that have a Withdraw Date value that equals today’s date or earlier can no longer be
selected for the following:
— Event > Countries field when adding an Event
— Sequence > Concerned Member States field when adding a Sequence
— Registration > Country field when adding a Registration
— Product Detail Set > Label > Label Country field when adding a Label Detail
— Product Detail Set > Country > Country field when adding a Country Detail
— Product Detail Set > Indication/Intended Use > Countries field when adding or modifying an Indication/

Intended Use Detail (non-Veterinary Product Detail Sets)
— Product Detail Set > Species Indication > Countries field when adding or modifying an Indication Use

Detail (for Veterinary Product Detail Sets)
— Product Detail Set > Manufacturer > Countries field when adding or modifying a Manufacturer for the

following parent Product Detail Set Details:
• Active Ingredient
• Active Ingredient Manufacturing Process Function
• Active Ingredient Manufacturing Process Step Function
• Active Ingredient Manufacturing Process Step Material
• Component Function
• Component Manufacturing Process Function
• Component Manufacturing Process Step Function
• Component Manufacturing Process Step Material
• Package Set Component Packaging
• Package Set Function
• Package Set Packaging
• Product Detail Set Function
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• Product Detail Set Manufacturing Process Function
• Product Detail Set Manufacturing Process Step Function
• Product Detail Set Manufacturing Process Step Material
• Substance
• Substance Manufacturing Process Function
• Substance Manufacturing Process Step Function
• Substance Manufacturing Process Step Material

The Countries tab on the Application Attributes page has been enhanced by adding a new column named
Withdraw Date.

The logic of populating the Withdraw Date for an Application Country has changed. The following rules apply to
the Application Country > Withdraw Date if this specific country is associated to the Country PDS Detail:
— If the Country Status field of the related Country PDS Detail is modified to Approved, the Application

Country > Withdraw Date field is automatically updated to be equal to Today's Date.
— If the Event is closed as Approved, meaning it has the Associations Closed As field set to APPROVED, the

Application Country > Withdrawn Date field is automatically updated to be equal to Event Closed Date
value. As an additional rule, the withdrawn Country PDS Detail > Country Status field is automatically
updated to Approved. See If the Event Is Closed with the Status Approved.

Note: The Update Status and Update Event Country Status wizards, launched from the Event > Countries
tab and Project > Event Country Dates tab, has been updated accordingly. The following new messages have been
added:
• Confirmation page: The Withdraw Date will be set to <Event Closed As Date>

for <Country that is being withdrawn>.
• Summary page: The Withdraw Date was set to <Event Closed As Date> for

<Country that is being withdrawn>.

This enhancement updates a variety of existing queries and adds a new Product Detail Management query named
List of Application Countries with PDS Country and Registration Details. See the Queries section.

See Entity Fields Updated: Calyx RIM 6.2 and Entity Fields Added: Calyx RIM 6.2.

Global Project Plan Wizard
Calyx RIM 6.2 enhances the Global Project Plan (GPP) wizard by adding new process flows:
— Add Manufacturing Process
— Add Manufacturing Process Step Function
— Add Material
— Add Substance
— Modify Active Ingredient
— Modify Manufacturing Process Step
— Modify Manufacturing Process Step Function
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— Modify Material
— Modify Packaging for Package Set
— Modify Substance
— Withdraw Material
— Withdraw Substance
— Replace Manufacturing Process Step Function

To support the enhancement to display the Manufacturer Name value as a concatenation of Manufacturer
Name + Address Line 1 + Country Code values, the following Global Project Plan > Update
Product Detail Sets project flows have been updated:
— Add Active Ingredient Manufacturer
— Add Active Ingredient Manufacturing Process Function Manufacturer
— Add Substance Manufacturer flow
— Add Substance Manufacturing Process Function Manufacturer
— Add Component Function Manufacturer flow
— Add Component Manufacturing Process Function Manufacturer
— Add PDS Function Manufacturer flow
— Add PDS Manufacturing Process Function Manufacturer
— Add Package Set Function Manufacturer
— Add Package Set Packaging Manufacturer
— Add Package Set Component Packaging Manufacturer

Calyx RIM 6.2 enhances the Global Project Plan wizard by adding the multi-select field Application Type as an
additional filter criterion for the following project types:
— Create New Events Package Set Registration > Search by Product, Country and Application Status

page
— Update Product Detail Sets > Input Query Filter Criteria page, when searching by:

• Active Ingredient
• PDS Code/PDS Name
• Product and Country
• Substance
• Trade Name

— Create New Events Product Registration > Search Country and Application Status page
— Withdraw Product Package Set Registration > Search by Product, Country Application and PDS

Statuses page

Events
Calyx RIM 6.2 introduces new rules to enforce Event uniqueness within an Application. The Event Name and Event
Code combination must be unique within an Application.

Calyx RIM 6.2 enhances the Event entity by renaming the Event Closed As field as Associations Closed As and
the Event Closed Date field as Closed Date. The following has been updated accordingly:
— View Event Attributes page for the closed events.
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— Modify Event Attributes page, if the Closed checkbox is selected.
— Wizards > Update Status > Update Event Country Status page, if the Close Event? drop-down field is

set to Yes.
— Project > Event Country Dates > Update Project Event Country Status wizard, if the Close Event?

drop-down field is set to Yes.

This enhancement also provides a variety of updates to existing queries. See Queries section.

See Entity Fields Updated: Calyx RIM 6.2

Projects
Calyx RIM 6.2 enables Sequences to be updated in bulk within a project. The Project Attributes page has been
enhanced by adding the Bulk Update Sequences icon that launches the Bulk Update Sequences wizard.

With Calyx RIM 6.2, the PLANNED status has been added to the following fields:
— Project Pivot Status drop-down field on the Create/Modify Project Attributes page.
— Enter Project Pivot Values > Project Pivot Status drop-down field of the Calculate Projected Dates

wizard (Global Project Plan wizard).

Product Detail Sets (PDS)
Calyx RIM 6.2 enhances the Countries field on the Add Indication/Intended Use detail page for Non-
Veterinary Product Detail Set (PDS) and the Add Indication detail page for Veterinary Product Detail Set (PDS).
By default, all countries of the associated Application appear in the Selected box of the Countries multi-select
field. You can deselect countries, if needed.

To enforce PDS uniqueness within an application, a PDS name must now be unique.

To enforce PDS template uniqueness within a product, a Product name must now be unique.

The Specialty Number field has been renamed to be Speciality Number.

To ensure the Excipient Role field availability for all substance types in the Product Detail Set and Product Detail
Set Template, Calyx RIM 6.2 renames the Excipient Role field for the Substance Detail as Substance Role. The
Substance Role field appears on the Add Substance page regardless of the selected Substance Type value.

Starting with Calyx RIM 6.2, the Manufacturer Name value is displayed as a concatenation of Manufacturer
Name + Address Line 1 + Country Code values in the Manufacturer field for each Product Detail
Set > Manufacturer Detail instance. This update includes enhancements to the following Calyx RIM areas:
— Data Administration > Product Detail Set Maintenance > Manufacturer Values table
— Product Detail Management, Registration Planning and Tracking, and Administration Queries
— A variety of Global Project Plan Wizard > Update Product Detail Sets project flows
— Comparator > Supplier field

A new configured field named Local Route of Administration for tracking country Route of Administration at the
PDS level has been added to the PDS Attributes page.
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Note: This field is hidden by default and can be enabled via custom XML overrides.

See the corresponding sections in the New in Calyx RIM 6.2, Entity Fields Updated: Calyx RIM 6.2, and Data
Administration Tables: Calyx RIM 6.2.

Products
Calyx RIM 6.2 enhances the following Product Strength-related fields to display a leading zero value for the decimal
numbers that are less than 1 in the Product Strength field on the View Product Attributes page:
— Product Strength Measure 1
— Product Strength Measure 2

A new entity named Country Specific Detail has been introduced for the Products of Medical Device and
Pharmaceutical Medical Device types.

See Entity Fields Added: Calyx RIM 6.2

Applications
Starting with Calyx RIM 6.2, the Application Status of an Application can be set to the Application Status
mapped to the internal WITHDRAWN status only when all Registrations associated to this Application have a status
mapped to the internal WITHDRAWN status.

The Update Status and Update Event-Country Status wizards mapped to the internal WITHDRAWN status
reflect this enhancement. If you set Associations Closed As to WITHDRAWN, the Application Status will be set
to WITHDRAWN only when all Registrations associated to this Application have a status mapped to the internal
WITHDRAWN status. Otherwise, the warning message appears ! Associated Registration(s) must
be Withdrawn prior to the Application.

See Entity Fields Updated: Calyx RIM 6.2

Registrations
In Calyx RIM 6.2, the logic of the Copy Package Set Registration wizard has been reworked for the MRP
(Mutual Recognition Procedure) and DCP (Decentralised Procedure) Application types to provide the ability to
select the country to copy the Package Set Registration. A new drop-down list named Country now appears on the
following wizard pages for the MRP and DCP Application types:
— New Package Set specific Registration(s) > Select Product Detail Set page
— New Product specific Registration(s) > Copy License Code page

A new field named Legal Basis has been added to the Package Set Registration entity. The Registration
Attributes > Entity History Query and Querying > Administration > Entity Audit Trail queries have been
updated to display the correct values for the new Legal Basis field. This update includes enhancements to the
following Calyx RIM areas:
— Data Administration > Application Maintenance and Data Administration > Other sections
— XEVMPD Submission Wizard data collection logic
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See the corresponding sections in the topics: New in Calyx RIM 6.2, Entity Fields Added: Calyx RIM 6.2, and Data
Administration Tables: Calyx RIM 6.2.

Full Product Presentations
With Calyx RIM 6.2, the MPID (Medicinal Product Identifier) field has been hidden on the Full Product
Presentation View, Create, and Modify pages.

Calyx RIM 6.2 enhances the Full Product Presentation Attributes entity by adding the following new fields:
— Formulation Part
— Intended Use Part
— Target Population Part
— Container or Pack Part
— Device Part
— Time Period Part
— Flavour Part
— Countries

To enable the Previous EV Code value for the Full Product Presentation entity to be added manually, Calyx RIM 6.2
provides the following enhancements:
— The Authorised Product option has been hidden from the Data Administration > Other > Previous EV Code

Values > Code Type drop-down list.
— The Full Product Presentation > Previous EV Code drop-down list has been reworked to be the FPP

Previous EV Codes tab on the Full Product Presentation Attributes page. If there are several Previous EV
Code values, this will result in several <previousevcode> tags being added to the XEVMPD XML file.

Calyx RIM 6.2 updates the uniqueness rule for the Full Product Presentation entity to have the concatenation of the
following fields unique within the Registration: Full Product Name, EEA Country, Language, Package
Description, Authorisation Status, Authorisation/Renewal Date, and EV Code.

See Entity Fields Added: Calyx RIM 6.2, and Data Administration Tables: Calyx RIM 6.2.

Registration FPP Attachments
With Calyx RIM 6.2, the Attachment Name field has been reworked to be a Registration Attachment
Selection list on the Create Registration FPP Attachment page. Once selected, the search results page displays
all Active Registration Attachments that are available in the system and are not associated to the current Full
Product Presentation.

See Entity Fields Updated: Calyx RIM 6.2.

Registration Attachments
Using XML overrides, Calyx RIM 6.2 can be configured to disable the autopopulate function for one or more
Registration Attachment fields, if the Attachment file is uploaded from a DMS Repository:
— Attachment Name
— File Name
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— File Type
— Attachment Version

For details, please contact your Business Development Representative to consult with our Client Enablement team.

References
To enforce Reference uniqueness within its parent entity, a Reference name must be unique.

Tasks
To enforce Task uniqueness within its parent entity, a Task name must be unique.

To provide the ability to identify the association between the parent Task and its Sub-Task, Calyx RIM 6.2 enhances
the Task entity by adding a new field named Related Task Name. When a Task has an associated Sub-Task entity,
the Related Task Name field for the Sub-Task will be automatically populated with the parent Task Name value.
This field will always be empty for the parent Task entity.

With Calyx RIM 6.2 release, the inactive or disabled users are omitted from the lists of available values (username;
or username (email address) combination) for the following Task entity fields:
— Assigner drop-down list
— Premier Assignee drop-down list
— Task Concerned Parties popup window

See Entity Fields Added: Calyx RIM 6.2 and Query Fields Added: Calyx RIM 6.2.

Workflows
Calyx RIM 6.2 includes the following enhancements in the optional Calyx RIM Workflow Integration module to
provide support for the XEVMPD entities:
— This release provides the ability to configure a workflow XML file to create and update the following entities:

• Active Ingredient
• Component
• FPP Previous EV Code
• Full Product Presentation
• PDS Details: Active Ingredient
• PDS Details: Flu Strain
• PDS Details: Indication
• PDS Details: Indication/Intended Use
• PDS Details: Package Set
• PDS Details: Reference Strain
• PDS Details: Substance
• Pharmaceutical Product
• Product
• Product Family
• Reference Active Ingredient
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• Registration Attachment
• Registration FPP Attachment

— The following additional tabs are added to the Full Product Presentation Attributes page:
• Activities
• Workflows

With Calyx RIM 6.2, it is now possible to associate a Package Set to a Registration via workflow.

Find
The Find > Activities functionality, available on the Calyx RIM home page, has been enhanced with a new
Workflow-related report and now enables you to find the activities associated with the XEVMPD-related entities.
The Entity Type drop-down list available on the View Activities List page is updated with a new entity type named
XEVMPD.

SPOR Integration
To support the integration with EMA OMS and RMS API, to enable adding the controlled vocabulary for
organisations and referentials data from the external system, and to enable the authentication between Calyx RIM
system and SPOR API client, Calyx RIM 6.2 provides the ability to enable and configure the SPOR services through
the appropriate options in the insightConfig.bat or insight.var files:
— In the insightConfig.bat file, in the newly introduced SPOR API Settings section, values for the

Enable SPOR API for RMS, Enable SPOR API for OMS, Defined Interval
(minutes), User Name, and Password options must be set.

OR

— In the insight.var file, in the newly introduced SPOR API SETTINGS section, values for the
spor.api.enable.rms, spor.api.enable.oms, spor.api.update.interval.minutes,
spor.api.user, and spor.api.password options must be set.

XEVMPD Submission Wizard
With Calyx RIM 6.2, the mrpnumber generated by the XEVMPD Submission wizard is displayed without a space
between Procedure Identifier/Application Code and Speciality Number. For example: [Procedure Identifier/
Application Code][Speciality Number1].

Calyx RIM 6.2 enhances the XEVMPD submission data collection features. Although the Package Set information is
not included in the XEVMPD submission, the Package Set assigned to the Full Product Presentation will determine
the Active Ingredient, Substance, Indication/Intended Use (non-Veterinary), or Species Indication (Veterinary) PDS
Details to be included. Only those PDS Details, with Package Set from the parent PDS associated to the Full Product
Presentation, are included in the XEVMPD submission.

Important: If any Package Set is associated to the Registration, but is not associated to the Full Product Presentation
under the Registration, then the Active Ingredient, Substance, Indication/Intended Use (non-Veterinary), or Species
Indication (Veterinary) Details of the parent Product Details Set are not included in the XEVMPD submission.

With Calyx RIM 6.2, the Initial Report option has been hidden in the XEVMPD Submission wizard:
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— The Run Initial Report? drop-down has been hidden on the Select Sender/Receiver Information page.
— The Initial Report Selection and Initial Report Selection Results pages that appeared when the Run Initial

Report? drop-down field was set to Yes, has been hidden in the wizard.

Calyx RIM 6.2 enhances the Package Set Registration entity by adding the new field named Legal Basis. The
Registration > Legal Basis value is included in the XEVMPD Submission XML file instead of the Application >
Legal Basis value, if:
— The field is populated with a value for both entities.
— The Application > Legal Basis field is not populated with a value.

Calyx RIM 6.2 provides an additional enhancement to the XEVMPD submission data collection features and now
allows the Route of Administration value to be taken into an XEVMPD submission from the PDS level. A new
configured field named Local Route of Administration for tracking country Route of Administration on the PDS
level has been added to the PDS Attributes page. This field is hidden by default and can be enabled via the overrides.

A new validation has been added to the XEVMPD Submission wizard invoked for the Authorised Product flow.
When the MFL (Master File Location) value is not selected for a Registration being submitted, a warning message
appears indicating that the MFL is required for this operation type. To be able to proceed with
the wizard and have the MFL tag included in the submission XML file, the MFL value on the Registration Attributes
page must be defined.

Note: The MFL value is mandatory for Insert, Update and Invalidate MA operation types.

Calyx RIM 6.2 enhances the XEVMPD Submission wizard to take the prior approved PDS Detail from the previous
Event into the XEVMPD Submission if the current PDS Detail has one of the following statuses:
— Pending Modify
— Pending Withdrawal

This enhancement is applicable to the following PDS Details:
— Active Ingredient (including the Reference Active Ingredient logic)
— Indication/Indented Use
— Indication (under Veterinary Product Family)
— Strain
— Reference Strain
— Substance (Excipient, Adjuvant, and Substance entities used as Active Ingredient)

The PDS Details with status set to Withdrawn are not:
— Included into XEVMPD Submission
— Displayed in the XEVMPD Audit Analytics report

See Entity Fields Added: Calyx RIM 6.2, Entity Fields Updated: Calyx RIM 6.2 and Data Administration Tables: Calyx
RIM 6.2
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Create Submission Wizard
Calyx RIM 6.2 enhances the Create Submission Wizard > Initial Application flow. The Event Type field is now
available for modifications on the Complete Submission Properties (event/sequence) page. The drop-down
field displays all Active values from Data Administration > Event Maintenance > Event Type Values.

See Entity Fields Updated: Calyx RIM 6.2

Change Submittal Status Wizard
Calyx RIM 6.2 enhances the logic of determining the Confirmed Sequence Code value in the Change Submittal
Status wizard. The Confirmed Sequence Code value is determined based on the number of sequences that have been
submitted to this application lifecycle, and now considers all previously submitted sequences, even if the current
Sequence Status is set to Approved.

See Entity Fields Updated: Calyx RIM 6.2

Submitted Views
Calyx RIM 6.2 provides the ability to edit the Reference Leaf elements in the Unlocked Submitted View of a
Sequence Assembly, if the following rules are met:
— To modify a Reference Leaf element in the unlocked submitted assembly plan view, in Security Administration

you must have the Entity Security > Submission Plans set to at least WRITE and Entity Security >
Sequence Assemblies set to ADMIN.

— To modify a Reference Leaf element in the unlocked submitted assembly view, in Security Administration you
must have the Application Country Rights set to at least WRITE and Entity Security > Sequence
Assemblies set to ADMIN.

Assemblies
The following Assembly enhancements have been introduced in Calyx RIM 6.2:

— Search for the folder and leaf assembly elements by the values of the extended attributes.
— Search for leafs that are operated in parallel sequences.
— When filtering an assembly tree, you can now select a node type as a criterion to narrow the search results.
— Ability to select and delete multiple assembly nodes simultaneously.
— The delete (Withdraw) lifecycle operation is now available in the right-click menu for multiple selected leafs.

Volumes
Calyx RIM 6.2 provides the ability to delete the first and the last elements in a Volume:
— Assembly tree elements can be deleted from the Locked Volume
— Assembly tree elements can be deleted from the Unlocked Volume

After the element is deleted, the volume structure will be adjusted automatically to start, finish, or continue from the
next or previous assembly tree element within the volume range.
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Queries
Calyx RIM 6.2 provides the following enhancements to the List of Applications with Products Registration
Planning and Tracking query:
— You can now search for all application types available in the system. All application types are displayed and

available for selection in the Application Type multi-select list.
— The Application Name field has been renamed to be Application Name/Study Number. The Application

Name/Study Number field is displayed on the List of Applications with Products Query search criteria
selection page and appears as a column on the Search Results page.

Calyx RIM 6.2 enhances the Entity Audit Trail Administration Query for the Full Product Presentation entity to
include the newly introduced fields:
— Formulation Part
— Intended Use Part
— Target Population Part
— Container or Pack Part
— Device Part
— Time Period Part
— Flavour Part

Calyx RIM 6.2 enhances the Entity Audit Trail Administration Query to add support for the CT Shared Data.
The CT Shared Data option is added to the Entity Type multi-select list.

To reflect renaming of the Excipient Role field for the Substance Detail as Substance Role and the Excipient
Name to a Substance Name, the following Administration and Product Details Management queries have been
updated to display Substance Role and Substance Name column names:
— Application History Query > Substance Details Changed? subquery
— Application QC Status History Report > Substance Details QC Passed? subquery
— Entity Audit Trial > Product Detail-Substances entity type
— List of Excipient Manufacturers
— List of Registrations with Excipients

To support the enhancement to display the Manufacturer Name value as a concatenation of Manufacturer
Name + Address Line 1 + Country Code values, the following queries have been updated:
— Queries > Registration Planning and Tracking:

• List of Manufacturers From Data Administration
— Queries > Product Detail Management:

• Application History Query
• Application QC Status History Report
• List of Active Ingredient Manufacturers
• List of Active Ingredient Function Manufacturers
• List of Active Ingredient Material Manufacturers
• List of Excipient Manufacturers

Calyx RIM 6.2 Release Notes

© Calyx™ 2023. 15 Calyx RIM 6.2 Release Notes
Calyx.ai New in Calyx RIM 6.2



• List of PDS Manufacturers
• List of Component Manufacturers
• List of Package Set Manufacturers

— Queries > Administration:
• Entity Audit Trail

To support the Withdraw Country enhancement, Calyx RIM 6.2 introduces a new Product Detail Management
query named List of Application Countries with PDS Country and Registration Details. This is designed to
query for countries based on the Application Country information as well as the related PDS Country information:
Registration, Registration Package Set, and Registration Package Set Country information. The hyperlinked attributes
on the report Search Results page will navigate you to the related entity attributes page. The following queries have
been updated with a new drop-down list named Applications with Withdrawn Country:
— Registration Planning and Tracking > List of Application Countries with Registration Details
— Product Detail Management > List of Application Countries with Registration and Product Details
— Submission Planning and Tracking > List of Application Countries

The following reports have been updated to support the renaming of the Event Closed As field to Associations
Closed As and the Event Closed Date field to Closed Date on the Event attributes page:
— Querying > Registration Planning and Tracking queries:

• List of Products with Event and Product Registration Details
• List of Events with Application Properties
• List of Sequences with Application and Event Properties

— Querying > Product Detail Management queries:
• Application History Query
• Application QC Status History Report
• List of Product Detail Sets

— Querying > Registered Document Analysis > Registered Document Query.
— Event Attributes > Entity History Query

To support the enhancement of providing the ability to identify the association between the parent Task and its Sub-
Task, the following Registration Planning and Tracking queries have been updated with a new filter field named
Related Task Name (enter parent Task/Sub-Task name if any):
— List of Tasks
— List of Tasks - Rollup by Product Family
— List of Tasks - Rollup by Application
— List of Tasks - Rollup by Project

The following changes are also introduced to support this enhancement:
— The listed Registration Planning and Tracking queries have been updated to add a new column named Related

Task Name to the Search Results page. The value in the column is hyperlinked. When selected, navigates you
to the appropriate Task Attributes page.

— The Related Task Name column has been added to the Querying > Administration > Entity Audit Trail >
Query table when querying for the Task entity. The value is not hyperlinked.
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Calyx RIM 6.2 enhances the Entity Audit Trail Administration Query to add support for the CT Shared Data.
The CT Shared Data option is added to the Entity Type multi-select list.

Search
The SEARCH function on the menu bar now includes the ability to search for sequences. You can search for
sequences filtered by specific text found in the Name, Code, Keywords, or Description attributes.

To support the enhancement of providing the ability to identify the association between the parent Task and its Sub-
Task, the Related Task Name column has been added to the Search Results page of the SEARCH function on
the menu bar when invoked for the Tasks/Sub-tasks option. The value in the column is hyperlinked. When
selected, navigates you to the appropriate Task Attributes page.

Analytics
The Analytics Schema (DM schema) has been updated:
— The DM schema includes views for reporting on audit data.
— All views affected by changes in this release are also updated in the DM Schema.
— The DM schema was updated with the view containing chronological representation of Sequences and References.

Analytics Predefined Reports
Calyx RIM 6.2 enhances the XEVMPD Audit Analytics Predefined Report to include an additional filter named
Message Sender. An additional column named Message Sender has been added to the XEVMPD Audit
Analytics Predefined Report results page.
The XEVMPD Audit Analytics Predefined Report logic for displaying the following list of entities has been updated
to consider the Package Set-Full Product Presentation association instead of the Package Set-Registration:

XEVMPD Entity Type InSight Entity Type

Authorised Product - Authorisation PDS

Authorised Product - Product Indications Indications/Intended Use

Pharmaceutical Product Pharmaceutical Product

Pharmaceutical Product - Active Ingredient Component Active Ingredient

Pharmaceutical Product - Active Ingredient PDS Active Ingredient

Pharmaceutical Product - Active Ingredient PDS Substance

Pharmaceutical Product - Active Ingredient Reference Active Ingredient

Pharmaceutical Product - Adjuvant Adjuvant

Pharmaceutical Product - Administration Route Component

Pharmaceutical Product - Administration Route Product

Pharmaceutical Product - Excipient Excipient

Pharmaceutical Product - Medical Devices Pharmaceutical Product
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Job Requests
Calyx RIM 6.2 enhances the Job Requests functionality to work with the data exchange user and receive the results
of actions performed by the user.

Data Exchange
Calyx RIM Data Exchange enables you to import the following types of records into the Calyx RIM database:
— Legal Status Values
— Registration Status Values
— Event Country
— Event Country Status
— Product Detail Set (PDS)

Note: To be able to import PDS data via Calyx RIM Data Exchange, the parent Event entity must have the Status
ofOpen.

— PDS Substance Component Detail
— PDS Flu Strain Detail
— PDS Reference Strain Detail
— PDS Species Indication Detail
— Region Values

Calyx RIM 6.2 enhances Data Exchange by adding the User Authentication, Authorisation, and Auditing support.

Data Administration
Calyx RIM 6.2 provides a variety of updates to Data Administration section:
— The Region Type Values table in the Application Maintenance section has been updated with a new default

region type named IDMP.
— The Region Values table in the Application Maintenance section has been updated with a new region named

IDMP Integration.
— A new field named Organisation Identifier has been added to the following Data Administration tables:

• Product Detail Set Maintenance > Manufacturer Values
• Other > MAH/Development Sponsor/Oranisation Values
• Application Maintenance > Country Values > Health Authority

— The Procedure Type Values table in the Application Maintenance section has been updated by adding a new
field named IDMP Internal Procedure Code.

— In the Registration Maintenance > Registration Status Values, the Internal System Status field has
been updated with a new internal status named APPROVED.

To maintain the integration with Organisations management service (OMS) introduced by European Medicines
Agency (EMA), Calyx RIM 6.2 provides the following enhancements:
— The Data Administration > Other Maintenance > MAH/Development Sponsor/Organisation Values

table is updated by adding the following fields:
• Location Identifier
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• Location Status
— The following Data Administration Tables have been updated to include a new drop-down list named RMS

Term Name:
• Application Maintenance > Country Values
• Application Maintenance > Procedure Type Values
• Other > Concentration Measure Type Values
• Other > Denominator Unit Values
• Other > Language Values
• Other > Legal Basis Values
• Other > Numerator Unit Values
• Other > Unit of Measure Prefix Values
• Product Detail Set Maintenance > Compendial Designation/Source Values
• Product Family Maintenance > ATC Values
• Product Maintenance > Dosage/Pharmaceutical Form Values
• Product Maintenance > Medical Device Values
• Product Maintenance > Route of Administration Values
• Registration Maintenance > EMA Authorisation Status Values
• Registration Maintenance > Medicinal Product Type Values

To make the Excipient Role field available for all substance types in the Product Detail Set and Product Detail Set
Template, the Data Administration > Product Detail Set Maintenance > Excipient Role Values table is
renamed as Substance Role Values.

Calyx RIM 6.2 introduces the SPOR Maintenance section in Data Administration. This section is designed to
maintain the European Medicines Agency (EMA) Substance, Product, Organisation and Referential (SPOR) service
compliance. According to the roadmap designed by EMA the SPOR support starts with an introduction of OMS
(Organisations management service) and RMS (Referentials management service) components.

To enable the Manufacturer Name value to be displayed as a concatenation of Manufacturer Name +
Address Line 1 + Country Code values in the Manufacturer field for each Product Detail Set >
Manufacturer Detail instance, Calyx RIM 6.2 introduces the following enhancements to the Data
Administration > Manufacturer Values > Manufacturer value attributes page:
— The Country text field has been reworked to be a drop-down list with all active Country values from the Data

Administration > Country Values table available for selection.
— The Country Code drop-down list is no longer presented on the Create/Modify Manufacturer attributes page.

To identify medical devices and also facilitate data exchange between manufacturers, regulators, and healthcare
authorities, Global Medical Device Nomenclature (GMDN) Code Values has been introduced under Data
Administration > Product Maintenance section.

To maintain the specific detail type value of the country attribute, the Product Maintenance section in Data
Administration has been updated with the following new tables:
— Country Specific Detail Type Values
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— Country Specific Detail Values

To maintain the applicable standard version, the Applicable Standards Values table has been updated to include the
Version of Standard option.

To identify, process, retrieve, transfer, and communicate data about medical devices, the UMDNS Code Values
option has been introduced under Data Administration > Product Maintenance section.

For the enhancement that adds a new field named Legal Basis to the Package Set Registration entity, the Legal
Basis Values table has been removed from the Data Administration > Application Maintenance section and is
now included in the Data Administration > Other section.

The following tables have been removed from the Calyx RIM 6.2 Data Administration section:
— Device Classification Values
— FDA Regulation Number Values

See Data Administration Tables: Calyx RIM 6.2

Additional Enhancements
With support for the Microsoft Edge and Google Chrome Enterprise Edition browsers, Calyx RIM 6.2 provides the
ability to display all windows throughout the system with Kendo (HTML5 user interface framework).

Note: Calyx RIM 6.2 supports Microsoft Edge and Google Chrome Enterprise Edition browsers only when configured for
Kendo. When not configured for Kendo, LIQUENT InSight 6.2 supports only Microsoft Internet Explorer 11.

The Kendo-styled windows can be minimized, maximized, moved, and re-sized. When the settings are configured to
support Kendo, using one of the following methods, then all windows will be displayed in the newly supported
browsers:
— In the insight.var file, the insight.window.type.kendo=true setting must be added.

If the setting is insight.window.type.kendo=false, then all windows are displayed in standard style.

OR

— In the insightConfig.bat file, in the Browser Independence Settings section, the Enable
Kendo Window UI option is set to true: Enable Kendo Window UI=true.
The default value is set to true. If the default value is preserved, then all windows are displayed in kendo style.

Attention: Please note that Calyx RIM for Analytics module is not compatible with the Microsoft Edge browser.

The PLANNED internal event status has been added. By default, the internal Event Status PLANNED is mapped to
the Planned Event Status.
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The maximum number of users that can access Calyx RIM for Analytics Reports has been increased from 1280 to
5000.

Calyx RIM 6.2 provides support for the following Ricoh Pro Printers:

— Ricoh Pro C5200s/C5210s
— Ricoh Pro C5200s/C5210s, US Punch*
— Ricoh Pro C5200s/C5210s, ISO Punch*

*Requires additional hardware.

The AssemblyImport.xsd file included in the Calyx RIM 6.2 release along with the corresponding Assembly
XML Specification set topics located in the Calyx RIM Administration Guide have been provided to aid in the
creation of the Assembly XML file from scratch using third-party tools, or leveraging it from an exported Assembly.

List of Enhancements: Calyx RIM 6.2

Requested new features and enhancements are included in each release. The items are listed in descending order by
their tracking numbers. Customer case numbers that were recorded when the enhancements were requested are
included in brackets [#####] following the tracking number.

Calyx RIM 6.2
Calyx RIM  6.2 includes the following enhancements.
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Issue Description

25698;
[00057639]

Calyx RIM 6.2 enhances the XEVMPD Submission wizard to take the prior
approved PDS Detail from the previous Event into the XEVMPD Submission if the
current PDS Detail has one of the following statuses:
— Pending Modify
— Pending Withdrawal

This enhancement is applicable to the following PDS Details:
— Active Ingredient (including the Reference Active Ingredient logic)
— Indication/Indented Use
— Indication (under Veterinary Product Family)
— Strain
— Reference Strain
— Substance (Excipient, Adjuvant, and Substance entities used as Active

Ingredient)

The PDS Details with status set to Withdrawn are not:
— Included into XEVMPD Submission
— Displayed in the XEVMPD Audit Analytics report

25680;
[00056846]

Calyx RIM 6.2 updates the uniqueness rule for the Full Product Presentation
entity to have the concatenation of the following fields unique within the
Registration:
Full Product Name, EEA Country, Language, Package Description, Authorisation
Status, Authorisation/Renewal Date, and EV Code.

25675;
[00057202,
00057471,
00057946,
00058223]

Calyx RIM 6.2 introduces support of the ICH STF Stylesheet v2.3. The following
updates have been applied:
— When you select the stf-2-2 in the XML Definitions field, the published

output will contain the new version of the Stylesheet file: util\style
\ich-stf-stylesheet-2-3.xsl

— When you select the stf-2-2-3-0 in the XML Definitions field, the
published output will contain the new version of the Stylesheet file: util
\style\ich-stf-stylesheet-2-3.xsl

Note: The MD5 checksum of the STF stylesheet is:
92BFEB4CB358A4AF786317A0DA2309C5

25663 Calyx RIM 6.2 provides support for Australia eCTD Module 1 Specification
Version 3.1 and AU NeeS v2.0 specification.
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Issue Description

25662;
[00057090,
00057174]

Calyx RIM 6.2 supports EU eCTD Module 1 Specification Version 3.0.3. The EU
eCTD Module 1 Templates have been updated.

Note: See Clarification of Behavior: Calyx RIM 6.2.

25607;
[00056665]

With Calyx RIM 6.2, it is now possible to associate a Package Set to a
Registration via workflow.

25563 With Calyx RIM 6.2, a new configured field named Local Route of Administration
has been added to the PDS Attributes page for tracking country Route of
Administration on PDS level. This field is hidden by default and can be enabled
via the overrides.
In addition, if configured to be available, the Local Route of Administration field
is displayed in the XEVMPD Audit Report under the Pharmaceutical Product-
Administration Route XEVMPD Entity.

25575;
[00056237]

With Calyx RIM 6.2, a new validation has been added to the XEVMPD
Submission wizard invoked for the Authorised Product flow. When the MFL
(Master File Location) value is not selected for a Registration being submitted, a
warning message appears indicating that the MFL is required for this
operation type.

Note: The MFL value is mandatory for Insert, Update and Invalidate MA
operation types.

To be able to proceed with the wizard and have the MFL tag included to the
submission XML file, the MFL value on the Registration Attributes page must be
defined.

25533 The AssemblyImport.xsd file included in the Calyx RIM 6.2 release along
with the corresponding Assembly XML Specification set topics located in the
Calyx RIM Administration guide have been provided to aid in the creation of the
Assembly XML file from scratch using third-party tools, or leveraging it from an
exported Assembly.
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Issue Description

25527 With Calyx RIM 6.2, the following enhancements have been introduced to
support the Legal Basis field to be available for the Package Set Registration
entity and be included to the XEVMPD Submission XML file:
— A new drop-down list named Legal Basis has been added to the Registration

of a Package Set type.
— The Legal Basis Values table has been removed from the Data Administration

> Application Maintenance section and is now included under the Data
Administration > Other section.

— The Registration Attributes > Entity History Query and Querying >
Administration > Entity Audit Trail queries have been updated to display the
correct values for the new Legal Basis field.

— The Registration > Legal Basis value is included to the XEVMPD Submission
XML file instead of the Application > Legal Basis value, if:
• The field is populated with a value for both entities.
• The Application > Legal Basis field is not populated with a value

25521;
[00055762]

This enhancement introduces the ability to have a workflow that allows for
updating of Active Ingredient, Reference Active Ingredient, and Pharmaceutical
Product entity specific data.

25435 With Calyx RIM 6.2, the Initial Report option has been hidden in the XEVMPD
Submission wizard:
— The Run Initial Report? drop-down has been hidden on the Select Sender/

Receiver Information page.
— The Initial Report Selection and Initial Report Selection Results pages that

appeared when the Run Initial Report? drop-down field was set to Yes, has
been hidden in the wizard.

25430;
[00054572]

With Calyx RIM 6.2, the PLANNED status has been added to the:
— Project Pivot Status drop-down field on the Create/Modify Projest Attributes

page.
— Enter Project Pivot Values > Project Pivot Status drop-down field of the

Calculate Projected Dates wizard (Global Project Plan wizard).

In addition, the PLANNED internal event status has been added. By default, the
internal Event Status PLANNED is mapped to the Planned Event Status.
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Issue Description

25416 To make the Excipient Role field available for all substance types in the Product
Detail Set and Product Detail Set Template, the Data Administration > Product
Detail Set Maintenance > Excipient Role Values table is renamed as Substance
Role Values, and the Excipient Role field for the Substance Detail is renamed as
Substance Role. The Substance Role field appears on the Add Substance page
regardless of the selected Substance Type value.

25407 Using XML overrides, Calyx RIM 6.2 can be configured to disable the
autopopulate function for one or more Registration Attachment fields, if the
Attachment file is uploaded from a DMS Repository:
— Attachment Name
— File Name
— File Type
— Attachment Version

25387;
[00054264]

Calyx RIM 6.2 enhances the XEVMPD submission data collection features.
Although the Package Set information is not included in the XEVMPD
submission, the Package Set assigned to the Full Product Presentation will
determine the Active Ingredient, Substance, Indication/Intended Use (non-
Veterinary), or Species Indication (Veterinary) PDS Details to be included. Only
those PDS Details, with Package Set from the parent PDS associated to the Full
Product Presentation, are included in the XEVMPD submission.

25373;
[00053960]

Starting with Calyx RIM 6.2, the Application Status of an Application can be set
to Withdrawn only when all Registrations associated to the Application have a
status mapped to internal WITHDRAWN status.

25372 With Calyx RIM 6.2, the Attachment Name field on the Create Registration FPP
Attachment page has been reworked to be a Registration Attachment Selection
list. The selected Registration Attachment is displayed in the Attachment Name
> Selected box in the concatenation of four fields: Internal Name, Attachment
Language, Attachment Name, Attachment Version.

25367 Calyx RIM 6.2 enhances the Entity Audit Trail Administration Query to add
support for the CT Shared Data. The CT Shared Data option is added to the
Entity Type multi-select list.

25341;
[00053767]

Calyx RIM 6.2 provides updates to the Indication/Intended Use detail in the
Non-Veterinary Product Details Set (PDS) and Species Indication detail in the
Veterinary Product Detail Set (PDS). All countries of the associated Application
by default appear in the Selected box of the Countries field on the Add
Indication/Intended Use detail (Non-Veterinary PDS) and Add Indication detail
(Veterinary PDS) pages. You can deselect countries, if needed.
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Issue Description

25340;
[00053739]

With Calyx RIM 6.2, the mrpnumber generated by the XEVMPD Submission
wizard is displayed without a space between Procedure Identifier/Application
Code and Speciality Number. For example: [Procedure Identifier/Application
Code][Speciality Number1]. As an addition to this enhancement, the Specialty
Number field has been renamed to be Speciality Number.

25335;
[00053740]

To enable the Previous EV Code value for the Full Product Presentation entity to
be added manually, Calyx RIM 6.2 provides the following enhancements:
— The Authorised Product option has been hidden from the Data

Administration > Other > Previous EV Code Values > Code Type drop-down
list.

— The Full Product Presentation > Previous EV Code drop-down list has been
reworked to be the FPP Previous EV Codes tab on the Full Product
Presentation Attributes page. If there are several Previous EV Code values, in
the XEVMPD XML file that results in several <previousevcode> tags.

25329, 24993;
[00053680,
00049980]

Calyx RIM 6.2 enhances Data Exchange by adding the User Authentication,
Authorisation, and Auditing support.
— Data Exchange can be configured to enforce user authentication for each

incoming request.
— Data Exchange can be configured to enforce authorisation to specific user

accounts.
— Authentication and authorisation logging has been added in the following

categories:
• com.liquent.insight.dataexchanger
• com.liquent.insight.messaging.jms

The Data Exchange XML schema contains the additional attributes named user
and password on the root <dataexchange> tag. This is used to pass the
credentials of the user to authenticate and use during the Data Exchange
transaction.

For example: <dataexchange user=”de_user”
password=”de_password”>

Important: These attributes are only required if Data Exchange authentication
is configured to be used.
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Issue Description

25284; Calyx RIM 6.2 provides support for the following Ricoh Pro Printers:
— Ricoh Pro C5200s/C5210s
— Ricoh Pro C5200s/C5210s, US Punch*
— Ricoh Pro C5200s/C5210s, ISO Punch*

25280;
[00052554;
00054120]

Calyx RIM 6.2 enhances the logic for determining the Confirmed Sequence Code
value in the Change Submittal Status wizard. The Confirmed Sequence Code
value is determined based on the number of sequences that have been
submitted to this application lifecycle, and now considers all previously
submitted sequences, even if the current Sequence Status is set to Approved.

25273;
[00051853]

Calyx RIM 6.2 provides support for the following Web browsers:
— Microsoft Internet Explorer (IE) 11 (set Compatibility View Settings to Off)
— Microsoft Edge (supported on Windows 10 only)
— Google Chrome

Note: Please note that Calyx RIM for Analytics module is not compatible with the
Microsoft Edge browser.

25242 Calyx RIM 6.2 enables you to copy a Registration entity using the Copy Package
Set Registration wizard. The wizard can be invoked for a Package Set
Registration only. Two flows are available for selection in the Copy Package Set
Registration wizard:
— New Package Set specific Registration(s). This flow also allows you to copy

the Full Product Presentations and Registration FPP Attachments, if any are
assigned to the Registration you selected to copy, and the minimum required
security settings are met.

— New Product specific Registration(s).

25239;
[00055798]

Calyx RIM 6.2 enables you to copy a Full Product Presentation entity using the
Copy Full Product Presentation wizard. Two flows are available for selection in
the Copy Full Product Presentation wizard:
— Full Product Presentation under different Registration(s)
— Full Product Presentation under the same Registration
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25218;
[00052214]

Calyx RIM 6.2 provides the ability to edit the Reference Leaf elements in the
Unlocked Submitted View of a Sequence Assembly, if the following rules are
met:
— To modify a Reference Leaf element in the unlocked submitted assembly

plan view, in Security Administration you must have the Entity Security >
Submission Plans set to at least WRITE and Entity Security > Sequence
Assemblies set to ADMIN.

— To modify a Reference Leaf element in the unlocked submitted assembly
view, in Security Administration you must have the Application Country
Rights set to at least WRITE and Entity Security > Sequence Assemblies set
to ADMIN.

25179 Calyx RIM 6.2 enhances the XEVMPD Audit Analytics Predefined Report to
include an additional filter named Message Sender. An additional column
named Message Sender has been added to the XEVMPD Audit Analytics
Predefined Report results page.

25169;
[00051802]

Calyx RIM 6.2 enhances the Create Submission Wizard > Initial Application
flow. The Event Type field on the Complete Submission Properties (event/
sequence) page is now available for modifications. The drop-down field displays
all Active values from Data Administration > Event Maintenance > Event Type
Values.

25163;
[00047861]

The maximum number of users that can access Calyx RIM for Analytics Reports
has been increased from 1280 to 5000.

25159;
[00051747]

Calyx RIM 6.2 enhances the List of Applications with Products query, in the
Registrations Planning and Tracking section, to provide the ability to search for
all application types available in the system. All application types are now
displayed and available for selection in the Application Type multi-select list.
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25083;
[00050940]

To provide the ability to identify the association between the parent Task and its
Sub-Task, Calyx RIM 6.2 enhances the Task entity by adding a new field named
Related Task Name. When a Task has an associated Sub-Task entity, the
Related Task Name field for the Sub-Task will be populated automatically with
the parent Task Name value. This field will always be empty for the parent Task
entity.
To support this enhancement, the following Registration Planning and Tracking
reports have been updated with a new filter field named Related Task Name
(enter parent Task/Sub-Task name if any):
— List of Tasks
— List of Tasks - Rollup by Product Family
— List of Tasks - Rollup by Application
— List of Tasks - Rollup by Project

The following changes are introduced to support this enhancement:
— The listed Registration Planning and Tracking reports have been updated to

add a new column named Related Task Name to the Search Results page.
The value in the column is hyperlinked. When selected, this displays the
appropriate Task Attributes page.

— The Related Task Name column has been added to the Querying >
Administration > Entity Audit Trail > Query table when querying for the Task
entity. The value is not hyperlinked.

— The Related Task Name column has been added to the Search Results page
of the SEARCH functionality when invoked for the Tasks/Sub-tasks option.
The value in the column is hyperlinked. When selected, this displays the
appropriate Task Attributes page.

25055 Calyx RIM Data Exchange now provides the ability to import Region Values
records into the Calyx RIM database.
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24743;
[00047073]

Calyx RIM 6.2 enhances the Global Project Plan wizard by adding the multi-
select field Application Type as an additional filter criterion for the following
project types:
— Create New Events Package Set Registration > Search by Product, Country

and Application Status page
— Update Product Detail Sets > Input Query Filter Criteria page, when

searching by:
• Active Ingredient
• PDS Code/PDS Name
• Product and Country
• Substance
• Trade Name

— Create New Events Product Registration > Search Country and Application
Status page

— Withdraw Product Package Set Registration > Search by Product, Country
Application and PDS Statuses page

24742;
[00047074]

Calyx RIM 6.2 enables a Sequence to be updated in bulk within a project. The
Project Attributes page has been enhanced by adding the Bulk Update
Sequences icon that launches the Bulk Update Sequences wizard.
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24711;
[00046629]

To enable the Manufacturer Name value to be displayed as a concatenation of
Manufacturer Name + Address Line 1 + Country Code values in the
Manufacturer field for each Product Detail Set > Manufacturer Detail instance,
Calyx RIM 6.2 introduces the following enhancements to the Data
Administration > Product Detail Set Maintenance > Manufacturer Values >
Manufacturer value attributes page:
— The Country text field has been reworked to be a drop-down list with all

active Country values from the Data Administration > Country Values table
available for selection.

— The Country Code drop-down list is no longer presented on the Create/Modify
Manufacturer attributes page.

In addition to all instances of Manufacturer Detail in the Product Detail Set, to
support this enhancement the Manufacturer Name value concatenation is now
displayed for the following areas:
— Queries > Product Detail Management:

• Application History Query
• Application QC Status History Report
• List of Active Ingredient Manufacturers
• List of Active Ingredient Function Manufacturers
• List of Active Ingredient Material Manufacturers
• List of Excipient Manufacturers
• List of PDS Manufacturers
• List of Component Manufacturers
• List of Package Set Manufacturers

— Queries > Administration:
• Entity Audit Trail

— Global Project Plan wizard:
• Add Active Ingredient Manufacturer flow
• Add Active Ingredient Manufacturing Process Function Manufacturer flow
• Add Substance Manufacturer flow
• Add Substance Manufacturing Process Function Manufacturer flow
• Add Component Function Manufacturer flow
• Add Component Manufacturing Process Function Manufacturer flow
• Add PDS Function Manufacturer flow
• Add PDS Manufacturing Process Function Manufacturer flow
• Add Package Set Function Manufacturer flow
• Add Package Set Packaging Manufacturer flow
• Add Package Set Component Packaging Manufacturer flow

— Comparator > Suppliers multi-select list
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23671;
[00038325]

The Analytics schema has been updated to include the audit trail information
stored within Calyx RIM, enabling users to create reports and metrics against
the audit information, using Calyx RIM for Analytics.

23634;
[00038044]

With Calyx RIM 6.2 you are now able to:
— Select a bunch of different Assembly Tree nodes using the Ctrl or Shift keys,

invoke the context menu and delete the selected items in a bulk;
— Select several different Assembly Tree nodes the Ctrl or Shift keys and drag-

and-drop them on the valid node.

23580;
[00037237]

Calyx RIM 6.2 enhances the following Product Strength-related fields to display
a leading zero value for the decimal numbers that are less than 1 in the Product
Strength field on the View Product Attributes page:
— Product Strength Measure 1
— Product Strength Measure 2

Calyx RIM 6.2 enhances the business rules for the Product Strength Measure 1
and Product Strength Measure 2 fields. The entered value must not exceed 5
decimal numbers before the decimal point and 5 decimal numbers after the
decimal point.

Note: The value cannot be larger than 99999.99999.

23432, 22641,
20705;
[00028353,
00029094]

When modifying a TOC tree, it is now possible to select multiple nodes and drag
them in between the other nodes.

22788, 15649;
[00029856,
75107FW,
115454FW]

With the New Version of the Assembly Tree introduced in Calyx RIM 6.2, it is
now possible to select and delete multiple Assembly Tree nodes
simultaneously using the Ctrl or Shift keys.

22207;
[00209161,
00042932]

Delete (Withdraw) lifecycle operation is now available in the right-click menu for
multiple selected leafs.

21791;
[00038699]

Calyx RIM 6.2 enhances the Event entity by renaming the Event Closed As field
as Associations Closed As and the Event Closed Date field as Closed Date.
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21788;
[000175882]

The performance of the List of Sequences with Application and Event Properties
query has been improved in Calyx RIM 6.2.

20557;
[000139077]

With Calyx RIM 6.2 release, using the Assembly Tree Filter functionality you can
now search for a specific study folder in Module 4 and Module 5 using the value
of the Report Number attribute.

16620;
[00076590FW,
00083511FW,
000133431FW,
000142150FW,
00039250]

With Calyx RIM 6.2, it is possible to delete the first and last elements in either
locked or unlocked volumes. After the element is deleted from the volume
range, the Volume structure will be adjusted automatically.

14129;
[00036861]

With Calyx RIM 6.2 release, the inactive or disabled users are omitted from the
lists of available values (username, or username (email address)
combination) for the following Task entity fields:
— Assigner drop-down list
— Premier Assignee drop-down list
— Task Concerned Parties popup window

10376 Using the Search function on the menu bar, it is now possible to find sequences
quickly.

See New in Calyx RIM 6.2, Entity Fields Added: Calyx RIM 6.2, Entity Fields Updated: Calyx RIM 6.2, Query Fields
Added: Calyx RIM 6.2, Query Fields Updated: Calyx RIM 6.2, and Data Administration Tables: Calyx RIM 6.2.

Data Administration Tables: Calyx RIM 6.2

The following Data Administration tables, sections, or fields were added with Calyx RIM 6.2.
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Data Administration Section: Application Maintenance
Data
Administration
Table Name

Entity Affected Field Name Value List Description

Country Values >
Health Authority

N/A Organisation
Identifier

The Data Administration > Application
Maintenance > Country Values > Health
Authority attributes page has been
enhanced by adding a new attribute
named Organisation Identifier:
— Field Type: text, non-mandatory
— Field Size: 250 characters
— Database Field Size:

VARCHAR2(500)
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Data
Administration
Table Name

Entity Affected Field Name Value List Description

Country Values >
Region

N/A N/A The IDMP Integration region of IDMP
region type appears in the Region tab
on the Country value attributes page for
the following list of countries:
— Austria
— Belgium
— Bulgaria
— Croatia
— Cyprus
— Czech Republic
— Denmark
— Estonia
— European Union
— Finland
— France
— Germany
— Greece
— Hungary
— Iceland
— Ireland
— Italy
— Latvia
— Liechtenstein
— Lithuania
— Luxembourg
— Malta
— Netherlands
— Norway
— Poland
— Portugal
— Romania
— Slovakia
— Slovenia
— Spain
— Sweden
— United Kingdom
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Data
Administration
Table Name

Entity Affected Field Name Value List Description

Country Values N/A RMS Term
Name

To maintain the European Medicines
Agency (EMA) Substance, Product,
Organisation and Referential (SPOR)
service, the Country Values table has
been updated with a new drop-down
list named RMS Term Name. The active
values from SPOR Maintenance >
Country RMS Values table are available
for selection.

Procedure Type
Values

N/A IDMP Internal
Procedure
Code

The Data Administration > Application
Maintenance > Procedure Type Values
attributes page has been enhanced by
adding a new field named IDMP
Internal Procedure Code:
— Field Type: drop-down list
— Values available for selection: CP,

DCP, MRP, NATIONAL

Procedure Type
Values

N/A RMS Term
Name

To maintain the European Medicines
Agency (EMA) Substance, Product,
Organisation and Referential (SPOR)
service, the Procedure Type Values
table has been updated with a new
drop-down list named RMS Term
Name. The active values from SPOR
Maintenance > Procedure Type RMS
Values table are available for selection.
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Data
Administration
Table Name

Entity Affected Field Name Value List Description

Region Type
Values

— Region Values
— Country Values >

Region
— Update Applications

wizard
— Create Application

wizard (the Region(s)
read-only field)

— Global Project Plan
wizard:
• Create New

Applications
Package Set
Registration
project

• Clinical Trial
project > Create
New CTA and/or
IND Application(s)
flow

• Clinical Trial
project > Create
New CTA
Application(s) and
Create New Event
for Existing IND
Application(s)
flow

• Clinical Trial
project > Create
New Event for
Existing CTA
and/or IND
Application(s)
flow

— Create Timeline/
Event Plan wizard

N/A The IDMP region type has been added.
The default value is set to Active. This
value is not available for modifications
and cannot be deactivated.

Note: You can update the list of
countries that are associated to the
region of an IDMP type, or create a new
region of an IDMP type, using the
Region Values section.
— In the Timeline/Event Plan wizard,

the Region Type field has been
updated to allow the selection an
IDMP region type.

— The Update Applications wizard has
been enhanced to include an IDMP
region type.

— The Global Project Plan wizard has
been enhanced to include an IDMP
region type a search criteria.

— The Create Application wizard,
Application Attributes page, and
Modify Application Attributes page
have been updated to show the IDMP
region type and a region of IDMP
type in the Region(s) read-only field,
if a country associated to such region
has been selected as a Reviewing
Country.
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Data
Administration
Table Name

Entity Affected Field Name Value List Description

Region Values Country Values > Region N/A A new default region named IDMP
Integration has been added. The
default value is set to Inactive. The
type of an IDMP Integration region is
set to IDMP.
By default, the following list of
countries belong to the IDMP
Integration region:
— Austria
— Belgium
— Bulgaria
— Croatia
— Cyprus
— Czech Republic
— Denmark
— Estonia
— European Union
— Finland
— France
— Germany
— Greece
— Hungary
— Iceland
— Ireland
— Italy
— Latvia
— Liechtenstein
— Lithuania
— Luxembourg
— Malta
— Netherlands
— Norway
— Poland
— Portugal
— Romania
— Slovakia
— Slovenia
— Spain
— Sweden
— United Kingdom
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Data Administration Section: Other
Data
Administration
Table Name

Entity Affected Field Name Value List Description

Concentration
Measure Type
Values

N/A RMS Term
Name

To maintain the European Medicines
Agency (EMA) Substance, Product,
Organisation and Referential (SPOR)
service, the Concentration Measure
Type Values table has been updated
with a new drop-down list named RMS
Term Name. The active values from
SPOR Maintenance > Concentration
Measure Type RMS Values table are
available for selection.

Denominator Unit
Values

N/A RMS Term
Name

To maintain the European Medicines
Agency (EMA) Substance, Product,
Organisation and Referential (SPOR)
service, the Denominator Unit Values
table has been updated with a new
drop-down list named RMS Term
Name. The active values from SPOR
Maintenance > Denominator Unit RMS
Values table are available for selection.

Language Values N/A RMS Term
Name

To maintain the European Medicines
Agency (EMA) Substance, Product,
Organisation and Referential (SPOR)
service, the Language Values table has
been updated with a new drop-down
list named RMS Term Name. The active
values from SPOR Maintenance >
Language RMS Values table are
available for selection.

Legal Basis Values — Package Set
Registration

— Data Administration
> Application
Maintenance > Legal
basis Values

Package Set
Registration >
Legal Basis

The Legal Basis Values table has been
removed from the Data Administration
> Application Maintenance section and
is now included under the Data
Administration > Other section. The
table name has not been changed.
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Data
Administration
Table Name

Entity Affected Field Name Value List Description

Legal Basis Values N/A RMS Term
Name

To maintain the European Medicines
Agency (EMA) Substance, Product,
Organisation and Referential (SPOR)
service, the Legal Basis Values table
has been updated with a new drop-
down list named RMS Term Name. The
active values from SPOR Maintenance
> Legal Basis RMS Values table are
available for selection.

MAH/Development
Sponsor/
Organisation
Values

N/A Organisation
Identifier

The Data Administration > Other >
MAH/Development Sponsor/
Organisation Values attributes page
has been enhanced by adding a new
attribute named Organisation
Identifier:
— Field Type: text, non-mandatory
— Field Size: 250 characters
— Database Field Size:

VARCHAR2(500)

MAH/Development
Sponsor/
Organisation
Values

N/A Location
Identifier

To maintain the integration with
Organisations management service
(OMS) introduced by European
Medicines Agency (EMA), the Data
Administration > Other > MAH/
Development Sponsor/Organisation
Values attributes page has been
updated with a new field named
Location Identifier:
— Field Type: text, non-mandatory
— Field Size: 200 characters
— Database Field Size:

VARCHAR2(1000)

Calyx RIM 6.2 Release Notes

© Calyx™ 2023. 40 Calyx RIM 6.2 Release Notes
Calyx.ai Data Administration Tables: Calyx RIM

6.2



Data
Administration
Table Name

Entity Affected Field Name Value List Description

MAH/Development
Sponsor/
Organisation
Values

N/A Location
Status

To maintain the integration with
Organisations management service
(OMS) introduced by European
Medicines Agency (EMA), the Data
Administration > Other > MAH/
Development Sponsor/Organisation
Values attributes page has been
updated with a new field named
Location Status:
— Field Type: drop-down list, non-

mandatory
— The values available for selection

are [Select], Active, Inactive.
[Select] is set by default.

Numerator Unit
Values

N/A RMS Term
Name

To maintain the European Medicines
Agency (EMA) Substance, Product,
Organisation and Referential (SPOR)
service, the Numerator Unit Values
table has been updated with a new
drop-down list named RMS Term
Name. The active values from SPOR
Maintenance > Numerator Unit RMS
Values table are available for selection.
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Data
Administration
Table Name

Entity Affected Field Name Value List Description

Previous EV Code
Values

Full Product
Presentation > Previous
EV Code

Code Type The Authorised Product option has
been hidden from the Code Type drop-
down list. The options available for
selection are:
— Approved Substance
— Pharmaceutical Form
— Rout of Administration

The field is not available for
modifications once the Previous EV
Code value is created and saved in
Data Administration.

The Full Product Presentation >
Previous EV Code field has been
reworked to be the FPP Previous EV
Codes tab on the Full Product
Presentation Attributes page without
using the values from the Data
Administration > Other > Previous EV
Code Values section.

The following set of rules apply to the
FPP Previous EV Code > Previous EV
Code field:
— Field Type: text, required
— Field Size: 60 characters
— Database Field Size:

VARCHAR2(100)

Unit of Measure
Prefix Values

N/A RMS Term
Name

To maintain the European Medicines
Agency (EMA) Substance, Product,
Organisation and Referential (SPOR)
service, the Unit of Measure Prefix
Values table has been updated with a
new drop-down list named RMS Term
Name. The active values from SPOR
Maintenance > Unit of Measure Prefix
RMS Values table are available for
selection.
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Data Administration Section Name: Product Detail Set Maintenance
Data
Administration
Table Name

Entity Affected Field Name Value List Description

Compendial
Designation/
Source Values

N/A RMS Term
Name

To maintain the European Medicines
Agency (EMA) Substance, Product,
Organisation and Referential (SPOR)
service, the Compendial Designation/
Source Values table has been updated
with a new drop-down list named RMS
Term Name. The active values from
SPOR Maintenance > Compendial
Designation/Source RMS Values table
are available for selection.

Excipient Role
Values

Product Detail Set >
Substance Detail

N/A The Excipient Role Values table in the
Data Administration > Product Detail
Set Maintenance section has been
renamed as Substance Role Values.
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Data
Administration
Table Name

Entity Affected Field Name Value List Description

Manufacturer
Values

— PDS > Component >
Active Ingredient >
Manufacturer

— PDS > Component >
Active Ingredient >
Manufacturing
Process > Function >
Manufacturer

— PDS > Component >
Substance >
Manufacturer

— PDS > Component >
Substance >
Manufacturing
Process > Function >
Manufacturer

— PDS > Component >
Manufacturing
Process > Function >
Manufacturer

— PDS > Component >
Function >
Manufacturer

— PDS > Manufacturing
Process > Function >
Manufacturer

— PDS > Package Set >
Function >
Manufacturer

— PDS > Package Set >
Packaging >
Manufacturer

— PDS > Package Set >
Component >
Packaging >
Manufacturer

— Queries >
Registration Planning
and Tracking:
• List of

Manufacturers
From Data
Administration

— Queries > Product
Detail Management:
• Application

History Query
• Application QC

Status History
Report

• List of Active
Ingredient
Manufacturers

• List of Active
Ingredient
Function
Manufacturers

• List of Active
Ingredient
Material
Manufacturers

• List of Excipient
Manufacturers

• List of PDS
Manufacturers

• List of Component
Manufacturers

• List of Package
Set Manufacturers

— Queries >
Administration:
• Entity Audit Trail

— Global Project Plan
wizard:
• Add Active

Ingredient
Manufacturer flow

• Add Active
Ingredient
Manufacturing
Process Function
Manufacturer flow

• Add Substance
Manufacturer flow

• Add Substance
Manufacturing
Process Function
Manufacturer flow

• Add Component
Function
Manufacturer flow

• Add Component
Manufacturing
Process Function
Manufacturer flow

• Add PDS Function
Manufacturer flow

• Add PDS
Manufacturing
Process Function
Manufacturer flow

• Add Package Set
Function
Manufacturer flow

• Add Package Set
Packaging
Manufacturer flow

• Add Package Set
Component
Packaging
Manufacturer flow

— Comparator >
Suppliers multi-
select list

Country The Country text field has been
reworked to be a drop-down list with
all active Country values from the Data
Administration > Country Values table
available for selection.

Manufacturer
Values

Manufacturer
Name

The uniqueness rule has been
changed. Concatenation of the
following values must be unique within
the system:
Manufacturer Name + Address
Line 1 + Country Code
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Data
Administration
Table Name

Entity Affected Field Name Value List Description

Manufacturer
Values

N/A Country Code The Country Code drop-down list is no
longer presented on the Create/Modify
Manufacturer attributes page.

Manufacturer
Values

N/A Organisation
Identifier

The Data Administration > Product
Detail Set Maintenance > Manufacturer
Values attributes page has been
enhanced by adding a new attribute
named Organisation Identifier:
— Field Type: text, non-mandatory
— Field Size: 250 characters
— Database Field Size:

VARCHAR2(500)

Data Administration Section Name: Product Family Maintenance
Data
Administration
Table Name

Entity Affected Field Name Value List Description

ATC Values N/A RMS Term
Name

To maintain the European Medicines
Agency (EMA) Substance, Product,
Organisation and Referential (SPOR)
service, the ATC Values table has been
updated with a new drop-down list
named RMS Term Name. The active
values from SPOR Maintenance > ATC
RMS Values table are available for
selection.

Data Administration Section Name: Product Maintenance
Data
Administration
Table Name

Entity Affected Field Name Value List Description

Applicable
Standards Values

N/A Applicable
Standard

To maintain the version of standard,
the Applicable Standards Values table
has been updated to include the
Version of Standard option.
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Data
Administration
Table Name

Entity Affected Field Name Value List Description

Country Specific
Detail Type Values

Product > Country
Specific Detail

Product >
Country
Specific
Detail >
Country
Specific
Detail Type

To maintain the specific detail type
value of the country attribute, the
Country Specific Detail Type Values
table has been introduced. The Field
Value Control drop-down list includes
the options Controlled - Single Value,
Controlled - Multiple Values, and User
Entered.

Country Specific
Detail Values

Product > Country
Specific Detail

N/A — Country Specific Detail Type - All
active Country Specific Detail Types
are displayed.

— Countries - A multi select field
displaying all active countries.

— Country Specific Value - This value is
defined for the detail type when
Field Value Control is set to
Controlled in the Country Specific
Detail Type. The field is hidden
when Field Value Control is set to
User Entered. The Country
Specific Detail Value must be unique
within the Country Specific Detail
Type.

Dosage/
Pharmaceutical
Form Values

N/A RMS Term
Name

To maintain the European Medicines
Agency (EMA) Substance, Product,
Organisation and Referential (SPOR)
service, the Dosage/Pharmaceutical
Form Values table has been updated
with a new drop-down list named RMS
Term Name. The active values from
SPOR Maintenance > Dosage/
Pharmaceutical Form RMS Values table
are available for selection.

Device
Classification
Values

N/A N/A This table has been removed.

FDA Regulation
Number Values

N/A N/A This table has been removed.
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Data
Administration
Table Name

Entity Affected Field Name Value List Description

Global Medical
Device
Nomenclature
(GMDN) Code
Values

N/A GMDN Term
Name

To identify medical devices, the Global
Medical Device Nomenclature (GMDN)
Code option has been introduced. The
values for the GMDN Code and GMDN
Term Name can be entered in their
respective text fields.

Medical Device
Values

N/A RMS Term
Name

To maintain the European Medicines
Agency (EMA) Substance, Product,
Organisation and Referential (SPOR)
service, the Medical Device Values
table has been updated with a new
drop-down list named RMS Term
Name. The active values from SPOR
Maintenance > Medical Device RMS
Values table are available for selection.

Route of
Administration
Values

N/A RMS Term
Name

To maintain the European Medicines
Agency (EMA) Substance, Product,
Organisation and Referential (SPOR)
service, the Route of Administration
Values table has been updated with a
new drop-down list named RMS Term
Name. The active values from SPOR
Maintenance > Route of Administration
RMS Values table are available for
selection.

Universal Medical
Device
Nomenclature
System (UMDNS)
Code Values

N/A UMDNS Code
Values

To identify, process, retrieve, transfer,
and communicate data about medical
devices, the UMDNS Code Values table
has been introduced. The values for the
UMDNS Code and UMDNS Description
can be entered in their respective
fields.
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Data Administration Section Name: Registration Maintenance
Data
Administration
Table Name

Entity Affected Field Name Value List Description

EMA Authorisation
Status Values

N/A RMS Term
Name

To maintain the European Medicines
Agency (EMA) Substance, Product,
Organisation and Referential (SPOR)
service, the EMA Authorisation Status
Values table has been updated with a
new drop-down list named RMS Term
Name. The active values from SPOR
Maintenance > EMA Authorisation
Status RMS Values table are available
for selection.

Medicinal Product
Type Values

N/A RMS Term
Name

To maintain the European Medicines
Agency (EMA) Substance, Product,
Organisation and Referential (SPOR)
service, the Medicinal Product Type
Values table has been updated with a
new drop-down list named RMS Term
Name. The active values from SPOR
Maintenance > Medicinal Product Type
RMS Values table are available for
selection.

Registration Status
Values

N/A Internal
System
Status

On the Registration Maintenance >
Registration Status Values attributes
page in Data Administration, the
Internal System Status field has been
enhanced by adding a new internal
status named APPROVED.
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Data Administration Section Name: SPOR Maintenance
Data
Administration
Table Name

Entity Affected Field Name Value List Description

— ATC RMS Values
— Compendial

Designation/
Source RMS
Values

— Concentration
Measure Type
RMS Values

— Country RMS
Values

— Denominator/
Numerator Unit
RMS Values

— Dosage/
Pharmaceutical
Form RMS
Values

— EMA
Authorisation
Status RMS
Values

— Language RMS
Values

— Legal Basis RMS
Values

— Medical Device
RMS Values

— Medicinal
Product Type
RMS Values

— Procedure Type
RMS Values

— Route of
Administration
RMS Values

— Unit of Measure
Prefix RMS
Values

N/A N/A Calyx RIM 6.2 introduces the SPOR
Maintenance section in Data
Administration. This section is
designed to maintain the European
Medicines Agency (EMA) Substance,
Product, Organisation and Referential
(SPOR) service. According to the
roadmap designed by EMA the SPOR
support starts with an introduction of
OMS (Organisartions management
service) and RMS (Referentials
management service) components.
The active values from SPOR
Maintenance sections can be
successfully selected and deselected
in the corresponding sections in Data
Administration:
— Application Maintenance > Country

Values
— Application Maintenance >

Procedure Type Values
— Other > Concentration Measure

Type Values
— Other > Denominator Unit Values
— Other > Language Values
— Other > Legal Basis Values
— Other > Numerator Unit Values
— Other > Unit of Measure Prefix

Values
— Product Detail Set Maintenance >

Compendial Designation/Source
Values

— Product Family Maintenance > ATC
Values

— Product Maintenance > Dosage/
Pharmaceutical Form Values

— Product Maintenance > Medical
Device Values

— Product Maintenance > Route of
Administration Values

— Registration Maintenance > EMA
Authorisation Status Values

— Registration Maintenance >
Medicinal Product Type Values

Calyx RIM 6.2 Release Notes

© Calyx™ 2023. 49 Calyx RIM 6.2 Release Notes
Calyx.ai Data Administration Tables: Calyx RIM

6.2



Data Administration Section Name: Workflow Management
Data
Administration
Table Name

Entity Affected Field Name Value List Description

Workflow
Management

Full Product
Presentation

Available
Entities

If configured, the Full Product
Presentation entity is available for
selection in the Available Entities
multi-select list when updating a
workflow in the Workflow Management
section.
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Entity Fields Added: Calyx RIM 6.2

The following tables describe new fields that were added to Calyx RIM 6.2.
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Entities
Entity Name Field Name Field Type Description Business Rules

Full Product
Presentation

Container or
Pack Part

Text The Container or Pack Part of the
Full Product Name (SmPC
Name). You can enter up to 250
characters for The value. The
database size of the field is
VARCHAR2(500).
For example: DrugLV,
collapsible aluminium
tube

N/A

Countries Multi-select
list

All Package Set Countries
available for selection. The field
appears after the package set is
selected in the Package Sets
field.

For the application
of National, Mutual
Recognition (MRP)
and Decentralised
(DCP) Procedure
types, the country
of the parent
Registration
appears as
selected by
default.

Device Part Text The Device Part of the Full
Product Name (SmPC Name).
You can enter up to 250
characters for the value. The
database size of the field is
VARCHAR2(500).
For example: DrugLV,
solution for injection
in pre-filled pen
(device Tradename)

N/A

Flavour Part Text The Flavour Part of the Full
Product Name (SmPC Name).
You can enter up to 250
characters for the value. The
database size of the field is
VARCHAR2(500).
For example: DrugLV for
Children Strawberry

N/A

Formulation
Part

Text The Formulation Part of the Full
Product Name (SmPC Name).
You can enter up to 250
characters for the value. The
database size of the field is
VARCHAR2(500).
For example: DrugLV, sugar
free

N/A

Full Product
Presentation
Add Comment

Text The free-format text box where
users can add comments:
— You can enter up to 4000

characters.
— The database size is

VARCHAR2(4000).

The comments will be displayed
in the Full Product Presentation
Comments box followed by the
date and time the comments
were entered, and the user ID of
the person who entered them.

Available on the
Create/Modify Full
Product
Presentation pages
only.

Intended Use
Part

Text The Intended Use Part of the Full
Product Name (SmPC Name).
You can enter up to 250
characters for the value. The
database size of the field is
VARCHAR2(500).
For example: DrugLV 200
tablet Migraine

N/A

Target
Population Part

Text The Target Population Part of the
Full Product Name (SmPC
Name). You can enter up to 250
characters for the value. The
database size of the field is
VARCHAR2(500).
For example: DrugLV For
Children

N/A

Time Period
Part

Text The Time Period Part of the Full
Product Name (SmPC Name).
You can enter up to 250
characters for the value. The
database size of the field is
VARCHAR2(500).
For example: DrugLV 300 mg
EXPRESS

N/A
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Entity Name Field Name Field Type Description Business Rules

Package Set
Registration

Legal Basis Drop-down
list

The legal basis for an
authorisation of the product.
The Registration Attributes >
Entity History Query and
Querying > Administration >
Entity Audit Trail queries have
been updated to display the
correct values for the new Legal
Basis field.

All active values
from Data
Administration >
Other > Legal
Basis Values table
are available for
selection. The field
is displayed for the
Registration of a
Package Set type
only.
The Registration >
Legal Basis value
is included to the
XEVMPD
Submission XML
file instead of the
Application > Legal
Basis value, if:
— The field is

populated with
a value for both
entities.

— The Application
> Legal Basis
field is not
populated with
a value
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Entity Name Field Name Field Type Description Business Rules

Product
Detail Set

Local Route of
Administration

Multi-select
list

With Calyx RIM 6.2, a new
configured field named Local
Route of Administration has
been added to the PDS
Attributes page for tracking
country Route of Administration
on PDS level.
The values available for selection
in the Local Route of
Administration multi-select list
are the values from Product >
Product Route of Administration
and Component > Component
Route of Administration fields,
displayed as a concatenation of
those values. If multiple
components are presented, then
each Component Route of
Administration value is included
in the concatenation.

For more information on how the
Route of Administration is
tracked for XEVMPD, see
XEVMPD Submission Wizard Data
Collection Features.

The field data is tracked in the
XEVMPD Audit pre-defined
Analytics report. The value is
displayed under the
Pharmaceutical Product-
Administration Route XEVMPD
Entity. The InSight Entity Type
for the field is PDS.

The Local Route of
Administration
field is hidden by
default and can be
enabled via the
overrides.
If configured, the
multi-select list is
displayed as
empty by default.

This field is not
displayed on the
PDS Template
attributes page.
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Entity Name Field Name Field Type Description Business Rules

Task Related Task
Name

Text
(populated
automatically,
non-
modifiable)

To provide the ability to identify
the association between the
parent Task and its Sub-Task,
Calyx RIM 6.2 enhances the Task
entity by adding a new field
named Related Task Name.
When a Task has an associated
Sub-Task entity, the Related
Task Name field for the Sub-Task
will be automatically populated
with the parent Task Name
value.
To support this enhancements,
the following updates have been
introduced:
— Several Registration Planning

and Tracking reports have
been updated. See Query
Fields Added: Calyx RIM 6.2.

— The Related Task Name
column has been added to the
Querying > Administration >
Entity Audit Trail > Query
table when querying for the
Task entity. The value is not
hyperlinked.

— The Related Task Name
column has been added to the
Search Results page of the
SEARCH functionality when
invoked for the Tasks/Sub-
tasks option.

The Related Task
Name field value is
hyperlinked. When
selected,
navigates you to
the appropriate
Task Attributes
page.
The Related Task
Name field will
always be empty
for the parent Task
entity.
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Wizards
Wizard Name Field Name Field

Type
Description Business Rules

Copy
Package Set
Registration

Country Drop-
down
list

For MRP (Mutual Recognition Procedure)
and DCP (Decentralised Procedure)
Application types, the Copy Package Set
Registration wizard now provides the ability
to select the country to copy the Package
Set Registration while proceeding with the
wizard pages.
The Copy Package Set Registration wizard is
updated with a new drop-down list named
Country that appears on the following
wizard pages:
— New Package Set specific Registration(s)

> Select Product Detail Set page
— New Product specific Registration(s) >

Copy License Code page

The Country drop-down list is a required
field. All Countries associated to the
Application are available for selection. The
field is populated by default with the
Country value from the source Registration.

The Package Sets
will be available
only if the country
selected in the
Country drop-
down list already
has the assigned
Registration.
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Wizard Name Field Name Field
Type

Description Business Rules

Global
Project Plan

Application
Type

Multi-
select
list

To enhance the Global Project Plan wizard,
the Application Type multi-select field has
been added as an additional filter criterion.
The following Global Project Plan wizard
pages have been updated by adding the
Application Type column:
— Create New Events Package Set

Registration > Search by Product,
Country and Application Status page

— Create New Events Product Registration
> Search Country and Application Status
page

— Update Product Detail Sets > Input Query
Filter Criteria page, when searching by:
• Active Ingredient
• PDS Code/PDS Name
• Product and Country
• Substance
• Trade Name

— Withdraw Product Package Set
Registration > Search by Product,
Country Application and PDS Statuses
page

The Application
Type multi-select
field depends on
the selected
countries and
appears only after
the selection is
made in the
Countries multi-
select field.

Query Fields Added: Calyx RIM 6.2

The following table describes fields that were added with Calyx RIM 6.2.

Table 1: Administration Queries

Query Name Field Name Field
Type

Description Business Rules

Entity Audit Trail
When querying
for the Task
entity.

Related
Task Name

Text The name of the parent Task, if
applicable. The reports have also
been updated to add a new
column named Related Task
Name to the Search Results
page.

The value in the column is
hyperlinked. When
selected, navigates you to
the appropriate Task
Attributes page.
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Table 2: Product Detail Management Queries

Query Name Field Name Field
Type

Description Business Rules

List of
Application
Countries with
Registration
and Product
Details

Applications
with
Withdrawn
Countries

Drop-
down
list

A non-required drop-
down list with the
following values
available for selection:
— [Select]
— Yes
— No

The [Select] value is set
by default.

The query results
depend on the value
selected in the
Applications with
Withdrawn Countries
drop-down list, as well
as all other selected
search criteria.

The following rules apply:
— If you select Yes, all

applications and all associated
countries are displayed on the
Query Results page if at least
one of those countries has a
Withdrawn Date value
populated.

— If you select No, all applications
and all associated countries are
displayed on the Query Results
page if those countries are not
withdrawn.

— If you do not make a selection
and leave the default
[Select] value, all
applications and all associated
countries are displayed.
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Table 3: Registration Planning and Tracking Queries

Query Name Field Name Field
Type

Description Business Rules

List of
Application
Countries

Applications
with Withdrawn
Countries

Drop-
down
list

A non-required drop-down
list with the following
values available for
selection:
— [Select]
— Yes
— No

The [Select] value is set by
default.

The query results depend
on the value selected in the
Applications with
Withdrawn Countries drop-
down list, as well as all
other selected search
criteria.

The following rules apply:
— If you select Yes, all

applications and all
associated countries are
displayed on the Query
Results page if at least one
of those countries has a
Withdrawn Date value
populated.

— If you select No, all
applications and all
associated countries are
displayed on the Query
Results page if those
countries are not
withdrawn.

— If you do not make a
selection and leave the
default [Select] value, all
applications and all
associated countries are
displayed.
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Query Name Field Name Field
Type

Description Business Rules

List of
Application
Countries with
Registration
Details

Applications
with Withdrawn
Countries

Drop-
down
list

A non-required drop-down
list with the following
values available for
selection:
— [Select]
— Yes
— No

The [Select] value is set by
default.

The query results depend
on the value selected in the
Applications with
Withdrawn Countries drop-
down list, as well as all
other selected search
criteria.

The following rules apply:
— If you select Yes, all

applications and all
associated countries are
displayed on the Query
Results page if at least one
of those countries has a
Withdrawn Date value
populated.

— If you select No, all
applications and all
associated countries are
displayed on the Query
Results page if those
countries are not
withdrawn.

— If you do not make a
selection and leave the
default [Select] value, all
applications and all
associated countries are
displayed.

List of Tasks Related Task
Name (enter
parent Task/
Sub-Task name
if any)

Text The name of the parent
Task, if applicable. The
reports have also been
updated to add a new
column named Related
Task Name to the Search
Results page.

The value in the column is
hyperlinked. When selected,
navigates you to the
appropriate Task Attributes
page.

List of Tasks -
Rollup by
Application

List of Tasks -
Rollup by
Product
Family

List of Tasks -
Rollup by
Project
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Entity Fields Updated: Calyx RIM 6.2

The following table describes fields that were updated or removed with Calyx RIM 6.2.

Entities
Entity Name Field Name Field

Type
Description Business Rules

Application Application
Status

Drop-
down list

Starting with Calyx RIM
6.2, the Application Status
of an Application can be
set to Withdrawn only
when all Registrations
associated to this
Application have a status
mapped to internal
WITHDRAWN status.

The following wizards have
been updated to reflect this
enhancement:
— Update Status
— Update Event-Country

Status

If you set Associations
Closed As to WITHDRAWN,
the Application Status will
be set to Withdrawn only
when all Registrations
associated to this
Application have a status
mapped to internal
WITHDRAWN status.
Otherwise, the warning
message appears !
Associated
Registration(s) must
be Withdrawn prior
to the Application.
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Entity Name Field Name Field
Type

Description Business Rules

Application
Country

Withdraw Date Date When an Event is closed
as Approved and the PDS
associated to this Event
has a withdrawn Country
Detail, displayed as
Country (Pending
Withdrawal), the parent
Application Country >
Withdraw Date field is
automatically updated to
be equal to Event >
Closed Date field value.
The following explains
specific conditions that
governs the Application
Country > Withdraw Date
field change:
— If Application Country

does not have the
Withdraw Date value
and the Event is closed
with today's date, -1
day (or more) before
today's date, or +1
after today's date, then
the Application Country
> Withdraw Date
inherits the Event >
Event Closed Date
value.

— If Application Country
has the Withdraw Date
field set to today's date
and the Event is closed
with -1 day (or more)
before today's date, or
+1 day after today's
date, then the
Application Country >
Withdraw Date inherits
the Event > Event
Closed Date value.

— If Application Country
has the Withdraw Date
field set to a date
greater then +2 days
(or more) after today's
date and the Event is
closed with today's
date, -1 day (or more)
before today's date, or
+1 day after today's
date, then the
Application Country >
Withdraw Date inherits
the Event > Event
Closed Date value.

The Application Country >
Withdraw Date is not
updated, if:
— The Application Country

> Withdraw Date value
precedes the Event >
Event Closed Date value
and both dates are in
the past.

— The Event > Event
Closed Date value is
equal to Event > Event
Closed Date value.

— The Event > Event
Closed Date is set to
today's date -1 day and
the Event > Event
Closed Date is set to
today's date.
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Entity Name Field Name Field
Type

Description Business Rules

Comparator Suppliers Multi-
select list

The Manufacturer Name
value is now displayed as
a concatenation of
Manufacturer Name +
Address Line 1 +
Country Code.

No updates to the business
rules.

Full Product
Presentation

Full Product
Presentation
Comments

Display The field has been
enhanced to be a display-
only field that includes the
previously added
comments. Can be
updated or deleted from
the View Full Product
Presentation Attributes
page.

Available on the View/
Modify Full Product
Presentation Attributes
pages. Includes all
comments entered by
users, including the date
and time the comments
were entered, and the user
ID of the person who
entered them.

MPID Text The unique identifier
allocated to a Medicinal
Product supplementary to
any existing authorization
number as ascribed by a
Medicines Regulatory
Agency in a jurisdiction.

The MPID field has been
hidden on the Full Product
Presentation View, Create
and Modify pages.

Important: The MPID
values are displayed in the
Entity Audit Trial report for
the Full Product
Presentation entity.

Previous EV
Code

N/A The Previous EV Code
drop-down list has been
reworked to be the FPP
Previous EV Codes tab on
the Full Product
Presentation Attributes
page.
— Field Type: text,

required
— Field Size: 60

characters
— Database Field Size:

VARCHAR2(100)

If there are several
Previous EV Code values, in
the XEVMPD XML file that
results in several
<previousevcode> tags.
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Entity Name Field Name Field
Type

Description Business Rules

Event Comment Text The field has been
renamed to be Event Add
Comment.

Only the field display name
has been changed.

Countries Multi-
select list

Business rules for the
Countries field on the
Create Event page have
been changed.

Withdrawn application
countries with the
Withdraw Date value equal
to today’s date or earlier
are not available for
selection in the Countries
multi-select field on the
Create Event page. This is
applicable only to
applications of Mutual
Recognition (MRP) or
Decentralised Procedure
(DCP) types.

Event Closed As Multi-
select list

The field has been
renamed as Associations
Closed As.

Only the field name has
changed.
The following pages,
tables, and tabs have also
been updated to display
Associations Closed As
column name:
— Home Page > Events

table
— Application > Events tab
— Project > Event Change

Details tab
— View Comparator page
— View Clinical Trial

Shared Data page

Event Closed
Date

Date The field has been
renamed as Closed Date:
— View Event Attributes

page for the closed
events.

— Modify Event Attributes
page, if the Closed
checkbox is selected.

Only the field name has
changed.
The following pages,
tables, and tabs have also
been updated to display
Closed Date column name:
— Home Page > Events

table
— Application > Events tab
— Project > Event Change

Details tab
— View Comparator page
— View Clinical Trial

Shared Data page
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Entity Name Field Name Field
Type

Description Business Rules

Pharmaceutical
Product

Add
Pharmaceutical
Product
Comment

Text The field has been
renamed to be
Pharmaceutical Product
Add Comment.

Only the field display name
has been changed.
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Entity Name Field Name Field
Type

Description Business Rules

Product Add Product
Comment

Text The field has been
renamed to be Product
Add Comment.

Only the field display name
has been changed.

Product
Strength
Measure 1

Numeric Product Strength Measure
1 field has been enhanced
to display a leading zero
value for the decimal
numbers that are less
than 1 on the View
Product Attributes page
for the:
— Pharmaceutical

Product Family
— Flu Vaccine Product

Family
— Pharmaceutical-

Medical Device Product
Family

— Veterinary Product
Family

For example, if you are
entering 0.1 value in the
Product Strength Measure
1 field, it will be displayed
in the Product Attributes >
Product Strength field
including the leading zero,
and followed by the
Product Strength Unit 1
value, if any:

0.1 mg

The business rules for the
field have been enhanced.
The entered value must not
exceed 5 decimal numbers
before the decimal point
and 5 decimal numbers
after the decimal point.
Value cannot be larger than
99999.99999.

Product
Strength
Measure 2

Numeric Product Strength Measure
2 field has been enhanced
to display a leading zero
value for the decimal
numbers that are less
than 1 on the View
Product Attributes page
for the:
— Pharmaceutical

Product Family
— Flu Vaccine Product

Family
— Pharmaceutical-

Medical Device Product
Family

— Veterinary Product
Family

For example, if you are
entering 0.2 value in the
Product Strength Measure
2 field, it will be displayed
in the Product Attributes >
Product Strength field
including the leading zero,
and followed by the
Product Strength Unit 2
value, if any:

0.2 g

The business rules for the
field have been enhanced.
The entered value must not
exceed 5 decimal numbers
before the decimal point
and 5 decimal numbers
after the decimal point.
Value cannot be larger than
99999.99999.
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Entity Name Field Name Field
Type

Description Business Rules

Product Detail
Set

Specialty
Number

Text This value is a part of
mrpnumber for XEVMPD.
The field has been
renamed to be Speciality
Number.

The concatenation formula
is: [Procedure Identifier/
Application Code]
[Speciality
Number1]'-'[Speciality
Number2], if there are two
PDSs associated to the Full
Product Presentation and
the Speciality Number2
value is different from
Speciality Number1 value.

Manufacturer Drop-
down list

The Manufacturer Name
value is now displayed as
a concatenation of
Manufacturer Name +
Address Line 1 +
Country Code in the
Manufacturer drop-down
list for each instance of
the Manufacturer Detail in
the Product Detail Set:
— Component > Active

Ingredient >
Manufacturer

— Component > Active
Ingredient >
Manufacturing Process
> Function >
Manufacturer

— Component >
Substance >
Manufacturer

— Component >
Substance >
Manufacturing Process
> Function >
Manufacturer

— Component >
Manufacturing Process
> Function >
Manufacturer

— Component > Function
> Manufacturer

— PDS > Manufacturing
Process > Function >
Manufacturer

— Package Set > Function
> Manufacturer

— Package Set >
Packaging >
Manufacturer

— Package Set >
Component >
Packaging >
Manufacturer

All active values from the
Data Administration >
Product Detail Set
Maintenance >
Manufacturer Values table
are available for selection.

Country Multi-
select list

Business rules for the
Country field on the Add
Country page have been
changed for the Product
Detail Set > Countries
detail.

Withdrawn application
countries with the
Withdraw Date value equal
to today’s date or earlier
are not available for
selection in the Label
Country drop-down list on
the Add Country page. This
is applicable only to
applications of Mutual
Recognition (MRP) or
Decentralised Procedure
(DCP) types.

Label Country Drop-
down list

Business rules for the
Label Country field on the
Add Label page have been
changed for the Product
Detail Set > Labels detail.

Withdrawn application
countries with the
Withdraw Date value equal
to today’s date or earlier
are not available for
selection in the Label
Country drop-down list on
the Add Label page. This is
applicable only to
applications of Mutual
Recognition (MRP) or
Decentralised Procedure
(DCP) types.

Countries Multi-
select list

Business rules for the
Counties field on the Add/
Modify Manufacturer
pages have been changed.
Applicable for the
following parent Product
Detail Set Details:
— Active Ingredient
— Active Ingredient

Manufacturing Process
Function

— Active Ingredient
Manufacturing Process
Step Function

— Active Ingredient
Manufacturing Process
Step Material

— Component Function
— Component

Manufacturing Process
Function

— Component
Manufacturing Process
Step Function

— Component
Manufacturing Process
Step Material

— Package Set
Component Packaging

— Package Set Function
— Package Set Packaging
— Product Detail Set

Function
— Product Detail Set

Manufacturing Process
Function

— Product Detail Set
Manufacturing Process
Step Function

— Product Details Set
Manufacturing Process
Step Material

— Substance
— Substance

Manufacturing Process
Function

— Substance
Manufacturing Process
Step Function

— Substance
Manufacturing Process
Step Material

Withdrawn application
countries with the
Withdraw Date value equal
to today’s date or earlier
are not available for
selection in the Countries
multi-select field on the
Add/Modify Manufacturer
page. This is applicable
only to applications of
Mutual Recognition (MRP)
or Decentralised Procedure
(DCP) types.

Countries Multi-
select list

Country (countries) for
which this detail is
created. Defines the value
that is included to the
XML file during the
XEVMPD Submission
wizard execution. The
business rules are
changed for the field.
Applicable to:
— Product Detail Set

(Non-Veterinary):
Indication/Intended
Use Detail

— Product Detail Set
(Veterinary): Species
Indication

By default, all countries
associated to the
Application appear in the
Selected box of the
Countries field on the Add
Indication/Intended Use
detail (Non-Veterinary) and
Add Indication (Veterinary)
pages.

Note: The exceptions are
application countries with
the Withdraw Date value
equal to today’s date or
earlier. Such countries are
not available for selection
in the Countries field on the
Add/Modify Indication/
Intended Use (Non-
Veterinary) and Add/Modify
Indication (Veterinary)
pages. This is applicable
only to applications of
Mutual Recognition (MRP)
or Decentralised Procedure
(DCP) types.

You can deselect countries,
if needed.

Excipient Role Drop-
down list

The field has been
renamed as Substance
Role and is now available
regardless of the selected
Substance Type value.
Applicable to:
— Product Detail Set:

Substance Detail
— Product Detail Set

Template: Substance
Detail

The Substance Role value
is displayed in the PDS
Tree as a part of
Substance Name
(Substance Type +
Substance Name +
Substance Role). The
uniqueness rule
concatenation is the
following: Substance
Type + Substance
Name + Substance
Role.

Only the field name has
changed.
The following reports have
also been updated to
display Substance Role and
Substance Name column
names:
— Querying > Product

Detail Management >
Application History
Query > Substance
Details Changed?
subquery

— Querying > Product
Detail Management >
Application QC Status
History Report >
Substance Details QC
Passed? subquery

— Querying >
Administration > Entity
Audit Trail > Product
Detail-Substances entity
type

— Querying > Product
Detail Management >
List of Excipient
Manufacturers

— Querying > Product
Detail Management >
List of Registrations with
Excipients
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Entity Name Field Name Field
Type

Description Business Rules

Project Project Pivot
Status

Drop-
down list

With Calyx RIM 6.2, the
following are updated
with a new PLANNED
status available for
selection:
— Project Pivot Status

drop-down field on the
Create/Modify Projest
Attributes page.

— Enter Project Pivot
Values > Project Pivot
Status drop-down field
of the Calculate
Projected Dates wizard
(Global Project Plan
wizard).

N/A

Registration License
Comments

Text The field name has been
renamed to be License
Add Comment.

Only the field display name
has been changed.

Country Drop-
down list

Business rules for the
Country field on the
Create Registration page
have been changed for
the:
— Package Set

Registration
— Product Registration

Withdrawn application
countries with the
Withdraw Date value equal
to today’s date or earlier
are not available for
selection in the Country
drop-down list on the
Create Registration page.
This is applicable only to
applications of Mutual
Recognition (MRP) or
Decentralised Procedure
(DCP) types.
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Entity Name Field Name Field
Type

Description Business Rules

Registration
Attachment

Attachment
Name

Text Using XML overrides,
Calyx RIM 6.2 can be
configured to disable the
autopopulate function for
the Attachment Name
field.

Only applicable if the
Attachment file is uploaded
from the DMS Repository.

Attachment
Version

Text Using XML overrides,
Calyx RIM 6.2 can be
configured to disable the
autopopulate function for
the Attachment Version
field.

Only applicable if the
Attachment file is uploaded
from the Documentum
DMS Repository.

File Name Text Using XML overrides,
Calyx RIM 6.2 can be
configured to disable the
autopopulate function for
the File Name field.

Only applicable if the
Attachment file is uploaded
from the DMS Repository.

File Type Drop-
down list

Using XML overrides,
Calyx RIM 6.2 system can
be configured to disable
the autopopulate function
for the File Type field.

Only applicable if the
Attachment file is uploaded
from the DMS Repository.
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Entity Name Field Name Field
Type

Description Business Rules

Registration
FPP Attachment

Attachment
Comments

Text The field has been
renamed to be
Registration FPP
Attachment Comments.

Available for modifications
on the Create/Modify
Registration FPP
Attachment Attributes
pages.

Attachment
Concerned
Parties

Text The field has been
renamed to be
Registration FPP
Attachment Concerned
Parties.

Only the field display name
has been changed.

Attachment
Name

Selection
list

The field has been
reworked to be a
Selection list on the
Create Registration FPP
Attachment Name page.
The system returns the
results after clicking the
Select icon next to the
Attachment Name >
Selected box. The
selected Registration
Attachment will be
displayed in the
Attachment Name >
Selected box in the
concatenation of four
fields: Internal Name,
Attachment Language,
Attachment Name,
Attachment Version.

Only one Registration
Attachment can be
selected. The search
results page displays all
Active Registration
Attachments available in
the system.

Important: The
registration attachments,
already associated to the
current Full Product
Presentation, are not
displayed.

Application
Procedure Type

Display N/A (attribute is removed)

Authorisation
Status

Display The status of the
authorisation of a
medicinal product.

N/A (attribute is removed)

Authorised
Pharmaceutical
Form

Display The pharmaceutical form
of the product.

N/A (attribute is removed)

Language Display N/A (attribute is removed)

Product Form Display The physical form in
which this product is
produced and dispensed.

N/A (attribute is removed)

Product
Strength

Display The value used to define
the product strength.

N/A (attribute is removed)

Withdrawn/
Invalidated
Date

Display The date of expiry of the
marketing authorisation.

N/A (attribute is removed)

XEVMPD MAH/
Organisation

Display The current XEVMPD
MAH/Organisation from
the Full Product
Presentation entity.

N/A (attribute is removed)

XEVMPD
Marketing
Authorisation
Number

Display The current XEVMPD
Marketing Authorisation
Number from the Full
Product Presentation
entity.

N/A (attribute is removed)
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Entity Name Field Name Field
Type

Description Business Rules

Sequence Concerned
Member States

Multi-
select list

Business rules for the
Concerned Member
States field on the Create
Sequence page have been
changed.

Withdrawn application
countries with the
Withdraw Date value equal
to today’s date or earlier
are not available for
selection in the Concerned
Member States multi-
select field on the Create
Sequence page.

Sequence
Comments

Text The field has been
renamed to be Sequence
Add Comment.

Only the field display name
has been changed.

Task
(Sub-Task)

Assigner Drop-
down list

Person responsible for
creating the task. The
business rules have been
changed.

Only active users are
available for selection. The
inactive or disabled users
are omitted from the lists
of available values.Premier

Assignee
Drop-
down list

Calyx RIM user that has
been assigned to this
task. The business rules
have been changed.

Task Concerned
Parties

Selection
list

Contains email addresses
and/orCalyx RIM User IDs
for which Notifications
can be sent. The business
rules have been changed.
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Wizards
Wizard Name Field Name Field

Type
Description Business Rules

Change Submittal
Status > Complete
Submission Status
Properties

Confirmed
Sequence
Code

Text Calyx RIM 6.2
enhances the logic of
determining the
Confirmed Sequence
Code value in the
Change Submittal
Status wizard. The
Confirmed Sequence
Code value is
determined based on
the number of
sequences that have
been submitted to
this application
lifecycle, and now
considers all
previously submitted
sequences.

All previously submitted
sequences are taken into
account, even if the current
Sequence Status is set to
Approved.

Create Submission
wizard > Initial
Application > Complete
Submission Properties
(event/sequence)

Event Type Drop-
down
list

The Event Type field
is now available for
modifications.

The drop-down list displays
all Active values from Data
Administration > Event
Maintenance > Event Type
Values. The New Application
value is selected by default in
the Event Type field.
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Wizard Name Field Name Field
Type

Description Business Rules

Find > Activities > View
Activities List

Entity Type Drop-
down
list

The Find > Activities
functionality,
available on the Calyx
RIM Home Page, has
been enhanced and
now provides an
ability to find the
activities associated
with the XEVMPD-
related entities. The
Entity Type drop-
down list available on
the View Activities List
page is updated with
a new entity type
named XEVMPD.

When XEVMPD is selected in
the Entity Type drop-down
list, the following list of filters
is displayed on the View
Activities List page:
— Entity Type Specific

Filters:
• Product Family Type
• Product Family Name
• PSet Registration

— Common Filters:
• Assigned User (multi-

select list)
• Assigned User (text

field)

The following columns are
available on the Search
Results page:
— Activity name
— Assigned User
— Related Workflow
— Related Entity
— Parent Entity (The Parent

entity for all activities of
XEVMPD type is the
corresponding Full
Product Presentation)

— Due Date
— Priority
— Paused
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Wizard Name Field Name Field
Type

Description Business Rules

Global Project Plan >
Add Manufacturer:
— Add Active

Ingredient
Manufacturer flow

— Add Active
Ingredient
Manufacturing
Process Function
Manufacturer flow

— Add Substance
Manufacturer flow

— Add Substance
Manufacturing
Process Function
Manufacturer flow

— Add Component
Function
Manufacturer flow

— Add Component
Manufacturing
Process Function
Manufacturer flow

— Add PDS Function
Manufacturer flow

— Add PDS
Manufacturing
Process Function
Manufacturer flow

— Add Package Set
Function
Manufacturer flow

— Add Package Set
Packaging
Manufacturer flow

— Add Package Set
Component
Packaging
Manufacturer flow

Manufacturer Drop-
down
list

The Manufacturer
Name value is now
displayed as a
concatenation of
Manufacturer
Name + Address
Line 1 + Country
Code.

No updates to the business
rules.
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Wizard Name Field Name Field
Type

Description Business Rules

Project > Event Country
Dates > Update Project
Event Country Status, if
the Close Event? drop-
down field is set to Yes

Event Closed
As

Multi-
select
list

The field has been
renamed as
Associations Closed
As.

Only the field name has
changed.
The following pages, tables,
and tabs have also been
updated to display
Associations Closed As
column name:
— Home Page > Events table
— Application > Events tab
— Project > Event Change

Details tab
— View Comparator page
— View Clinical Trial Shared

Data page

Event Closed
Date

Date The field has been
renamed as Closed
Date.

Only the field name has
changed.
The following pages, tables,
and tabs have also been
updated to display Closed
Date column name:
— Home Page > Events table
— Application > Events tab
— Project > Event Change

Details tab
— View Comparator page
— View Clinical Trial Shared

Data page
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Wizard Name Field Name Field
Type

Description Business Rules

Update Status >
Update Event Country
Status page, if the
Close Event? drop-
down field is set to Yes

Event Closed
As

Multi-
select
list

The field has been
renamed as
Associations Closed
As.

Only the field name has
changed.
The following pages, tables,
and tabs have also been
updated to display
Associations Closed As
column name:
— Home Page > Events table
— Application > Events tab
— Project > Event Change

Details tab
— View Comparator page
— View Clinical Trial Shared

Data page

Event Closed
Date

Date The field has been
renamed as Closed
Date.

Only the field name has
changed.
The following pages, tables,
and tabs have also been
updated to display Closed
Date column name:
— Home Page > Events table
— Application > Events tab
— Project > Event Change

Details tab
— View Comparator page
— View Clinical Trial Shared

Data page

XEVMPD Submission >
Select Sender/Receiver
Information page

Run Initial
Report?

Drop-
down
list

The Initial Report
option has been
hidden in the XEVMPD
Submission wizard.
The Run Initial
Report? drop-down
has been hidden on
the Select Sender/
Receiver Information
page.

The Initial Report Selection
and Initial Report Selection
Results pages that appeared
when the Run Initial Report?
drop-down field was set to
Yes, has been hidden in the
wizard.
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Query Fields Updated: Calyx RIM 6.2

The following table describes fields that were updated or removed with Calyx RIM 6.2.

Table 4: Administration Queries

Query
Name

Field Name Field
Type

Description Business Rules

Entity
Audit Trail

Manufacturer
Name

N/A The Manufacturer Name value is now
displayed as a concatenation of
Manufacturer Name + Address Line
1 + Country Code in the Search Results
> Manufacturer Name column for the
Manufacturer-related subqueries.

No updates to
the business
rules.
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Table 5: Product Detail Management Queries

Query Name Field Name Field Type Description Business Rules

Application
History Query

Event Closed
As

Multi-
select list

The field has been renamed
as Associations Closed As.

Only the field name has
changed.
The following pages,
tables, and tabs have
also been updated to
display Associations
Closed As column name:
— Home Page > Events

table
— Application > Events

tab
— Project > Event

Change Details tab
— View Comparator

page
— View Clinical Trial

Shared Data page

Event Closed
Date

Date The field has been renamed
as Closed Date.

Only the field name has
changed.
The following pages,
tables, and tabs have
also been updated to
display Closed Date
column name:
— Home Page > Events

table
— Application > Events

tab
— Project > Event

Change Details tab
— View Comparator

page
— View Clinical Trial

Shared Data page

Manufacturer
Name

N/A The Manufacturer Name
value is now displayed as a
concatenation of
Manufacturer Name +
Address Line 1 +
Country Code in the
Search Results >
Manufacturer Name column
for the Manufacturer-related
subqueries.

No updates to the
business rules.

N/A N/A The following column names
have been changed in the
Substance Details Changed?
subquery:
— Excipient Role is renamed

to Substance Role
— Excipient Name to

Substance Name

N/A
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Query Name Field Name Field Type Description Business Rules

Application QC
Status History
Report

Event Closed
As

Multi-
select list

The field has been renamed
as Associations Closed As.

Only the field name has
changed.
The following pages,
tables, and tabs have
also been updated to
display Associations
Closed As column name:
— Home Page > Events

table
— Application > Events

tab
— Project > Event

Change Details tab
— View Comparator

page
— View Clinical Trial

Shared Data page

Event Closed
Date

Date The field has been renamed
as Closed Date.

Only the field name has
changed.
The following pages,
tables, and tabs have
also been updated to
display Closed Date
column name:
— Home Page > Events

table
— Application > Events

tab
— Project > Event

Change Details tab
— View Comparator

page
— View Clinical Trial

Shared Data page

Manufacturer
Name

N/A The Manufacturer Name
value is now displayed as a
concatenation of
Manufacturer Name +
Address Line 1 +
Country Code in the
Search Results >
Manufacturer Name column
for the Manufacturer-related
subqueries.

No updates to the
business rules.

Calyx RIM 6.2 Release Notes

© Calyx™ 2023. 79 Calyx RIM 6.2 Release Notes
Calyx.ai Query Fields Updated: Calyx RIM 6.2



Query Name Field Name Field Type Description Business Rules

N/A N/A The following column names
have been changed in the
Substance Details QC
Passed? subquery:
— Excipient Role is renamed

to Substance Role
— Excipient Name to

Substance Name

N/A

List of Active
Ingredient
Function
Manufacturers

Manufacturer
Name

Drop-
down list

The Manufacturer Name
value is now displayed as a
concatenation of
Manufacturer Name +
Address Line 1 +
Country Code in the Enter
Search Criteria >
Manufacturer Name multi-
select list.

No updates to the
business rules.

List of Active
Ingredient
Manufacturers

Manufacturer
Name

Drop-
down list

The Manufacturer Name
value is now displayed as a
concatenation of
Manufacturer Name +
Address Line 1 +
Country Code in the Enter
Search Criteria >
Manufacturer Name multi-
select list.

No updates to the
business rules.

List of Active
Ingredient
Material
Manufacturers

Manufacturer
Name

Drop-
down list

The Manufacturer Name
value is now displayed as a
concatenation of
Manufacturer Name +
Address Line 1 +
Country Code in the Enter
Search Criteria >
Manufacturer Name multi-
select list.

No updates to the
business rules.
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Query Name Field Name Field Type Description Business Rules

List of
Component
Manufacturers

Manufacturer
Name

Drop-
down list

The Manufacturer Name
value is now displayed as a
concatenation of
Manufacturer Name +
Address Line 1 +
Country Code in the Enter
Search Criteria >
Manufacturer Name multi-
select list.

No updates to the
business rules.

List of Excipient
Manufacturers

Manufacturer
Name

Drop-
down list

The Manufacturer Name
value is now displayed as a
concatenation of
Manufacturer Name +
Address Line 1 +
Country Code in the Enter
Search Criteria >
Manufacturer Name multi-
select list.

No updates to the
business rules.

Excipient
Name

Selection
list

The Excipient Name multi-
select list has been renamed
to be Substance Role.
The following column names
have been changed:
— Excipient Role is renamed

to Substance Role
— Excipient Name to

Substance Name

N/A

List of Package
Set
Manufacturers

Manufacturer
Name

Drop-
down list

The Manufacturer Name
value is now displayed as a
concatenation of
Manufacturer Name +
Address Line 1 +
Country Code in the Enter
Search Criteria >
Manufacturer Name multi-
select list.

No updates to the
business rules.
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Query Name Field Name Field Type Description Business Rules

List of PDS
Manufacturers

Manufacturer
Name

Drop-
down list

The Manufacturer Name
value is now displayed as a
concatenation of
Manufacturer Name +
Address Line 1 +
Country Code in the Enter
Search Criteria >
Manufacturer Name multi-
select list.

No updates to the
business rules.
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Query Name Field Name Field Type Description Business Rules

List of Product
Detail Sets

Event Closed
As

Multi-
select list

The field has been renamed
as Associations Closed As.

Only the field name has
changed.
The following pages,
tables, and tabs have
also been updated to
display Associations
Closed As column name:
— Home Page > Events

table
— Application > Events

tab
— Project > Event

Change Details tab
— View Comparator

page
— View Clinical Trial

Shared Data page

Event Closed
Date

Date The field has been renamed
as Closed Date.

Only the field name has
changed.
The following pages,
tables, and tabs have
also been updated to
display Closed Date
column name:
— Home Page > Events

table
— Application > Events

tab
— Project > Event

Change Details tab
— View Comparator

page
— View Clinical Trial

Shared Data page
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Query Name Field Name Field Type Description Business Rules

List of
Registrations
with Excipients

Excipient
Name

Selection
list

The following field names
and column names have
been changed:
— Excipient Role is renamed

to Substance Role
— Excipient Name to

Substance Name

N/A

Excipient Role Multi-
select list

Table 6: Registered Document Analysis Queries

Query Name Field
Name

Field
Type

Description Business Rules

Registered
Document
Query

Event
Closed
As

Multi-
select
list

The field has
been renamed as
Associations
Closed As.

Only the field name has changed.
The following pages, tables, and tabs have also
been updated to display Associations Closed
As column name:
— Home Page > Events table
— Application > Events tab
— Project > Event Change Details tab
— View Comparator page
— View Clinical Trial Shared Data page

Event
Closed
Date

Date The field has
been renamed as
Closed Date.

Only the field name has changed.
The following pages, tables, and tabs have also
been updated to display Closed Date column
name:
— Home Page > Events table
— Application > Events tab
— Project > Event Change Details tab
— View Comparator page
— View Clinical Trial Shared Data page
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Table 7: Registration Planning and Tracking Queries

Query Name Field Name Field
Type

Description Business Rules

List of Applications
with Products

Application
Name/Study
Number

Text Application Name field has
been renamed as
Application Name/Study
Number.

The Application
Name/Study Number
field is displayed on
the List of Applications
with the Products
Query search criteria
selection page and
appears as a column
on the Search Results
page.

Applicable
Standards

Multi-
select
list

The Applicable Standards
value is now displayed as a
concatenation of
Applicable Standards
Name - version in the
Applicable Standards multi-
select list.

Note: The hyphen is
excluded when the version
field is blank.

No updates to the
business rules.

Application
Type

Multi-
select
list

Business rules for the field
have been changed.

All application types
are now available for
selection in the
Application Type
multi-select list.

EU Class Drop-
down
list

This field has been
removed.

N/A

EU Classification
Rule

Drop-
down
list

This field has been
removed.

N/A

FDA Device
Class

Drop-
down
list

This field has been
removed.

N/A

FDA Regulation
Number

Drop-
down
list

This field has been
removed.

N/A

Global Medical
Device
Nomenclature
(GMDN) Code

Multi-
select
list

The Global Medical Device
Nomenclature (GMDN) Code
value is now displayed as a
concatenation of GMDN
Code - GMDN Term Name
in the Global Medical Device
Nomenclature (GMDN) Code
multi-select list.

Note: The hyphen is
excluded when the GMDN
Term Name field is blank.

No updates to the
business rules.

Medical Device
Link/Listing

Text This field has been
removed.

N/A

UMDNS Code Multi-
select
list

The UMDNS Code value is
now displayed as a
concatenation of UMDNS
Code - UMDNS
Description in the
UMDNS Code multi-select
list.

Note: The hyphen is
excluded when the UMDNS
Description field is blank.

No updates to the
business rules.
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Query Name Field Name Field
Type

Description Business Rules

List of Events with
Application
Properties

Event Closed As Multi-
select
list

The field has been renamed
as Associations Closed As.

Only the field name
has changed.
The following pages,
tables, and tabs have
also been updated to
display Associations
Closed As column
name:
— Home Page >

Events table
— Application >

Events tab
— Project > Event

Change Details tab
— View Comparator

page
— View Clinical Trial

Shared Data page

Event Closed
Date

Date The field has been renamed
as Closed Date.

Only the field name
has changed.
The following pages,
tables, and tabs have
also been updated to
display Closed Date
column name:
— Home Page >

Events table
— Application >

Events tab
— Project > Event

Change Details tab
— View Comparator

page
— View Clinical Trial

Shared Data page
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Query Name Field Name Field
Type

Description Business Rules

List of
Manufacturers From
Data Administration

Manufacturer
Name

Text The Manufacturer Name
value is now displayed as a
concatenation of
Manufacturer Name +
Address Line 1 +
Country Code in the
Search Results >
Manufacturer Name
column.

No updates to the
business rules.
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Query Name Field Name Field
Type

Description Business Rules

List of Medical
Device Products

Applicable
Standards

Multi-
select
list

The Applicable Standards
value is now displayed as a
concatenation of
Applicable Standards
Name - version in the
Applicable Standards multi-
select list.

Note: The hyphen is
excluded when the version
field is blank.

No updates to the
business rules.

EU Class Drop-
down
list

This field has been
removed.

N/A

EU Classification
Rule

Drop-
down
list

This field has been
removed.

N/A

FDA Device
Class

Drop-
down
list

This field has been
removed.

N/A

FDA Regulation
Number

Drop-
down
list

This field has been
removed.

N/A

Global Medical
Device
Nomenclature
(GMDN) Code

Multi-
select
list

The Global Medical Device
Nomenclature (GMDN) Code
value is now displayed as a
concatenation of GMDN
Code - GMDN Term Name
in the Global Medical Device
Nomenclature (GMDN) Code
multi-select list.

Note: The hyphen is
excluded when the GMDN
Term Name field is blank.

No updates to the
business rules.

Medical Device
Link/Listing

Text This field has been
removed.

N/A

UMDNS Code Multi-
select
list

The UMDNS Code value is
now displayed as a
concatenation of UMDNS
Code - UMDNS
Description in the
UMDNS Code multi-select
list.

Note: The hyphen is
excluded when the UMDNS
Description field is blank.

No updates to the
business rules.
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Query Name Field Name Field
Type

Description Business Rules

List of Medical
Device Products
and Components

Applicable
Standards

Multi-
select
list

The Applicable Standards
value is now displayed as a
concatenation of
Applicable Standards
Name - version in the
Applicable Standards multi-
select list.

Note: The hyphen is
excluded when the version
field is blank.

No updates to the
business rules.

EU Class Drop-
down
list

This field has been
removed.

N/A

EU Classification
Rule

Drop-
down
list

This field has been
removed.

N/A

FDA Device
Class

Drop-
down
list

This field has been
removed.

N/A

FDA Regulation
Number

Drop-
down
list

This field has been
removed.

N/A

Global Medical
Device
Nomenclature
(GMDN) Code

Multi-
select
list

The Global Medical Device
Nomenclature (GMDN) Code
value is now displayed as a
concatenation of GMDN
Code - GMDN Term Name
in the Global Medical Device
Nomenclature (GMDN) Code
multi-select list.

Note: The hyphen is
excluded when the GMDN
Term Name field is blank.

No updates to the
business rules.

Medical Device
Link/Listing

Text This field has been
removed.

N/A

UMDNS Code Multi-
select
list

The UMDNS Code value is
now displayed as a
concatenation of UMDNS
Code - UMDNS
Description in the
UMDNS Code multi-select
list.

Note: The hyphen is
excluded when the UMDNS
Description field is blank.

No updates to the
business rules.
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Query Name Field Name Field
Type

Description Business Rules

List of
Pharmaceutical and
Medical Device
Products

Applicable
Standards

Multi-
select
list

The Applicable Standards
value is now displayed as a
concatenation of
Applicable Standards
Name - version in the
Applicable Standards multi-
select list.

Note: The hyphen is
excluded when the version
field is blank.

No updates to the
business rules.

EU Class Drop-
down
list

This field has been
removed.

N/A

EU Classification
Rule

Drop-
down
list

This field has been
removed.

N/A

FDA Device
Class

Drop-
down
list

This field has been
removed.

N/A

FDA Regulation
Number

Drop-
down
list

This field has been
removed.

N/A

Global Medical
Device
Nomenclature
(GMDN) Code

Multi-
select
list

The Global Medical Device
Nomenclature (GMDN) Code
value is now displayed as a
concatenation of GMDN
Code - GMDN Term Name
in the Global Medical Device
Nomenclature (GMDN) Code
multi-select list.

Note: The hyphen is
excluded when the GMDN
Term Name field is blank.

No updates to the
business rules.

Medical Device
Link/Listing

Text This field has been
removed.

N/A

UMDNS Code Multi-
select
list

The UMDNS Code value is
now displayed as a
concatenation of UMDNS
Code - UMDNS
Description in the
UMDNS Code multi-select
list.

Note: The hyphen is
excluded when the UMDNS
Description field is blank.

No updates to the
business rules.
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Query Name Field Name Field
Type

Description Business Rules

List of
Pharmaceutical and
Medical Device
Products and
Components

Applicable
Standards

Multi-
select
list

The Applicable Standards
value is now displayed as a
concatenation of
Applicable Standards
Name - version in the
Applicable Standards multi-
select list.

Note: The hyphen is
excluded when the version
field is blank.

No updates to the
business rules.

EU Class Drop-
down
list

This field has been
removed.

N/A

EU Classification
Rule

Drop-
down
list

This field has been
removed.

N/A

FDA Device
Class

Drop-
down
list

This field has been
removed.

N/A

FDA Regulation
Number

Drop-
down
list

This field has been
removed.

N/A

Global Medical
Device
Nomenclature
(GMDN) Code

Multi-
select
list

The Global Medical Device
Nomenclature (GMDN) Code
value is now displayed as a
concatenation of GMDN
Code - GMDN Term Name
in the Global Medical Device
Nomenclature (GMDN) Code
multi-select list.

Note: The hyphen is
excluded when the GMDN
Term Name field is blank.

No updates to the
business rules.

Medical Device
Link/Listing

Text This field has been
removed.

N/A

UMDNS Code Multi-
select
list

The UMDNS Code value is
now displayed as a
concatenation of UMDNS
Code - UMDNS
Description in the
UMDNS Code multi-select
list.

Note: The hyphen is
excluded when the UMDNS
Description field is blank.

No updates to the
business rules.
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Query Name Field Name Field
Type

Description Business Rules

List of Product
Families

Product Family
Name

Multi-
select
list

The Product Family Name
field has been reworked to
be a multi-select list instead
of a text field in the List of
Product Families query.

This change enables
the active ingredients
in the Substance
Selection list to be
filtered according to
their association to
the selected product
families.
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Query Name Field Name Field
Type

Description Business Rules

List of Products with
Event and Product
Registration Details

Event Closed As Multi-
select
list

The field has been renamed
as Associations Closed As.

Only the field name
has changed.
The following pages,
tables, and tabs have
also been updated to
display Associations
Closed As column
name:
— Home Page >

Events table
— Application >

Events tab
— Project > Event

Change Details tab
— View Comparator

page
— View Clinical Trial

Shared Data page

Event Closed
Date

Date The field has been renamed
as Closed Date.

Only the field name
has changed.
The following pages,
tables, and tabs have
also been updated to
display Closed Date
column name:
— Home Page >

Events table
— Application >

Events tab
— Project > Event

Change Details tab
— View Comparator

page
— View Clinical Trial

Shared Data page
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Query Name Field Name Field
Type

Description Business Rules

List of Sequences
with Application
and Event
Properties

Event Closed As Multi-
select
list

The field has been renamed
as Associations Closed As.

Only the field name
has changed.
The following pages,
tables, and tabs have
also been updated to
display Associations
Closed As column
name:
— Home Page >

Events table
— Application >

Events tab
— Project > Event

Change Details tab
— View Comparator

page
— View Clinical Trial

Shared Data page

Event Closed
Date

Date The field has been renamed
as Closed Date.

Only the field name
has changed.
The following pages,
tables, and tabs have
also been updated to
display Closed Date
column name:
— Home Page >

Events table
— Application >

Events tab
— Project > Event

Change Details tab
— View Comparator

page
— View Clinical Trial

Shared Data page
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Table 8: Entity History Queries

Entity
Name

Field Name Field
Type

Description Business Rules

Event Event Closed As Multi-
select
list

The field has been renamed as
Associations Closed As:
— View Event Attributes page

for the closed events.
— Modify Event Attributes page,

if the Closed checkbox is
selected.

Only the field name has
changed.
The following pages, tables,
and tabs have also been
updated to display
Associations Closed As
column name:
— Home Page > Events

table
— Application > Events tab
— Project > Event Change

Details tab
— View Comparator page
— View Clinical Trial

Shared Data page

Event Closed
Date

Date The field has been renamed as
Closed Date.

Only the field name has
changed.
The following pages, tables,
and tabs have also been
updated to display Closed
Date column name:
— Home Page > Events

table
— Application > Events tab
— Project > Event Change

Details tab
— View Comparator page
— View Clinical Trial

Shared Data page
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Entity
Name

Field Name Field
Type

Description Business Rules

Product Applicable
Standards

Multi-
select
list

The Applicable Standards value
is now displayed as a
concatenation of Applicable
Standards Name - version
in the Applicable Standards
multi-select list.

Note: The hyphen is excluded
when the version field is blank.

No updates to the business
rules.

EU Class Drop-
down
list

This field has been removed. N/A

EU Classification
Rule

Drop-
down
list

This field has been removed. N/A

FDA Device Class Drop-
down
list

This field has been removed. N/A

FDA Regulation
Number

Drop-
down
list

This field has been removed. N/A

Global Medical
Device
Nomenclature
(GMDN) Code

Multi-
select
list

The Global Medical Device
Nomenclature (GMDN) Code
value is now displayed as a
concatenation of GMDN Code -
GMDN Term Name in the Global
Medical Device Nomenclature
(GMDN) Code multi-select list.

Note: The hyphen is excluded
when the GMDN Term Name
field is blank.

No updates to the business
rules.

Medical Device
Link/Listing

Text This field has been removed. N/A

UMDNS Code Multi-
select
list

The UMDNS Code value is now
displayed as a concatenation of
UMDNS Code - UMDNS
Description in the UMDNS
Code multi-select list.

Note: The hyphen is excluded
when the UMDNS Description
field is blank.

No updates to the business
rules.
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Database Columns Changed: Calyx RIM 6.2

The following database columns were added or changed in Calyx RIM 6.2.

Field Name Field
Size

Database Column
Name

Database Column Size Database Table
Name

N/A N/A ABSOLUTE_SEQ_N
O

NUMBER(10) has been changed to
NUMBER

— ODS.TOC_ENTR
Y

— AUD.TOC_ENTR
Y

N/A N/A ASSIGNEE_LDAP_I
DENTIFIER

VARCHAR2(100) has been
changed to VARCHAR2(500)

WF_LOG

Resolved Issues: Calyx RIM 6.2

The following issues that were reported to Technical Support have been resolved.

Issues are listed in descending order by their internal tracking numbers. Customer incident numbers that were
recorded when the issues were reported are included in brackets [#####] following the internal tracking number.

Calyx RIM 6.2 resolves the following issues.

Issue Build Hotfix Build Description

25738 6.2.0.0.0296 N/A Some internal Calyx RIM processes may have caused
issues that resulted in the Status 500 error pages
appearing in the user interface. However, those issues
were recorded as a SQLException: Protocol
violation message in the server.log file. This
issue is resolved by upgrading the Oracle JDBC driver
to be fully compatible with the Oracle 12.2.0.1
version.
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Issue Build Hotfix Build Description

25726 6.2.0.0.0296 N/A For MRP (Mutual Recognition Procedure) and DCP
(Decentralised Procedure) Application types, the Copy
Package Set Registrations wizard did not provide the
ability to select the country to copy the Package Set
Registration while proceeding with the wizard pages.
This issue is resolved. The Copy Package Set
Registrations wizard has been updated with a new
drop-down list named Country that appears on the
following wizard pages for the MRP and DCP
Application types:
— New Package Set specific Registration(s) > Select

Package Set(s) page
— New Product specific Registration(s) > Copy

License Code page

25667,
25352,
24982;
[00057163,
00053947,
00049818,
00052494]

6.2.0.0.0296 N/A When you selected an Applicant Contact for the 1
Administrative Information folder in US eCTD Module
1 assembly template (v3.3), the Search and Sort
functions did not work in the Select Applicant Contact
list. This issue is resolved. The mechanism for data
sorting and filtering has been improved. The correct
results are now displayed when the Search, Sort, or
Filter options are applied.

25622;
[00056776]

6.2.0.0.0296 N/A When you had one Registration with several Product
Detail Sets assigned to it, and one assigned Full
Product Presentation where Active Ingredient and
Substance are identical, after the XEVMPD Submission
wizard was completed you received an XML file with
one tag for the same Active Ingredient and one tag for
the same Substance without duplicating data.
However, for the same Indication/Intended Use and
Indication value the generated XML file contained
duplicate tags. This issue is resolved. One Indication/
Intended Use value is present in the generated XML
file when the same Indication/Intended Use Detail
(non-Veterinary Product Detail Sets), or Indication
Detail (Veterinary Product Detail Sets) is associated to
several Product Detail Sets that are associated to one
Full Product Presentation via Package Sets.
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Issue Build Hotfix Build Description

25605
[00056656]

6.2.0.0.0296 N/A After an event was updated from a workflow, the list of
products was not displayed in the Products tab under
that Event. This issue is resolved. All associated
products are displayed in the Products tab.

25561,
25535
[00056173,
00055825]

6.2.0.0.0296 — 25561 -
6.1.0.3.
0115

— 25535 -
6.1.0.3.
0111

When a multi-select extra field had more than one
value and was included in a workflow, not all values
were displayed for the field on the Activity page. This
issue is resolved. The mechanism of processing the
custom multi-select fields is improved to handle fields
that contain multiple values.

25557;
[00056104]

6.2.0.0.0296 6.1.0.3.0115 When attempting to save changes to a Product Family
through a workflow, the error message Cannot
modify active ingredients on a Product
Family that has associated Products was
generated. This issue is resolved. The appropriate
validation process is improved and the Product Family
can now be updated through a workflow.

25554;
[00055924]

6.2.0.0.0296 N/A When creating and associating a PDS using a Product
Detail Set template, clicking the Save button more
than once resulted in the PDS appearing to be
associated with an Event multiple times. This issue is
resolved.

25551,
25381;
[00056031;
00054223]

6.2.0.0.0296 6.1.0.3.0120 When assigning an Activity or a Task to a user with a
User Name containing a comma (,) character, the
following appeared:
— The assigned Activity was not displayed in the My

Activities tab invoked from GO TO > Activities or
Navigation Pane > Activities.

— The Task Alert was not displayed in the Alert Center
on the Calyx RIM Home Page.

The system could not correctly interact with a
database because the comma character was not
included in the list of allowed special characters that
can be processed during the execution of certain
operations. This issue is resolved. The system has
been updated to add the comma character to the list
of allowed special characters that can be processed by
the system.
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Issue Build Hotfix Build Description

25546;
[00055951]

6.2.0.0.0296 6.1.0.3.0117 Due to the Internet Explorer one hour time out, the
XEVMPD Audit Report was not returning data and was
not responding in an acceptable time limit. This issue
is resolved. The Calyx RIM 6.2 release improves
performance of the XEVMPD Audit Report
functionality.

25542;
[00055861]

6.2.0.0.0296 N/A When modifying a closed event, setting the Event
Closed As field to [Select] and trying to save
changes caused an invalid reference exception to
appear and the event itself to become unavailable
through any navigation paths. This issue is resolved. A
new warning message is displayed stating that Event
Closed As is a required field and must be specified
prior to saving the changes.

25541;
[00055826]

6.2.0.0.0296 6.1.0.3.0111 When completing an activity that required selecting a
user field where the distinguished name was greater
than 100 characters, the following error message was
generated: "! Exception while executing
event-listener". This issue is resolved by allowing
for distinguished name values up to 255 characters
long.

25539;
[00055840]

6.2.0.0.0296 N/A When statuses are deleted from the Event-Country
Attributes > Status Dates tab, the system should
update both Actual Date and Projected Date attributes
to have the Null value in the database. However only
the ACTUAL_DATE (Actual Date) database value was
updated correctly and the SCHED_DATE (Projected
Date) value stayed unchanged. This issue is resolved.
When the status is deleted, the ACTUAL_DATE and
SCHED_DATE values are updated to have Null value
in the event_country_status_schedule
database table.

25538,
25495;
[00052193,
00058004,
00056979,
00055469]

6.2.0.0.0296 N/A There were performance issues observed when
expanding the Assembly Tree nodes. The performance
of expanding the nodes in the assembly tree and
refreshing the expanded assembly tree has been
improved. For more information on the new version of
the assembly tree see Working with New Assembly
Tree..
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Issue Build Hotfix Build Description

25536;
[00055812]

6.2.0.0.0296 6.1.0.3.0116 A deadlock occurred in Calyx RIM when several
workflow actions were performed when a long-running
transaction (for example, lifecycle event) was in
progress. When the workflow Activiti engine inserts a
new row in a table in the Activiti schema, it uses an
internal DbIdGenerator to generate the next ID
value. The DbIdGenerator has a setting for
idBlockSize that determines how many IDs to
distribute before going back to the database for the
next block.
When a long-running transaction requested a new ID
block, and then another transaction requested a new
ID block before the first long-running transaction was
committed, a deadlock occurred. This release reduces
the possibility of a deadlock by increasing the default
block size from 2,500 to 50,000. Also, this release
enables the default block size value to be configurable
by adding the following setting in the insight.var
file specifying the appropriate block size:
— activiti.blockSize=50000

Note: 50000 is a default size.

25526;
[00055788]

6.2.0.0.0296 N/A The Yes value set in the Publishing Settings Library >
Default Values for the Use Native File attribute was not
inherited by the leaf elements created automatically
by associating documents with the folders. This issue
is resolved. When the leaf is automatically created, the
value set for the Use Native File attribute in the
Publishing Settings Library is preserved.

25516;
[00055405]

6.2.0.0.0296 6.1.0.3.0117 Updating the Publishing Settings to add or remove a
DTD sometimes took much longer in Calyx RIM 6.2
compared to previous versions. This release improves
the performance by causing Oracle to choose a better
execution plan when updating Publishing Settings to
add or remove a DTD.
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Issue Build Hotfix Build Description

25511;
[00055024]

6.2.0.0.0296 N/A In the Global Project Plan wizard, the manufacturers
available for selection in the Manufacturer drop-down
list were displayed in a random order for the following
Update Product Detail Set Project > Add Manufacturer
flows:
— Add Active Ingredient Manufacturer
— Add Active Ingredient Manufacturing Process

Function Manufacturer
— Add Substance Manufacturer
— Add PDS Function Manufacturer

This issue is resolved. The sorting mechanism has
been added to display the Manufacturer values in the
Manufacturer drop-down list in alphabetical order.

25510;
[00055531,
00057192]

6.2.0.0.0296 N/A For the following listed queries, the Substance
Selection list (Search Criteria > Active Ingredient Name
> Select) displayed all Active Ingredients from the
Data Administration > Product Family Maintenance >
Substance Values table:
— Product Detail Management > List of Active

Ingredient Manufacturers
— Product Detail Management > List of Active

Ingredient Function Manufacturers
— Product Detail Management > List of Active

Ingredient Material Manufacturers
— Product Detail Management > List of Registrations

with Active Ingredients
— Registration Planning and Tracking > List of Product

Families

In Calyx RIM 6.2, the Substance Selection list was
reworked to display only Active Ingredients associated
to the product families selected in the Product Family/
Product Family Name multi-select list.

25508;
[00055608]

6.2.0.0.0296 6.1.0.3.0111 In Calyx RIM for Analytics, the XEVMPD Audit Report
returned duplicated results when a product was
associated with more than one application. This issue
is resolved.
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Issue Build Hotfix Build Description

25501,
25464;
[00054523,
00054500,
00055108,
00054523]

6.2.0.0.0296 N/A Performance issues were observed when the Ready
for Submission wizard retargeted Reference Leafs for
the entire Working View after the Assembly Plan was
merged. This could cause the job to fail and the
Source leaf cannot be a reference leaf
error message to appear in the Job Details. The
performance issue is resolved. The retargeting
reference leafs system function is improved. The job is
successfully completed and no error messages are
displayed in the Job Details when the Ready for
Submission wizard is finished.

25484;
[00055433]

6.2.0.0.0296 6.1.0.3.0115 Volumes were created with blank names if the
Assembly was volumized out of order. This issue is
resolved. The mechanism of identifying the sibling
volumes during the Bulk Volumization by Sheets
operation has been improved.

25483;
[00055072]

6.2.0.0.0296 6.1.0.3.0100 When in the Working View with Try New Version of an
assembly tree option selected, using drag and drop to
replace a document in a leaf with NEW status resulted
in the leaf status not being automatically updated to
REPLACE. This issue is resolved. The assign DMS
nodes function is improved to refresh the assembly
tree when the assign action is completed.

25481;
[00055174]

6.2.0.0.0296 N/A When requesting a DMS Synchronization from the
Publishing View, all nodes from previous sequences
were processed and that could take an extended
period of time to complete. This issue is resolved. The
performance of DMS Synchronization invoked from the
Publishing View has been improved.

25475;
[00054686]

6.2.0.0.0296 6.1.0.4.0041 Attempting to generate a volume TOC resulted in a
Failed to resolve TocEntry Name error in the
Job Requests window. The error ORA-01438: value
larger than specified precision allowed
for this column was also seen in the
server.log.file. This issue is resolved. The
precision constraint in the
ods.toc_entry.absolute_seq_no column has
been removed.

25469 6.2.0.0.0296 Attempting to delete a Dose Schedule PDS Detail
resulted in an error. This issue is resolved.
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Issue Build Hotfix Build Description

25465 6.2.0.0.0296 6.1.0.3.0100 In Calyx RIM 6.1, an update trigger on the content
table was modified to not create entries if the update
was due to a renumbering event. The trigger, however,
denoted updates to the content table as inserts
instead of updates. The database script included with
this release corrects the trigger and repairs affected
data.

25461;
[00055117]

6.2.0.0.0296 N/A For the Canadian eCTD Module 1 v2.2, entering invalid
numeric-only value for the Sequence Description field
caused an UndeclaredThrowableException error
message to appear in the publish Job Details. This
issue is resolved. The revised message explains that
numeric-only values are not supported for the
Sequence Description field, and is displayed when you
try to save the metadata.

25460;
[00055109]

6.2.0.0.0296 N/A When creating a New (Empty) Standalone Assembly,
or a Standalone Assembly from an Assembly File using
the New > Standalone Assembly option, the following
fields were displayed as non-required:
— Publishing Settings Library
— Use Source Assembly Publishing Settings Library

Saving those Standalone Assemblies without making
any selections in the listed fields caused warning
messages to appear.

This issue is resolved. The fields are followed by an
asterisk (*) indicating that they are required.

25457;
[00055111,
00054917]

6.2.0.0.0296 N/A In the unlocked Submitted View of an assembly you
were unable to remove empty folders using the Delete
icon on the Folder Attributes, if the Try New Version of
an assembly tree option was selected. This issue is
resolved. Now you can delete empty folders in the new
version of an assembly tree.

25440;
[00055119]

6.2.0.0.0296 6.1.0.4.0041 When creating a Working Assembly using the Create
eCTD wizard, the error ORA-00932: inconsistent
datatypes: expected NUMBER got BINARY
occurred if the checkbox Update the sub-folder
structure for was selected. This issue is resolved. The
Create eCTD wizard can be finished successfully
without displaying any errors.
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Issue Build Hotfix Build Description

25434;
[00054636]

6.2.0.0.0296 N/A When you selected the Create Missing Renditions and
Extractions option for a PDF document with PDF Exists
value set to Yes and Extractions Exist value set to No,
the job was completed. However, the following
message was displayed in the Job Requests details
page: No document to render. This issue is
resolved. An additional verification has been added for
the Prepare to Publish. The system checks the
Extractions Exist flag of a source document and the
functionality now works as designed.
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Issue Build Hotfix Build Description

25422 6.2.0.0.0296 N/A The following columns that display data related to
Substance PDS Detail child entities were missing from
the Product Detail Management > Application History
and Product Detail Management > Application QC
Status History queries:
— Application History Query:

• Substance Manufacturing Process Details
Changed?

• Substance Manufacturing Process Function
Details Changed?

• Substance Manufacturing Process Function
Manufacturer Details Changed?

• Substance Manufacturing Process Step Details
Changed?

• Substance Manufacturing Process Step Function
Details Changed?

• Substance Manufacturing Process Step Function
Manufacturer Details Changed?

• Substance Material Details Changed?
• Substance Material Manufacturer Details

Changed?
— Application QC Status History Report:

• Substance Manufacturing Process Details QC
Passed?

• Substance Manufacturing Process Function
Details QC Passed?

• Substance Manufacturing Process Function
Manufacturer Details QC Passed?

• Substance Manufacturing Process Step Details
QC Passed?

• Substance Manufacturing Process Step Function
Details QC Passed?

• Substance Manufacturing Process Step Function
Manufacturer Details QC Passed?

• Substance Material Details QC Passed?
• Substance Material Manufacturer Details QC

Passed?

This issue is resolved. The appropriate values are now
available for selection in the Display Columns multi-
select field on the Application History Query > Enter
Search Criteria and Application QC Status History
Report > Enter Search Criteria pages. The appropriate
columns appear on the Search Results page of both
queries for the Substance PDS Detail related entities,
when those columns are selected. The value
presented in each of the columns is a hyperlink to the
specific subreport.

Calyx RIM 6.2 Release Notes

© Calyx™ 2023. 106 Calyx RIM 6.2 Release Notes
Calyx.ai Resolved Issues: Calyx RIM 6.2



Issue Build Hotfix Build Description

25414;
[00054605]

6.2.0.0.0296 6.1.0.4.0041 The FLASHBACK_TIME=SYSTIMESTAMP parameter
was added to the expdp commands in the
dpexportinsight.sql to keep all exported tables
synchronised to the same point of time.

25410;
[00055170,
00054235]

6.2.0.0.0296 6.1.0.3.0099 For US grouped submissions, the order of M1
metadata unintentionally affected whether or not the
primary application was listed first in the published
us-regional.xml. This issue is resolved. The
primary application is always listed first in the
regional.xml.

25405;
[00054019]

6.2.0.0.0296 6.1.0.3.0093 For US eCTD v2.01 submissions: When using the
Import eCTD to Application wizard (Import from eCTD
icon on the Application attributes page) to import
several sequences having 1.14.1.X subfolders
introduced non-sequentially in different sequences,
the nodes were not ordered numerically in the
submitted view created by the import process. This
issue is resolved.

25401;
[00053089]

6.2.0.0.0296 6.1.0.3.0100 When the Rendition Identifier for an assembly
document without a custom rendition was set to a
non-standard value and the Use Standard Rendition
option was selected for Missing Rendition Identifier
Handling in Publishing Settings, Linking plug-in (PDF)
was allowing you to create links in the standard
rendition of the document instead of displaying an
error as expected. This issue is resolved.

25395;
[00054382]

6.2.0.0.0296 6.1.0.3.0092 When Calyx RIM attempted to create a
DataExchangeExport file with the exact same
timestamp-inclusive file name as an already existing
export file, the duplicate name file would not be
created. This issue is resolved by adding milliseconds
to the timestamp portion of the filename to avoid
duplicates.

25391;
[00054454,
00054327,
00053609]

6.2.0.0.0296 DB_hotfix6
_1_0_chf3_
0136.zip

ORA-01789 and ORA-00942 errors occurred during
the Calyx RIM6.2 CHF 3 migration when the AUD table
had an obsolete column that did not exist in the
corresponding table in the ODS/MGR/SEC schema.
This issue is resolved and is no longer presented when
migrating to Calyx RIM 6.2 from the previous Calyx
RIM versions. Also, the RULE hint is added to improve
the migration performance.

Calyx RIM 6.2 Release Notes

© Calyx™ 2023. 107 Calyx RIM 6.2 Release Notes
Calyx.ai Resolved Issues: Calyx RIM 6.2



Issue Build Hotfix Build Description

25379;
[00054093]

6.2.0.0.0296 6.1.0.3.0092 When a Document with a Rendition Identifier that had
been assigned to a document by default was later
updated in the Working View of the Assembly to have
any other Rendition Identifier value from Data
Administration > DMS Integration > Rendition
Identifier Values table, the change was not displayed
in the Publishing View of the Assembly. However, in
the published output the rendition was set correctly.
This issue is resolved. During the document create or
update actions, the list of specific attributes are
copied from the Working View of an Assembly to the
Publishing View. To have the Rendition Identifier value
in the list that is copied to the Publishing View of an
Assembly, the missing RenditionModifierTypeId value
has been added to the system Copy function.

25376;
[00054015,
00053356]

6.2.0.0.0296 N/A Performance issues were observed when the system
processed leafs in a sequence assembly within one
application, for example converting a standard leaf to
be a reference leaf. To fix the performance issue, the
query has been optimized.

25370;
[00053016]

6.2.0.0.0296 6.1.0.3.0100 When the jp-regional-index.xml file was
replaced in Sequence 0001 and again in Sequence
0002, the index.xml file for Sequence 0002
referenced the 0000 regional xml file as the modified
file instead of the 0001 version. This issue is resolved.
For Japanese submissions, the method of searching
for the sequence with the latest updated content is
improved.

25361;
[00054034]

6.2.0.0.0296 6.0.0.6.0027 If a Product Detail Set (PDS) had multiple approved
Package Set details with approved Packaging details,
the Product Detail Management > List of Registrations
with Packaging query displayed each package set on
the Search Results page, however only one Package
Set was assigned to the Registration. This issue is
resolved. The query Search Results page now displays
only Package Set details associated to the
Registration.
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25358;
[00053900]

6.2.0.0.0296 N/A The Applicant Contact table for the US Module 1 eCTD
v2.3 specification (DTD v3.3) Assembly > 1
Administrative Information folder displayed the
Telephone and Email values as dimmed and
unavailable, if:
— There were several Contact Telephone Number

values with different telephone number types, but
identical telephone numbers, assigned and one of
them had been deactivated later on the Data
Administration > Submission Maintenance >
Applicant Contact Values > Applicant Contact
Telephone Number tab.

— There were several Contact Email values assigned
and one of them had been deactivated later on the
Data Administration > Submission Maintenance >
Applicant Contact Values > Applicant Contact Email
tab.

The issue is resolved:
— For Contact Email, only the deactivated value is

displayed as dimmed and unavailable.
— For the Contact Telephone Number, the system

checks the unique combination of the Telephone
Number Type and Telephone Number values and
indicates only the deactivated value to be displayed
as dimmed and unavailable.

25348;
[00054367]

6.2.0.0.0296 6.1.0.3.0117 In Calyx RIM 6.2, the queries related to the following
areas have been optimized to reduce the possibility of
database locks:
— Getting Events under Application
— Actions with the XEVMPD change history
— DTD change for an Assembly

As part of this optimization, a new index has been
added to the XEVMPD change history.

25345;
[00053849]

6.2.0.0.0296 DB_hotfix6
_1_0_chf3_
0137.zip

The performance of the upgrade script that was used
to migrate to Calyx RIM 6.1 CHF 3 has been improved.
The DB_hotfix6_1_0_chf3_0137.zip upgrade
script supercedes the
DB_hotfix6_1_0_chf3_0136.zip upgrade script
and must be used to migrate to Calyx RIM 6.1 CHF 3.
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25333 6.2.0.0.0296 N/A When setting up a notification for Registration FPP
Attachment and selecting the When a value changes
option to display the notification in the Alert Center,
the notification was triggered. However, the entity URL
on the Notification Attributes page displayed
incorrectly concatenated data: Internal Name,
Country, Attachment Name, and Attachment Version.
This issue is resolved. The URL is displayed as a
concatenation of Internal Name, Language,
Attachment Name, and Attachment Version.

25324 6.2.0.0.0296 N/A It was not possible to re-target a link that was already
targeted to a bookmark. This issue is resolved.

25322 6.2.0.0.0296 N/A When creating a new assembly using either the
Existing Template, Assembly, or View option, the OK
button on the Search Assembly Wizard remained
unavailable after selecting the matching assembly.
This issue is resolved. The OK button becomes active
after you select the matching assembly and then click
on Next.

25312;
[00058254]

6.2.0.0.0296 6.1.0.4.0047 Attempting to delete a link from the Link Inspector
results failed with an error. This issue is resolved. No
error message is displayed when you delete a link
from the Link Inspector results.

25309;
[00054064;
00053322]

6.2.0.0.0296 6.1.0.3.0092 Calyx RIM 6.2 introduces a fix for Calyx RIM for
Analytics to decrease the amount of time needed to
load the Manufacturer Report page with the selection
criteria.
To improve the report performance, the PDS Name
filter criterion has been removed from the
Manufacturer Report filter criteria selection page. The
PDS Name column on the report Search Results page
is preserved.

25308;
[00053352]

6.2.0.0.0296 N/A In the Calyx RIM 6.1 CHF 1 and Calyx RIM 6.1 CHF 2
upgrade scripts, passwords from the
define.migration file were stored and displayed in
the resulting master.sql log file. The Calyx RIM 6.2
upgrade script resolves this issue.
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25299;
[00053287]

6.2.0.0.0296 6.1.0.3.0093 When assigning Withdrawal Time Unit values to the
Species > Route of Administration > Withdrawal Times
PDS Detail during the creation of a PDS Template, the
Withdrawal Time Unit drop-down list displayed values
that had been deactivated in Data Administration. This
issue is resolved. The system has been enhanced to
add a filtering option to the Species > Route of
Administration > Withdrawal Times > Withdrawal Time
Unit field that excludes the inactive values from the
list.

25272;
[00052896]

6.2.0.0.0296 N/A After applying the upgrade script, importing the
assembly template into Calyx RIM for the first time
caused the following error message to be displayed:
The object you are acting on has been
deleted or modified by another user.
Refresh your object to view the current
information. This issue is resolved.

25268;
[00052092]

6.2.0.0.0296 6.1.0.3.0089 Running the Update Status wizard from a Product
Family Attributes page resulted in the unintentional
changing of the Reviewing Country value for an
application, when there was more than one country
assigned. This issue is resolved. The reviewing country
stays unchanged after the Update Status wizard is
finished.

25266;
[00052934]

6.2.0.0.0296 6.1.0.3.0089 Using the eCTD Import wizard to import an assembly
that had a node-extension folder with hundreds of
child leaf nodes took many hours to complete. This
issue is resolved by separating one large import
transaction into multiple smaller import transactions.

25264;
[00052928]

6.2.0.0.0296 N/A The M1 folder disappeared completely from the
Assembly Tree during expand attempt if there were
any nodes that contained a hyphen (‐) in the node
name. This issue is resolved. This symbol is ignored in
the New Assembly Tree. In addition, a specific script
replace_soft-hyphen_with_minus.zip that is
aimed to replace each instance of the hyphen across
the Assembly Tree has been introduced. Please
contact Technical Support for more information.
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25246
[00052728]

6.2.0.0.0296 6.1.0.3.0092 Values in drop-down lists on the following Add PDS
Detail pages were being sorted in a case-sensitive
manner.
— Add Active Ingredient > Active Ingredient drop-

down list
— Add Function > Function drop-down list
— Add Manufacturer > Manufacturer drop-down list

This issue is resolved. The case of values is ignored
during the sorting process.

25245;
[00052399]

6.2.0.0.0296 N/A Using the Update Status wizard for an Event with an
associated Sequence caused an extra APPROVED
Sequence status to appear in the Status Dates tab,
when the Event was closed as WITHDRAWN or NOT
APPROVED. This issue is resolved. The correct
statuses are now displayed in the Sequence > Status
Dates tab, when the Update Status wizard is passed.

25221;
[00052338]

6.2.0.0.0296 6.1.0.3.0093 Running the Bulk Update Events wizard (launched from
the Project Attributes page) when nothing was selected
in the non-required Secondary Event Type field
resulted in the Secondary Event Type values being
cleared unintentionally for all applicable events. This
issue is resolved. The Secondary Event Type values
are preserved when the wizard is finished if this field
has not been selected for modifications on the Select
Attributes to update page of the wizard.

25215;
[00052305]

6.2.0.0.0296 N/A There was a performance issue in displaying a large
quantity of users in Calyx RIM Security Administration.
This issue is resolved:
— ISM.DV_USER view has been updated
— ISM.R_SEC package has been updated
— lv_rc line has been increased from

VARCHAR2(4000) to VARCHAR2(32767)
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25210;
[00052191]

6.2.0.0.0296 N/A There was a performance issue when logging on to
Calyx RIM for Analytics. This issue is resolved. The
following has been updated:
— An index X2USR has been added to the USR table,

NAME field
— The ISM.DV_USER_ACCESS_LEVEL view has

been updated

25209;
[00053438,
00052279,
00052147,
00052137]

6.2.0.0.0296 hotfix6_1_
0_chf1_011
5.zip

The following error occurred during the Calyx RIM 6.1
CHF 1 migration:
ORA-01555: snapshot too old

This issue is resolved in the
DB_hotfix6_1_0_chf4_0024.zip migration script
that is used to migrate to Calyx RIM 6.1 CHF 4 from
the previous Calyx RIM 6.1 CHFs. After performing the
migration to Calyx RIM 6.1 CHF 4 and proceeding with
the migration to Calyx RIM 6.2 using the appropriate
migration script, no migration errors appear.

25206;
[00051373,
00052844]

6.2.0.0.0296 N/A If an assembly had been created from the existing
Submitted View with the Retarget Copied Reference
Leaf option selected, the following issues occurred:
— The Find Reference Leaf Elements option invoked

on the Leaf element of the created assembly
displayed the reference leaf elements of the copied
submitted view.

— The created assembly could not be deleted.

These issues are resolved:
— The Find Reference Leaf Elements option now

displays the reference leaf elements of the current
assembly.

— The created assembly can be deleted.
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25197;
[00052103]

6.2.0.0.0296 — master.z
ip

— hotfix6_
1_0_chf1
_0115.zi
p

Data copied from a field in the
MGR.Application.Term_Withdraw_Reason table
to a field in the new MGR.Term_with_reason_type
table that was too small resulted in the following
errors:
— ORA12899: value too large for column
— ORA-00001: unique constraint

This issue is resolved in the
DB_hotfix6_1_0_chf4_0024.zip migration script
that is used to migrate to Calyx RIM 6.1 CHF 4 from
the previous Calyx RIM 6.1 CHFs. After performing the
migration to Calyx RIM 6.1 CHF 4 and proceeding with
the migration to Calyx RIM 6.2 using the appropriate
migration script, no migration errors appear.

25182;
[00051882]

6.2.0.0.0296 N/A The Apache Commons Collections library was
vulnerable to insecure deserialisation of data, which
could result in arbitrary code execution. To fix this
issue, the Apache Commons Collections version 3.2.2
has been applied to the Calyx RIM 6.2 Application
Server. The Apache Commons Collections library
version 3.2.2 mitigates the vulnerability by disabling
the insecure functionality.

25158;
[00051744]

6.2.0.0.0296 — InsightFor
Analytics.zi
p
6.1.0.3.00
13
(InsightFor
Analyics-6.
1-chf3-
hf1.zip )

— WFConfig.z
ip
6.1.0.3.00
09
(WFConfig-
6.1-chf3-
hf1.zip)

The log on to the Calyx RIM for Analytics failed if the
Display Name contained the ampersand (&) character.
This issue is resolved by escaping the ampersand
characters for Display Name value in the
wfsqlusers.fex and user_name.fex files.
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25156 6.2.0.0.0296 6.1.0.2.0017 The error ORA-02292: integrity constraint
(ODS.R_789) violated - child record
found occurred when attempting to delete an
application having a lifecycled assembly with a
reference leaf. This issue is resolved.

25141;
[00051550]

6.2.0.0.0296 6.1.0.3.0099 Attempting to import a Japanese submission having a
DELETE operation in module 1 failed. This issue is
resolved by updating the xlink:href attribute
processing for the Leaf that has a DELETE status.

25140;
[00051261]

6.2.0.0.0296 N/A It was possible to delete a sequence with a working
assembly that was created by another user, or in
another tab. The Delete button on the Sequence
Attributes page was enabled until the page was
refreshed. This issue is resolved by adding an
additional check to identify the presence of working
assembly in the verifiable sequence. If the working
assembly exists, the warning message is displayed.

25134;
[00052137,
00051492,
00051212]

6.2.0.0.0296 hotfix6_1_
0_chf1_011
5.zip

During the migration from Calyx RIM 5.1 to Calyx RIM
6.1 CHF 1 the issue of an empty GUID column for leafs
and folders was observed. This issue resulted in the
following errors:
— Error adding new not null constraint

on FOLDER.GUID
ORA-02296: cannot enable (ODS.) - null
values found

— Error adding new not null constraint
on LEAF.GUID
ORA-02296: cannot enable (ODS.) - null
values found

This issue is resolved in the
DB_hotfix6_1_0_chf4_0024.zip migration script
that is used to migrate to Calyx RIM 6.1 CHF 4 from
the previous Calyx RIM 6.1 CHFs. After performing the
migration to Calyx RIM 6.1 CHF 4 and proceeding with
the migration to Calyx RIM 6.2 using the appropriate
migration script, no migration errors appear.
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25110,
25001;
[00048772,
00049481,
00049976 ,
00050201,
00050749,
00051273,
00051803]

6.2.0.0.0296 — 25110 -
6.0.0.5.
0004,
6.1.0.2.
0017

— 25001 -
6.0.0.5.
0004,
6.1.0.2.
0017

In Calyx RIM 6.1, if the default styles were not
overridden, all native links were processed with the
style obtained from the default link settings profile.
This resulted in performance degradation of the
publishing process. This issue is resolved with Calyx
RIM 6.2, the functionality is modified by not altering
native links unless the target page of the link is no
longer in the same file due to a the file being split, or if
the profile is not the default profile.

25091;
[00049218]

6.2.0.0.0296 N/A When Prepare to Publish, or Publish, was executed for
a submission with any assigned documents that
contained Xref links, you could experience an
UndeclaredThrowableException error. This error
was caused by Xrefs that are no longer supported by
Calyx RIM. This issue is resolved:
— Xrefs are ignored and the link annotations are not

created in the PDF rendition.
— All CDCXrefs in an in-process rendition, or PDF

document, or rendition to be published, are always
deleted.

— CDCXrefs no longer cause the publish request to
fail.

25085;
[00051005]

6.2.0.0.0296 N/A When you created the Publishing Settings Library
Template using the New > Publishing Settings Library
Template option, one of the following issues occurred:
— Clicking Save after the session timeout, displayed

the warning message: You have already sent
this request to the server. Please try
again. Clicking Save for the second time saved the
entity.

— Navigating to the New > Publishing Settings Library
Template option after the session timeout opened
the Create Publishing Settings Library page, with the
Publishing Library Owner field set to guest. Filling
the attributes and clicking Save saved the entity.

This issue is resolved. The system now does not allow
you to save the Publishing Settings Library Template
after the session timeout.
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25075;
[00050986]

6.2.0.0.0296 N/A Navigating to Calyx RIM for Analytics while logged on
to the Calyx RIM system caused the wrong user name
value to be sent to the Calyx RIM for Analytics server.
This issue is resolved. The system now uses the
correct user name value for the SSO (Single Sign On)
to the Calyx RIM for Analytics system.

25070;
[00052810,
00051949,
00051259,
00050874]

6.2.0.0.0296 6.1.0.3.0093 When a user session expired, a guest account with no
privileges was assigned to the session. Any
subsequent action resulted in the login page being
displayed. However, if the user was still idle when the
guest session expired, errors were generated and
logged in the server.log file. This issue is resolved.
Calyx RIM no longer attempts to save settings for the
guest user when the guest user session expires.

25058;
[00050726]

6.2.0.0.0296 6.1.0.2.0015 Inactive functions were available for selection when
executing the Add Active Ingredient Manufacturing
Process Function Manufacturer step in the Global
Project Plan Wizard > Update a Product Detail Set
Project flow. This issue is resolved. Only Active
functions are available for selection.

25054;
[00050668]

6.2.0.0.0296 N/A In email notifications, the old application logo was
displayed and the Calyx RIM Manager notification
system was indicated as the sender. This issue is
resolved. The sender name is updated and is
displayed as Calyx RIM notification system. The
application logo is replaced with the most current one.

25045;
[00050172,
00052819]

6.2.0.0.0296 N/A The system allowed you to disassociate the approved
Product Detail Set (PDS) with a withdrawn Shelf Life/
Storage Condition detail from the Event, but the
ORA-02292: integrity constraint
(MGR.R_732B) violated - child record
found error occurred. This issue is resolved. The
system now does not allow the disassociation if there
are data dependencies.
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25014;
[00050210]

6.2.0.0.0296 N/A For sequence assemblies only, you could convert a
leaf to be a reference leaf referencing itself, which
violated the business rule that a leaf cannot reference
itself. This issue is resolved. Now, if a user attempts to
create a leaf referencing itself, the following error
message is displayed:
A leaf cannot reference itself.

25013;
[00050091]

6.2.0.0.0296 N/A When using the Recalculate Checksums option, the
backbone files in the electronic output location were
not updated if the electronic output location contained
a normalized Application Code. Instead, new
backbone files were published to the location which
was 2 folders above the correct one, in case if during
the normalization process the Application Code value
was changed. This issue is resolved.

25002;
[00050016]

6.2.0.0.0296 N/A When creating a new assembly using Creating
Assembly from a Template, Assembly, or View option or
Import Assembly Wizard, data under the Sequence
Assemblies tab was not appearing in a reasonable
amount of time. This issue is resolved.

24959;
[0004923,
00050581,
00051103]

6.2.0.0.0296 — 6.0.0.5.00
08

— 6.1.0.2.00
17

Long publishing time issues could occur due to Oracle
choosing an inefficient execution plan for a particular
query. This issue is resolved. The problematic query is
rewritten to prohibit Oracle from choosing the
inefficient execution plan.

24958;
[00049474]

6.2.0.0.0296 N/A When you opened the Assembly tab, a "Loading"
message appeared but the operation was not
completed in a reasonable amount of time for the
Assembly Attributes page. However, the assembly tree
and assembly tree elements were fully loaded and
accessible. This issue is resolved.

24956;
[00049263]

6.2.0.0.0296 N/A When the Bulk Update Events wizard was invoked from
the Project Attributes page, you could update the
events with countries to which you had Read access.
This issue is resolved. The Select Events to Update
page now lists only events with countries, to which
your access is set to at least Write.
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24923;
[00049174,
00049530]

6.2.0.0.0296 N/A The 1.A.5 Comparison Table section in Thailand
Module 1 Specification v1.0 had incorrect leaf output
file name comparison.pdf. This issue is resolved.
The leaf output file name is now appearing as
comparison-table.pdf.

24896;
[00048871,
00049238,
00024896,
00050205]

6.2.0.0.0296 N/A When trying to extract a document with a bookmark
that contained a non-Unicode character, the extract
job was displayed as Completed. However, the Job
Details contained an error with an exception, and the
Assembly > Document Attributes had the Extract
Exists field set to No. The issue with the job statuses is
resolved. The correct status, Failed, is now displayed
when a document is not extracted.

24891;
[00047906]

6.2.0.0.0296 6.0.0.3.0037 Leafs and documents with names beginning with stf-
were omitted during the eCTD Import process
because the code interpreted all files located in study
folders beginning with stf- as STF XML files. This
issue is resolved.

24876;
[00048681]

6.2.0.0.0296 6.0.0.3.0037 Attempting to remove a sequence from a lifecycle was
not completing in a reasonable amount of time even
after increasing the timeout value. The delay occurred
due to the unnecessary calls to two queries. This issue
is resolved.

24860;
[00048499,
00054314]

6.2.0.0.0296 N/A When using the eCTD Import process to import an
assembly containing reference leafs that target leafs
further down in the assembly tree, the reference leafs
and target leafs were switched in the imported
assembly. This issue is resolved for the region specific
Module 1, and also Module 2, Module 3, Module 4, and
Module 5 that are common for all regions.

24832;
[00047932]

6.2.0.0.0296 — 5.1.0.5.00
13

— 6.0.0.3.00
34

Using the Import Assembly Wizard to import an
assembly with the option to retarget selected
reference leafs sometimes resulted in an invalid
reference error. This issue is resolved.

24800;
[00047397]

6.2.0.0.0296 6.1.0.3.0092 For null values on sequence ACTUAL_DATE fields from
01-JAN-1901 to 01-JAN-1900 the default date is
set to avoid issues with incorrect event statuses
appearing after migrations that set the values to dates
between those two values.
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24704 6.2.0.0.0296 N/A The issue of incorrect display names for the Full
Product Presentation and Registration FPP
Attachment comment fields has been resolved:
— The Full Product Presentation Comments field has

been reworked to be a display-only field on the
View Full Product Presentation Attributes page.

— The Full Product Presentation Add Comment field
has been added to the Create/Modify Full Product
Presentation Attributes pages.

— The Attachment Comments field has been renamed
to be Registration FPP Attachment Comments.
See Fields Added: Calyx RIM 6.2 and Fields
Updated: Calyx RIM 6.2.

24703 6.2.0.0.0296 N/A The discussion thread related fields had the incorrect
display names for the Product, Pharmaceutical
Product, Event, Registration, and Sequence entities.
This issue is resolved. To support the naming
convention across the Calyx RIM system, the display
names had been reworked to be:
— Product > Product Add Comment
— Pharmaceutical Product > Pharmaceutical Product

Add Comment
— Event > Event Add Comment
— Registration > Registration Add Comment
— Sequence > Sequence Add Comment

See Fields Updated: Calyx RIM 6.2.

24641 6.2.0.0.0296 When trying to delete a Product Details Set (PDS) with
the child details added under the Substance node, the
Delete button appeared dimmed after those details
with Approved or Not Approved status had been
deleted. This meant that the PDS could not be deleted
due to data dependencies. This issue is resolved. The
Delete button is now available and the PDS can be
deleted.
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Issue Build Hotfix Build Description

24561 6.2.0.0.0296 N/A The Next Renewal Date column on the Registrations
tab was displayed incorrectly as First Renewal Date
when you were navigating to it from the Product
Family Attributes and Product Attributes pages. This
issue is resolved. The column name is now displayed
correctly for Product Family Attributes, Product
Attributes, and Application Attributes pages.

24474;
[00044014]

6.2.0.0.0296 N/A A client reported a performance issue that appeared
when changing the status to APPROVED for Event
entities that were created as part of a migration. This
issue has been resolved and is no longer reproducible
on the latest Calyx RIM versions.

24422 6.2.0.0.0296 N/A When using the Veeva DMS, an error occurred while
attempting to bind a document to any label other than
CURRENT. This issue is resolved. When the selected
label is other than CURRENT, a warning message
informs you that the document must be bound to a
CURRENT label only.

24408;
[00032393]

6.2.0.0.0296 N/A The sorting for Manufacturer Details in the PDS tree
was performed by the Manufacturer Status Date
attribute. This issue is resolved. The Manufacturer
Details are now sorted alphabetically.

22781;
[00029737,
00044188]

6.2.0.0.0296 N/A You were not able to modify the Active Ingredients
field on the Modify Product Family page after the
associated Product, that contained a Component, was
deleted. This issue is resolved. Once the related
Product along with its Component is deleted, the
Active Ingredients field is displayed as a selection list
and is available for modifications on the Modify
Product Family page.

23690;
[00051715,
00048203,
00047314]

6.2.0.0.0296 6.1.0.3.0084 Closing an event as Approved did not set the
Application Status to Approved if the current
Application Status value was Submitted. This issue is
resolved.
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Issue Build Hotfix Build Description

22697;
[00027525]

6.2.0.0.0296 N/A When an Event was closed with a status of Withdrawn,
all related Sequence Status Dates were changed to the
withdrawn date. This issue is resolved. When an event
is now closed, the Sequence will keep its status as
well as the date for any sequence with a status of
Approved, Not Approved, Submitted, or Withdrawn. If
the Sequence status is Planned, it will be changed to
Withdrawn.

22028;
[198009FW]

6.2.0.0.0296 N/A When changing the value in Product Family Type
multiple selection field, refreshing of the List of
Product Families page took several minutes. This issue
occurred on all multiple selection fields across the
system. This issue is resolved for Internet Explorer 11
and Google Chrome browsers.

20703;
[144950FW,
00043370]

6.2.0.0.0296 N/A You were not able to select multiple documents using
the Shift and Ctrl keys and drag them within the
assembly. This issue is resolved with the New Version
of the Assembly Tree introduced in Calyx RIM 6.2.

18655 6.2.0.0.0296 N/A Create eCTD wizard failed if many sets of metadata
were applied. This issue has been resolved and is no
longer reproducible on the latest Calyx RIM versions.
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Calyx RIM 6.2 CHF 1 Release Notes

This document describes a certified hotfix (CHF) provided to improve Calyx RIM 6.2. In addition to enhanced
features and functionality, Calyx RIM 6.2 CHF 1 resolves issues that were reported to Technical Support. Our
hotfixes are cumulative packages applied to a named version of our software.

As a certified hotfix, these updates have undergone Quality Control regression testing, certifying the system works as
expected. These changes will not create a new code branch, but will be identified by the updated build number on the
existing codeline of each version affected, not a new release number.

Prerequisites
Calyx RIM 6.2 CHF 1 requires overrides updates. Please allow 6 to 8 weeks for XML overrides review and updates.
For details, please contact your Business Development Representative to consult with our Client Enablement team.

To enable the drag-and-drop from Veeva DMS functionality, the appropriate configurations need to be done in the
Internet Explorer browser. Please review the procedures in the LIQUENT InSight 6.2 CHF 1 Installation Guide
topic Internet Explorer: Enabling the Drag-and-Drop from Veeva DMS and make sure that the necessary configurations
are applied. If you experience any difficulties in configuring the Internet Explorer browser to enable the drag-and-
drop functionality, please contact Technical Support.

The following conditions must exist for D2 Forms when created via Calyx RIM 6.2 CHF 1:
— All forms (Product Registration Form, Project Registration Form, Regulatory Application Registration Form, and

Submission Registration Form) have external_system_attribute in the properties list.
— The flag for external_system_attribute is always set to True.
— The value for the external_system_attribute cannot be empty.
— All forms (Product Registration Form, Project Registration Form, Regulatory Application Registration Form, and

Submission Registration Form) are currently created in Active status in D2 as the required fields in D2 SDK are
either equal or subset of the required fields in Calyx RIM 6.2 for that entity.

Open Text Documentum D2 Integration
This release provides the ability to differentiate between procedure types on the forms in an OpenText Documentum
D2 application.

Users will be able to uniquely identify the description fields on forms in OpenText Documentum D2 application.

The following D2 Data Dictionaries are no longer automatically synchronized with Data Administration entities, but
can be synchronized via configuration files as needed:
— Application Procedure Type
— GMP Drug Product Manufacturer
— GMP Drug Substance Manufacturer
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Data Administration
The IDMP Internal Procedure Code field has been renamed to External System Procedure Type Code in
the Data Administration > Application Maintenance > Procedure Type Values attributes page. Calyx RIM
6.2 CHF 1 requires External System Procedure Type Code to be configured to be a required field via overrides,
such as the meta.overrides.xml file.

See Entity Fields Updated: Calyx RIM 6.2 CHF 1.

Veeva DMS Support Enhancements
Calyx RIM 6.2 CHF 1 enables you to drag-and-drop documents directly from the Veeva Vault window to the
assembly.

This release significantly reduces the number of API calls that Calyx RIM performs to get data from Veeva DMS.
This may avoid errors occurring due to the number of calls exceeding the Veeva Burst API Count limit.

Veeva Objects Cache

When you use the Veeva DMS, the number of requests accepted by Veeva Vault from Calyx RIM and other
integrated systems is limited by the Burst API Count value specific for each Veeva Vault. Calyx RIM 6.2 CHF 1
leverages the Veeva Bulk API calls with an internal cache. This will decrease the chance of encountering 5-minute API
burst restrictions imposed by Veeva Vault. This enhancement reduces the chance of exceeding the number of API
calls allowed within a Veeva Vault. The optimal cache lifetime depends on the following factors:

— Burst API Count value for the Veeva Vault (the higher the Veeva objects cache timeout value, the fewer API calls
are made by Calyx RIM to Veeva)

— Keeping the data up-to date

You can change the default Veeva cache timeout that is set to 3 minutes to be any other integer value. See Configuring
the Veeva Cache Timeout Setting.

The behavior of the following Document attributes has been changed to provide better Veeva calls consumption:
— Has Relations
— Owner

See Entity Fields Updated: Calyx RIM 6.2 CHF 1.

Calyx RIM for Analytics
There are no revisions or enhancements, and no new installation or upgrade instructions, for Calyx RIM for
Analytics with this certified hotfix for Calyx RIM 6.2. If you are upgrading from a version earlier than Calyx RIM
6.2, please follow the instructions within the appropriate Calyx RIM version.

Data Administration Tables: Calyx RIM 6.2 CHF 1

The following Data Administration tables field was modified with Calyx RIM 6.2 CHF 1.
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Data Administration Section: Application Maintenance
Data
Administration
Table Name

Entity Affected Field Name Value List Description

Procedure Type
Values

N/A External
System
Procedure
Type Code

The IDMP Internal Procedure Code
field has been renamed to External
System Procedure Type Code in the
Data Administration > Application
Maintenance > Procedure Type Values
attributes page:
— Field Type: drop-down list
— Values available for selection: CP,

DCP, MRP, NATIONAL

Entity Fields Updated: Calyx RIM 6.2 CHF 1

The following table describes fields that were updated or removed with Calyx RIM 6.2 CHF 1.

Entity
Name

Field
Name

Field
Type

Field/Update Description Business Rules

Document Owner Text The business rules for the
field have been changed
according to the Veeva
Enhancements introduced
with Calyx RIM 6.2 CHF 1
release.

The value for the Owner text field
derives from the Veeva file. Instead
of owner__v attribute, this value is
now taken from the
created_by__v attribute.

Has
Relations

Read-
only

The Has Relations property is
calculated according to the
presence of associated Relation
object(s) in the Documentum
Docbase. For Veeva Document the
Has Relations property set to Yes by
default regardless of actual
association.

List of Enhancements: Calyx RIM 6.2 CHF 1

Requested new features and enhancements are included in each release. The items are listed in descending order by
their tracking numbers. Customer case numbers that were recorded when the enhancements were requested are
included in brackets [#####] following the tracking number.
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Calyx RIM 6.2 CHF 1 includes the following enhancements.

Issue Build Hotfix Build Description

25746;
[00058184]

6.2.0.1.0004 N/A When you use the Veeva Vault, the number of requests
sent to Veeva by Calyx RIM is limited by the number
that is defined by the Veeva System. Calyx RIM 6.2
CHF 1 leverages the Veeva Bulk API calls with an
internal cache. This will decrease the chance of
encountering 5-minute API burst restrictions imposed
by Veeva Vault. The optimal cache lifetime depends on
one of the following factors:
— Optimizing the number of Veeva requests (the

higher the Veeva objects cache timeout value, the
fewer InSight API calls to Veeva)

— Keeping the data up-to date

Keep in mind that setting the Veeva cache timeout to a
higher value will reduce the number of Veeva
requests. However, this can also lead to a risk of
getting data that is not relevant.

Resolved Issues: Calyx RIM 6.2 CHF 1

The following issues that were reported to Technical Support have been resolved. Issues are listed in descending order
by their internal tracking numbers.

Customer incident numbers that were recorded when the issues were reported are included in brackets [#####]
following the internal tracking number.

Calyx RIM 6.2 CHF 1 resolves the following issues.

Issue Build Hotfix Build Description

25744;
[00058035]

6.2.0.1.0004 6.1.0.4.0057 When the Default Rendition Identifier was set to
"Viewable Rendition" in the Publishing Setting
Library, users were unable to assign a document
from a non-Veeva DMS. This issue is resolved.
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Issue Build Hotfix Build Description

25728
[00058029]

6.2.0.1.0004 N/A Veeva documents with hyperlinks would cause
the publish to fail, and the message "Not
supported yet" was displayed. This issue is
resolved. Veeva documents with hyperlinks now
publish successfully.
Note: Authoring hyperlinks in Veeva is not
supported by LIQUENT SmartLink for PDF and
LIQUENT SmartLink for Word.
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Calyx RIM 6.2 CHF 2 Release Notes

This document describes a certified hotfix (CHF) provided to improve Calyx RIM 6.2. In addition to enhanced
features and functionality, Calyx RIM 6.2 CHF 2 resolves issues that were reported to Technical Support. Our
hotfixes are cumulative packages applied to a named version of our software.

As a certified hotfix, these updates have undergone Quality Control regression testing, certifying the system works as
expected. These changes will not create a new code branch, but will be identified by the updated build number on the
existing codeline of each version affected, not a new release number.

Prerequisites
Calyx RIM 6.2 CHF 2 requires overrides updates. Please allow 6 to 8 weeks for XML overrides review and updates.
For details, please contact your Business Development Representative to consult with our Client Enablement team.

Cross-site Scripting Protection
Calyx RIM 6.2 CHF 2 enhances security protection against most cross-site scripting vulnerabilities, helping to
prevent against hacker access and the theft or manipulation of customer sessions or cookies information.

Extended Support for Identity Providers
Calyx RIM 6.2 CHF 2 extends support for Identity Providers, including PingOne and Okta in addition to Microsoft
Azure Active Directory.

For more details, follow the topic Security Administration > Log on to Identity Provider

OpenText Documentum D2 Integration
Calyx RIM 6.2 CHF 2 provides the following updates in D2 systems:
— Allows synchronization of all the statuses of Calyx RIM PDS nodes with OpenText Documentum D2.
— Enhances Regulatory Application Registration Form and Submission Registration Form with the new Concerned

Member State table columns, to populate with Application Code and Health Authority values.
— Enhances the Submission Registration Form with the following fields:

• Sequence Name
• Event Name
• Event Code
• Event Type

— If a field on an integrated Calyx RIM 6.2 entity is updated, and it does not correspond to a column in the grid in
D2, the existing Form is updated.

— If a field on an integrated Calyx RIM 6.2 entity is updated, and it corresponds to a column in the grid in D2, a
new row is created keeping the old record in the D2 grid.

Regulatory Updates
Calyx RIM 6.2 CHF 2 supports CH eCTD Module 1 Version 1.4.

Calyx RIM 6.2 CHF 2 introduces support of Valid Values 5.0 for STF 2.2.
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Optimization
Processing of the following functions has been optimized in Calyx RIM 6.2 CHF 2:
— Adding an assembly to a lifecycle
— Creating a working assembly
— Using the Ready for Submission wizard
— Moving folders in an assembly
— Variables resolution performance

Multiple Documentum Rendition Formats
Calyx RIM enables you to include additional PDF rendition formats for documents in Documentum.

For more details, see the topic LIQUENT InSight Configuration for 6.2 CHF 2: Step 8

New Sorting Logic in Create eCTD Wizard
Calyx RIM 6.2 CHF 2 provides new sorting logic in the Create eCTD wizard, enabling the display of all additional
sections or folders in an assembly in the correct order.

For more details, see the topic Creating an eCTD Submission: Steps 6 & 7

Assign Document
Enhancements have been made to the Assign Document window and the DMS Search Results pane for better
usability. This includes: retention of changes made to the size and position of the Assign Document window, and
retention of changes made to the size, position, and sorting of columns in the DMS Search Results pane, including
after re-login.

Parallel Planned Submissions
Calyx RIM 6.2 CHF 2 enables you to:

— Identify conflicting lifecycle operations in parallel working assemblies.
— Synchronize a working assembly with the latest changes in the submitted view and resolve conflicting lifecycle

operations between a working assembly and a submitted view.

For more details, see: Calyx RIM Publisher > Lifecycle > Parallel Submissions

List of Enhancements: Calyx RIM 6.2 CHF 2

Requested new features and enhancements are included in each release. The items are listed in descending order by
their tracking numbers. Customer case numbers that were recorded when the enhancements were requested are
included in brackets [#####] following the tracking number.

Calyx RIM 6.2 CHF 2 includes the following enhancements.
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Issue Build Hotfix Build Description

25879;
[00059428]

6.2.0.2.0069 N/A With Calyx RIM 6.2 CHF 2, the size of the EU Grouping/
Worksharing Number field on the Event entity has
been increased to 100 characters.

25768;
[00058351,
00059919]

6.2.0.2.0069 N/A Calyx RIM 6.2 CHF 2 introduces support in the Data
Exchange export process for the Event Country Status
data and the Event Change Detail entities.

25763;
[00058350]

6.2.0.2.0069 N/A When the option Use as Active Ingredient for XEVMPD
is set to Yes, the substance with any type will now be
taken as an Active Ingredient for submission XML,
even if the PDS Active Ingredient is already present in
the XML.

25703; 6.2.0.2.0069 N/A Using the new Include Concentrations to XEVMPD?
option that is included to the PDS Substance Details
page for Excipient type, it is now possible to restrict
concentrations from being included in the XEVMPD
submission XML file.

25702;
[00057443]

6.2.0.2.0069 N/A It is now possible to add additional attributes exposed
for the Package Set Detail in PDS on the Select
Package Set(s) grid in the Copy Package Set
Registration wizard for New Package Set specific
Registration(s) flow.

25684;
[00057296,
00057471,
00057541,
00059407]

6.2.0.2.0069 N/A Calyx RIM 6.2 CHF 2 introduces support of Valid
Values 5.0 for STF 2.2.

25490;
[00054468]

6.2.0.2.0069 N/A It is now possible to keep the original Module 1 leaf ID
for the imported JP submissions.

25359;
[00053549]

6.2.0.2.0069 N/A With Calyx RIM 6.2 CHF 2, the Bookmark length limit
has been increased to 4000 characters.
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Issue Build Hotfix Build Description

25304,
23861;
[00050291,
00039668,
00040435,
00043936,
00039631,
00057333,
00060463]

6.2.0.2.0069 N/A It is now possible to add additional PDF rendition
formats for document in Documentum. List of formats
can be defined in the insight.var file during Calyx RIM
configuration.

25131;
[00051433]

6.2.0.2.0069 N/A With the new Synchronize with the Submitted View
feature, it is now possible to update the Working View
with the latest changes in the Submitted View.

24308,
24129;
[00043483,
00043482,
00045217,
00041903,
00042379]

6.2.0.2.0069 N/A The following enhancements have been made to the
Assign Document window:
— a horizontal scroll bar appears in the right frame

(DMS Search Results)
— the vertical separator line is moved to the left and

persists (if changed) for the user after re-login
— the full column names appear in the DMS Search

Results frame
— the size and the position of the Assign Document

window persists (if changed) for the user after re-
login

— the size, position, and sorting of columns in the
DMS Search Results frame persists (if changed) for
the user after re-login

24041;
[00040709,
00059360]

6.2.0.2.0069 N/A Calyx RIM 6.2 CHF 2 enhances Application security
protection to overcome the Cross-Site Scripting
vulnerability.
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Issue Build Hotfix Build Description

22465;
[00024678,
00042911,
00054968,
00055823,
00055848]

6.2.0.2.0069 N/A Calyx RIM 6.2 CHF 2 enhances the eCTD Wizard to
copy the envelope information for the DCP and MRP
Sequences. If the field is modified for the first Country
on the Select Attribute tab of the Create eCTD Wizard,
the modified value will be copied to the other Country
field on proceeding ahead for the other Countries in
the same tab. The modified value will be copied only
for the creation of Working Assemblies.
Following are the fields from which value can be
copied for other Countries in the Create eCTD Wizard:
— UUID
— Submission Type
— Submission Mode
— Submission Unit Type
— High-level/Worksharing Submission Number
— Application Tracking Number
— Procedure Type
— INN
— Sequence
— Related Sequence
— Submission Description

Note: This behavior (Modified value of one country
copied to other country) works only, when creating a
Working Assembly and not when updating it.
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Issue Build Hotfix Build Description

20159;
[000132847,
00028774,
00057075,
00057239,
00057214]

6.2.0.2.0069 N/A When working on a submitted entity in different
working assemblies, it is now possible to update the
latest changes using the Synchronize with the
Submitted View feature.
Example: Consider a leaf in the sequence 0000
submitted as new. Sequences 0001 and 0002 are
created with Working View. Replacing that leaf in
sequences 0001 and 0002 by different users replaces
the leaf in 0000 twice. Now, if the leaf is replaced in
0001 and 0001 is added to lifecycle, the change to the
leaf is indicated to the user working on 0002. On using
the Synchronize with the Submitted View feature, the
leaf in 0002 refers to the leaf in 0001 instead of 0000.

For information on synchronization, see the topic
Synchronizing Current Working View with Latest
Submitted View.

17153 6.2.0.2.0069 N/A When there are two or more Working assemblies, and
if a folder or a leaf is added to one of them and then
one of the Working assembly is lifecycled, you can use
the Synchronize with the Submitted View feature to
update the Working View with the latest changes in
the Submitted View.

New Fields Added: Calyx RIM 6.2 CHF 2

The following table describes fields that were added with Calyx RIM 6.2 CHF 2.

Field Name Field
Type

Entity Name Description Business Rules

Lifecycle Order Text;
Read-
only

Assembly
Plans under
Submission
Plans

The order of Assembly
Plans in a lifecycle.

Index number added to
Lifecycle Assembly/Assembly
Plan and equals to Lifecycle
Order value from the Sequence
Attributes page. An empty
value or a zero indicates that a
Sequence/Assembly Plan has
not been added to a Lifecycle.
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Field Name Field
Type

Entity Name Description Business Rules

Updated
Submitted
Available

Text;
Read-
only

Working and
Sequence
view of
Assembly/
Assembly Plan
Attributes
page

Indicates if updates are
made to the Submitted
view since the creation
of the Working
Assembly.

For newly created Working
Assembly, the status is No by
default. The status changes to
Yes when the Submitted view
is updated. When the
synchronize with the
Submitted view operation is
performed, the status changes
from Yes to No.

Include
Concentrations
to XEVMPD?

Drop-
down
list

PDS
Substance
Detail page

With Calyx RIM 6.2 CHF
2, the field Include
Concentrations to
XEVMPD? has been
added to the PDS
Substance Detail page
for Excipient type to
restrict concentrations
from being included in
the XEVMPD submission
XML file.

The Include Concentrations to
XEVMPD? field appears only
with the substance type
Excipient. The default value of
Include Concentrations to
XEVMPD? is No by default.

Entity Fields Updated: Calyx RIM 6.2 CHF 2

The following table describes fields that were updated or removed with Calyx RIM 6.2 CHF 2.

Entities
Entity
Name

Field Name Field Type Description Business Rules

Events EU Grouping/
Worksharing
Number

Text With Calyx RIM 6.2 CHF 2, the
GUI Field size has been
changed from 30 to 100.

GUI Field Size: 100
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Entity
Name

Field Name Field Type Description Business Rules

Sequence Lifecycle Order Numeric;
Read-only

The Lifecycle Order column
has been enabled in this
release. The Lifecycle Order
column displays the order of a
sequence in a lifecycle. This
column is available on the
Sequence tab of an
Application.

Index number added to
Lifecycle Assembly/
Assembly Plan and equal
to Lifecycle Order value
from the Sequence
Attributes page. An
empty value or a zero
indicates that a Sequence
has not been added to a
Lifecycle.

Database Columns Changed: Calyx RIM 6.2 CHF 2

The following database columns were added or changed in Calyx RIM 6.2 CHF 2.

Field Name Field
Size

Database Column Name Database Column
Size

Database Table Name

Use Native
File

N/A USE_NATIVE_FILE_FLAG VARCHAR2(1
BYTE)

ODS.DEFAULT_PUB_VAL
UES

Include
Concentration
s to XEVMPD?

N/A XEVMPD_CONCENTRATIONS_F
LAG

VARCHAR2(1
BYTE)

MGR.PDS_SUBSTANCE_
CHANGE

N/A N/A EU_GROUPING_NUMBER VARCHAR2(30) has
been changed to
VARCHAR2(500)

MGR.EVENT

N/A N/A NAME VARCHAR2(1000)
has been changed
to
VARCHAR2(4000)

ODS.EXTRACT

N/A N/A TARGET_BOOKMARK VARCHAR2(1000)
has been changed
to
VARCHAR2(4000)

ODS.DOC_LINK_INSPEC
TOR_RESULT

Resolved Issues: Calyx RIM 6.2 CHF 2

The following issues that were reported to Technical Support have been resolved. Issues are listed in descending order
by their internal tracking numbers.
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Customer incident numbers that were recorded when the issues were reported are included in brackets [#####]
following the internal tracking number.

Calyx RIM 6.2 CHF 2 resolves the following issues.

Issue Build Hotfix Build Description

26048 6.2.0.2.0069 N/A XEVMPD Audit Analytics: Legal Basis from the
Registration entity was not audited. This issue is
resolved. Legal Basis will appear in the XEVMPD
Audit Analytics report.

26013, 25936;
[00060710,
00060234]

6.2.0.2.0069 — 26013 -
6.1.0.4.
0078

— 25936 -
6.1.0.4.
0064

When sending an ADD/UPDATE/INSERT data
exchange message for a ChangeDetail, if the
changeId value included a tilde (~), plus (+),
hash (#), or a dash (-), then the value was not
converted and the Change Detail was not added.
This issue is resolved.

25985 6.2.0.2.0069 N/A When trying to reassociate a user that has been
deleted from the Azure Active Directory, from
within Calyx RIM, a 404 Not Found error was
displayed. This message has been modified to
display: User does not exist in the
third party IdP system. To add the
user to the group, user needs to be
re-added in the IdP system.

25984 6.2.0.2.0069 N/A When creating or identifying a notification while
logged on as an Azure user, the Created By
column does not display the full email address of
the user. This issue has been resolved.

25983 6.2.0.2.0069 N/A When attempting to get a full list of Azure users
within Calyx RIM using the Add User/Group
Wizard, a 400 Bad Request error would be
displayed. This issue is resolved.

Calyx RIM 6.2 CHF 2 Release Notes

© Calyx™ 2023. 136 Calyx RIM 6.2 Release Notes
Calyx.ai Resolved Issues: Calyx RIM 6.2 CHF 2



Issue Build Hotfix Build Description

25968;
[00060639]

6.2.0.2.0069 6.1.0.4.0077 Expanding a working assembly of more than
10,000 nodes folder by folder and switching from
Working to Publishing/Submitted view and back
caused the folders or the assembly to disappear.
This issue is resolved. Assembly tree will be
collapsed automatically if the amount of
expanded nodes exceeds the limit. This limit is
configurable and there is a default system value
of ‘1000’. If the
'assembly.tree.expand.range.limit' parameter is
not specified in insight.var file, the default system
value is applied.

25949;
[00059797,
00054015,
00057268]

6.2.0.2.0069 6.1.0.4.0077 Importing a large assembly into a working
assembly via the Import Assembly Wizard could
take an excessive amount of time to complete, or
would not complete. This issue is resolved.

25942;
[00060255]

6.2.0.2.0069 N/A A deserialization vulnerability that allowed an
attacker to execute arbitrary code was found.
This issue is resolved.

25940;
[00060256]

6.2.0.2.0069 6.1.0.4.0064 The JBoss RichFaces project is a UI component
framework for integrating Ajax capabilities into
business applications using JavaServer Faces.
Because the RichFaces project has reached end-
of-life status and there will be no further updates
to the functionality, and it has been flagged as a
security vulnerability. This issue is resolved.
JBoss RichFaces has been removed from Calyx
RIM.

25923;
[00059341]

6.2.0.2.0069 6.1.0.4.0079 When there were 50 or more rows in the Recently
Viewed details and no entity from this list was
selected before logging out, the Recently Viewed
details was not available when re-logging on to
Calyx RIM. This issue is resolved.
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25922;
[00060089]

6.2.0.2.0069 N/A It was not possible to export the following grids
to Excel. This issue is resolved.
— Reports in Querying
— Jobs
— Job Details
— Links Inspector Report
— Document List

25906;
[00059680]

6.2.0.2.0069 6.1.0.4.0079 When working with a historical data an XEVMPD
Audit report showed incorrect data in the output.
This issue is resolved.

25895 6.2.0.2.0069 N/A Attempting to modify and save the TOC content
in a Assembly resulted in the following errors:
— On saving the edits, a blank pop-up appeared

and the TOC tree displayed no changes.
— When closing/cancelling the pop-up window,

the Edit TOC Entry dialog box did not close.

This issue is resolved.

25890 6.2.0.2.0069 N/A When creating an Application using the Create
Application Wizard, the Application Concerned
Parties field and the Event Concerned Parties
field were missing from the Create Application
and Create Event page. This issue is resolved.

25889;
[00059223]

6.2.0.2.0069 6.1.0.4.0068 This release includes a performance
enhancement to reduce the number of Display
Activity, Claim Activity, Unclaim Activity and Save
Activity (after edit) calls to the database during
workflow operations.

25886;
[00059462]

6.2.0.2.0069 6.1.0.4.0068 When selecting Country Tree on the Navigation
pane and expanding the country for the second
time, performance issues were experienced and
no information was displayed. This was due to a
known bug in Oracle 12.1. It is resolved in Oracle
12.2 for Calyx RIM 6.2 CHF 2.
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25880;
[00059361]

6.2.0.2.0069 N/A Identified deficiencies in the Application Security
controls lead to a Session Fixation vulnerability
(Cross-Site Scripting, Stored Cross-Site scripting)
that could allow a hacker to access confidential
information and tamper with the server. This
issue is resolved. Application security protection
has been enhanced.

25876;
[00059363]

6.2.0.2.0069 N/A Calyx RIM now uses the HttpOnly flag when
generating a cookie to help mitigate the risk of a
client-side script accessing the protected cookie.
It instructs the browser that the cookie can only
be accessed by the server and not by client-side
scripts.

25875;
[00059364]

6.2.0.2.0069 N/A Server headers revealed the underlying server
technologies and software versions in use, and
was flagged as a server headers vulnerability.
This issue is resolved.

25874;
[00059375]

6.2.0.2.0069 6.1.0.4.0079 In Calyx RIM6.2 CHF1, appended leafs were
duplicating IDs after the Convert to Reference
Leaf > Revert operation. The Revert option was
available for such leafs, but caused a data break.
This issue is resolved. The Revert option has
been removed to make it consistent with default
leafs.

25870 6.2.0.2.0069 N/A When trying to delete a PDS with Reference Flu
Strain details, the following error message was
generated: Error calling stored
procedure: ORA-02292: integrity
constraint (MGR.T_1634) violated -
child record found.
This issue is resolved. The PDS with Reference
Flu Strain details is deleted and the Event
Attribute page appears.

25868;
[00059008;
00062766]

6.2.0.2.0069 6.1.0.4.0077 When multiple users were working in separate
modules within the same complex Assembly, in
some cases the database was locked and the
following error message appeared:
java.sql.SQLException: ORA-00060:
deadlock detected while waiting for
resource. This issue is resolved.
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25866;
[00059229]

6.2.0.2.0069 6.1.0.4.0064• On a system with applied overrides, after using
the Build Query option to search for a document
in the DMS Search window, clicking the Reset
button did not clear all of the search criteria
fields. When this happened, attempting to
perform a search by specifying a Document
Number value returned no results. This issue is
resolved.

25864;
[00059036,
00058799,
00059198,
00060075]

6.2.0.2.0069 N/A The assigned document appeared as a
placeholder icon in the assembly tree, despite
the ‘BOUND’ value in Assignment Status and
‘Yes’ value displayed in both the PDF Exists and
the Extraction Exists fields. This issue is resolved.
The assembly tree is refreshed automatically and
the placeholder icon is changed to the document
icon when the document is assigned.

25863;
[00059133;
00059005]

6.2.0.2.0069 6.1.0.4.0077 When a document with a bookmark name of
more than 500 characters was assigned to an
assembly that had a link targeted to the long
bookmark, the Link Inspector results were empty
after running Prepare to Publishing. The
ORA-12899 error was observed in server.log.
This issue is resolved.

25858;
[00059223]

6.2.0.2.0069 6.1.0.4.0058 Slow performance issues were observed in the
Alert Center window for the list of activities
assigned to the users. This issue is resolved.
Calyx RIM 6.2 CHF 2 adds a database index to
improve performance. It decreases the amount
of time needed to display activities in the Alert
Center.

25828;
[00058914,
00058896]

6.2.0.2.0069 6.1.0.4.0079 When using the XEVMPD Submission wizard to
take the prior approved Package Set PDS Details
from the previous Event with the statuses
Pending Modify or Pending Withdrawal, an error
message regarding no active ingredients
specified was displayed. This issue is resolved.
Additional logic for Withdrawn status has been
added for Not Valid status in EMA Authorisation
Status field on Full Product Presentation entity.
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25825;
[00058868]

6.2.0.2.0069 6.1.0.4.0053 Results of the View Document List report could
not be exported to an Excel spreadsheet. This
issue is resolved.

25815;
[00058064,
00060154]

6.2.0.2.0069 N/A Attempting to disassociate a Package Set Detail
from a Registration when it was associated to a
different Registration resulted in an error.
This Issue is resolved. A Package Set Detail can
be deleted from a Registration when it is
associated to a different Registration.

25797;
[00058103]

6.2.0.2.0069 6.1.0.4.0057 When creating a Full Product Presentation for an
Authorised Product with more than one active
ingredient and one having a reference active
ingredient, selecting the option to "Use
Reference Ingredient for XEVMPD" resulted in
the reference active ingredient being added to
the XML, but not the active ingredients without a
reference active ingredient. This issue was also
valid for Reference Strain extraction for Flu
Vaccine Component and Product Family Type.
This issue is resolved.

25782;
[00058380]

6.2.0.2.0069 N/A Using the Create Submission Wizard, creating a
Submission with a large number of products
assigned to a Product Family took longer than
expected and resulted in Windows Explorer being
locked for a period of time.
This issue is resolved. The performance has been
improved by replacing Associated Products
multi-select field type with the Selection Widget.

25776;
[00058405]

6.2.0.2.0069 6.1.0.4.0053 Attempting to create a Linked System with a
display name containing apostrophe resulted in a
blank white screen. This issue is resolved.
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25774 6.2.0.2.0069 N/A When an Event was closed with the values as
below, an invalid reference message was
displayed instead of displaying the reason for
closing the Event.
— Closed: ON
— Associations Closed As: NOT APPROVED
— Reason for Termination/Withdrawal: Reason

for closing event

This issue is resolved.

25773, 25621,
25562 ;
[00058380,
00056770,
00058337,
00055768,
00056182,
00058515 ]

6.2.0.2.0069 6.1.0.4.0044,
CUSTOM6_1_
0_25621_00
04.zip,
medtronic_ch
f3_25621_25
724_25773_
0007.zip

Issues were found in the selection pop-up
window with the larger number of items
assigned. Below are some of the issues described
here:
— Populating the products and Search

functionality on the product selection pop-up
window took long time to execute with large
number of products assigned

— Blank white screen appeared, when attempted
to:
• Associate/Disassociate Products with a

Registration that has 3,900 or more
Products assigned

• Edit an Application that has 3,900 or more
Products assigned

• Associate Products with an Application

These issues are resolved. Selection pop-up
window works smoothly with large number of
items assigned.
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25759;
[00058286]

6.2.0.2.0069 6.1.0.4.0061 The Create Notification wizard displayed the
wrong field name when viewing an existing
notification configured on a custom extra field for
the Application Types.
This issue is resolved. The Create Notification
wizard displays the correct field name and sends
the Notifications for the Specifications correctly.
Following are some examples of IND and CTA
application type:
— Display correct field name when custom extra

field settings have similar names for IND and
CTA

— Display correct values for IND and CTA
Application Types

— Display correct value when modifying extra
field name

— Display correct extra field values for IND and
CTA even when modifying a Notification
Specification

25756;
[00058222]

6.2.0.2.0069 N/A The Use Native File value under Default Values
conflicted with the key in insight.var file. This
is resolved by adding the new Use Default value
to the Use Native File option. When specified, the
new leafs will get the value from Use Native File
value according to the
dms.nativeLeafExtension key only.

25725;
[00057843,
00055920]

6.2.0.2.0069 6.1.0.4.0061 ABBR variable was not resolved for some cases
even when Abbreviated Name for the specific
element was present and specified.
This issue is resolved. ABBR resolves to
Abbreviated Name value when it is available and
also resolves to blank for the elements that do
not contain any value.
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25724;
[00057878]

6.2.0.2.0069 6.1.0.4.0044,
CUSTOM6_1_
0_25621_00
04.zip,
medtronic_ch
f3_25621_25
724_25773_
0007.zip

Using the quick search feature to search for a
product was taking a long time to execute. This
issue is resolved.

25722;
[00057807]

6.2.0.2.0069 N/A When Calyx RIM Publisher sent a Paper Publish
or Electronic Publish request (IpFusion,
IpLinksetter, PDFFile), some of the sub-jobs
(such as All Leaf Elements or Selected Leaf
Elements) used the on-fail parameter "continue"
instead of "end".
This issue is resolved. The on-fail attribute is set
to the correct parameter for the following leaf
elements of Paper Publish and Electronic Publish:
— Publish to a Single File – "end"
— All Leaf Elements – "end"
— Selected Leaf Elements – "end"
— All Leaf Elements and XML – "continue"
— Selected Leaf Elements and XML – "continue"
— All Volumes – "end"
— Volumes in Selected Range – "end"

25706;
[00057170]

6.2.0.2.0069 N/A When creating a PDS Template from an existing
PDS with Withdrawn status, Withdrawn PDS
Details were copied to the new PDS Template.
This issue is resolved, and the Withdrawn PDS
Details are not copied to the new PDS Template.

25690;
[00057543]

6.2.0.2.0069 6.1.0.4.0043 When exporting a report to an Excel spreadsheet,
the application consumed a large amount of
memory and it took longer than expected to
export the results.
This issue is resolved. This release reduces
memory consumption when exporting a report to
Excel by keeping only a configurable number of
rows in memory at any given time. This number
can be configured by defining a numerical value
for Excel. The default value is 100.
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25681, 25677;
[00057308]

6.2.0.2.0069 6.1.0.4.0045 Clicking the Export to Excel button multiple times
consecutively could cause LIQUENT InSight to
shut down. This issue is resolved. The Export to
Excel button becomes inactive (dimmed) after
one click. Also, when the number of results to
export exceeds 1000, a warning message
indicates that the operation could take a long
time to complete.

25672;
[00057246]

6.2.0.2.0069 N/A A JavaRMI vulnerability was found on the Insight
Publisher server, in all IP environments. This
issue is resolved.

25659;
[00056994,
00055703,
00059714]

6.2.0.2.0069 N/A After running the Create eCTD Wizard for an
Assembly and adding Leafs with Documents in
sections 1.15 and 1.16, Leafs under these
sections appeared out of order in the structure.
This issue is resolved. Leafs in sections 1.15 and
1.16 appear in the correct order.

25625;
[00056802]

6.2.0.2.0069 6.1.0.4.0044 On the Transfer Activities page, names in the
"Assign to User" list were not sorted case-
insensitive. This issue is resolved. Names now
appear in the correct alphabetical order, with
upper-case names included immediately after
lower-case names. Example:
— Aa1
— AA2

25623;
[00056605]

6.2.0.2.0069 N/A The legends in the Registration Status Summary
by Country report were not displayed correctly.
This issue is resolved.

25619;
[00056296]

6.2.0.2.0069 6.1.0.4.0068 For US 3.3 submissions, IDs of '0000' were
accepted by Calyx RIM, although US 3.3 only
permits IDs of '0001' through '9999'. This issue
is resolved for Set Application Metadata in the
Create eCTD wizard and for the Add/Edit
Metadata page invoked from the assembly or m1
folder. If an ID of '0000' is added, the message
"Submission ID must be four digits
between 0001 and 9999" appears and the
system prevents you from proceeding.
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25615, 25568;
[00056158,
00056737]

6.2.0.2.0069 6.1.0.4.0043 Some workflow activities were taking a long time
to open due to a lag in resolving entity attributes
with many objects linked to each other, causing
an extra load on the server. This issue is resolved,
and performance has been improved.

25598;
[00055911]

6.2.0.2.0069 N/A Due to the larger file size, user received an error
while publishing the files into PDF. This issue is
resolved. The publishing limit has been increased
for the following regions:
— Size limit for CA M1: up to 200MB
— Size limit for EU M1: up to 200MB
— Size Limit for US M1: up to 400MB
— Size Limit for M2-5 for US: up to 400MB
— Size Limit for M2-5 for other regions: up to

400MB

If the publishing size limit exceeds the maxsize
limit, the following warning message will appear:

FileSizeRule: invalid file
size(actual file size MB)of leaf
content "" path and name of leaf that
contains this file "".[XPath: ""/
href path @xlink:href""]/

25596;
[00056032]

6.2.0.2.0069 6.1.0.4.0043 When exporting a List of Application
Countries with Registration and
Product Details report results from Calyx
RIM to an Excel file, entries containing a large
number of Package Sets resulted in the addition
of extra rows with Package Set Name information
in two different columns. This issue is resolved.
No extra rows are added when exporting a large
amount of data to an Excel spreadsheet.

Calyx RIM 6.2 CHF 2 Release Notes

© Calyx™ 2023. 146 Calyx RIM 6.2 Release Notes
Calyx.ai Resolved Issues: Calyx RIM 6.2 CHF 2



Issue Build Hotfix Build Description

25595, 25590;
[00055290,
00056757,
00056281,
00056320,
00056666,
00055362]

6.2.0.2.0069 6.1.0.4.0044 Due to an Activity framework defect, some
workflow actions failed. Following errors found:
— ORA-02292: integrity constraint

(ACTIVITI.ACT_FK_VAR_EXE) violated - child
record found.

— org.apache.ibatis.exceptions.TooManyResults
Exception: Expected one result (or null) to be
returned by selectOne(), but found two
results.

25593;
[00056472]

6.2.0.2.0069 N/A The messages in the following wizards for the
Withdrawal operation have been revised to notify
the result of the action more accurately.
— Update Status
— Update Event-Country Status
— Update Project Event-Country Status

25585;
[00056427]

6.2.0.2.0069 6.1.0.4.0047 This release introduces a performance
improvement to decrease the amount of time it
takes to display the bookmarks for a document
when selecting the Edit Document Bookmarks
option.

25580;
[00053883]

6.2.0.2.0069 6.1.0.4.0052 Attempting to publish a tab using a "Canon
imageRUNNER with imagePASS U2" printer
resulted in an error. This issue is resolved.

25567;
[00056152]

6.2.0.2.0069 6.1.0.4.0044 When performing an event bulk update for an
existing Project, an error was encountered when
trying to update the Event Type without selecting
the Secondary Event Type when the Secondary
Event Type field was configured in the overrides
to be a required field. This issue is resolved.

25564;
[00055331]

6.2.0.2.0069 6.1.0.4.0043 After assigning an email value in the Concerned
Parties field for a sequence and then creating a
working assembly for that sequence, the email
value was missing from the Concerned Parties
field when returning to the sequence page. This
issue is resolved.
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25558;
[00056133]

6.2.0.2.0069 6.1.0.4.0044 When creating or editing a DTD/Schema type
value using the Assembly DTD/Schema Types
page in Calyx RIM Data Administration, the list of
associated countries was not populated when a
region was selected. This issue is resolved.

25547;
[00055851]

6.2.0.2.0069 6.1.0.4.0057 In-process Lifecycle links to Native Leaf in a
previous Sequence did not work in the previous
output when published. This issue is resolved.

25493;
[00055237,
00056897]

6.2.0.2.0069 N/A When the Supporting Sequence Assemblies
updated via Create eCTD wizard and attempted
to delete, resulted in an error.
This issue is resolved. Supporting Sequence
Assemblies can be deleted successfully.

25437;
[00054727,
00060709,
00062618,
00062617,
00057337]

6.2.0.2.0069 N/A FREAK (Factoring Attack on RSA-EXPORT Keys
CVE-2015-0204) is a weakness in some
implementations of SSL/TLS that enables an
attacker to decrypt secure communications
between vulnerable clients and servers. Some
SSL ciphers allowed SSL communication without
authentication. This issue is resolved.

25375;
[00052193,
00055172,
00055703,
00057012,
00058833,
00059176

6.2.0.2.0069 N/A Publishing failed: Application Number became
invalid and displayed as blank field in 1.1.2 Form
Folder. This issue is resolved.
If the issue persists after publishing again, it will
be handled as if Application Number is empty,
prompting a warning to Job Request Details and
replacing it with the default Application Number.

25261
[00054015,
00057268]

6.2.0.2.0069 N/A Assigning 500 documents to a working assembly
could take a long amount of time to complete or
would not complete. This issue is resolved and
performance has been improved.

25207;
[00052121,
00054830,
00059055,
00059474]

6.2.0.2.0069 N/A After running the Create eCTD Wizard to add new
folders (3.2.P.4.4 and 3.2.P.4.1) to section 3.2.P
in an Assembly, the added folders appeared out
of order in the structure.
This issue is resolved. All folders appear in the
correct order.
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25084;
[00051037,
00052759,
00056925,
00058862]

6.2.0.2.0069 N/A Deleting large applications or removing multiple
sequences from a lifecycle took much longer than
expected to produce results. The performance of
these operations has been improved in this
release.

24141;
[00042142,
00052191,
00052706,
00056907,
00057078]

6.2.0.2.0069 N/A When creating a new assembly using the JP eCTD
Module 1 v1.0 and JP eCTD Module 2-5 v3.2
templates, the wrong information was displayed
with missing details in these templates.
The issue is resolved. JP eCTD Module 1 v1.0 and
JP eCTD Module 2-5 v3.2 templates display
correct information with all the details.

24051;
[00041841,
00053298]

6.2.0.2.0069 N/A Publishing requests were taking an unreasonably
long time to reach the Calyx RIM Rendering
server. Publishing even a single leaf took longer
time then expected. This was due to resolving
assembly repository variables for each leaf/
document. This issue is resolved and
performance has been improved.

23917;
[00040709]

6.2.0.2.0069 N/A The following issues were found in Calyx RIM:
— Cross-Site Scripting
— JBoss Java Management Extension Console

Authentication Bypass
— JBoss Web Management Console

Authentication Bypass
— Stored Cross-Site Scripting

All of these issues have been fixed by providing
enhanced Application security protection in this
release.

22982;
[00033229]

6.2.0.2.0069 N/A It was possible to create more than one working
assembly on a single sequence. This issue is
resolved.

21599;
[00047499,
00050725,
00052214]

6.2.0.2.0069 N/A When a published submission with an updated
reference leaf Title was imported from the eCTD
into the application, the Reference Leaf Title
value was not saved. The Leaf Name value was
assigned to it. This issue is resolved.
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17629 6.2.0.2.0069 N/A After adding a lifecycle to an assembly, the
Assembly Name field was blank in the List of
Sequences with Application and Event Properties
report. This issue is resolved.

Calyx RIM 6.2 CHF 2 Release Notes

© Calyx™ 2023. 150 Calyx RIM 6.2 Release Notes
Calyx.ai Resolved Issues: Calyx RIM 6.2 CHF 2



Calyx RIM 6.2 CHF 3 Release Notes

This document describes a certified hotfix (CHF) provided to improve Calyx RIM 6.2. In addition to enhanced
features and functionality, Calyx RIM 6.2 CHF 3 resolves issues that were reported to Technical Support. Our
hotfixes are cumulative packages applied to a named version of our software.

As a certified hotfix, these updates have undergone Quality Control regression testing, certifying the system works as
expected. These changes will not create a new code branch, but will be identified by the updated build number on the
existing codeline of each version affected, not a new release number.

Overrides Updates
Calyx RIM 6.2 CHF 3 requires overrides updates. Please allow 6 to 8 weeks for XML overrides review and updates.
For details, please contact your Business Development Representative to consult with our Client Enablement team.

Security Administration
With Calyx RIM 6.2 CHF 3, the field Identity Provider Name has been added to the Security Administration
> Users and Groups > Add User/Group Wizard.

Java Support
Calyx RIM 6.2 CHF 3 includes support for Java AdoptOpenJDK as a direct replacement of Oracle Java. See Liquent
InSight Application Server Specifications for the details .

Documentum connector
Calyx RIM 6.2 CHF 3 provides an ability to change DFC library used to connect to Documentum. The default
DFC is 16.4. Please see Liquent InSight 6.2 System Support Document (SSD) for more information on supported
versions of DFC.

D2/LSRD Drag-and-Drop Functionality
Calyx RIM 6.2 CHF 3 enables you to drag-and-drop documents directly from the D2/LSRD window to the
assembly. Drag-and-drop is supported if the D2 window is opened in Java mode only. Make sure that you are aware
of the product-specific notes that may apply to the requirements for OpenText Documentum D2 16.4.

To enable the drag-and-drop from D2/LSRD functionality, the appropriate configurations need to be done in the
Internet Explorer browser. Please review the procedures in the Calyx RIM 6.2 CHF 3 Installation Guide topic
Internet Explorer: Enabling Drag-and-Drop from D2 /LSRD and make sure that the necessary configurations are
applied. If you experience any difficulties in configuring the Internet Explorer browser to enable the drag-and-drop
functionality, please contact Technical Support.

Regulatory Updates
Calyx RIM 6.2 CHF 3 supports the Jordan (JO) eCTD Module 1 Version 1.0.2.

Workflows
Calyx RIM 6.2 CHF 3 provides the ability to:
— Create and update tasks, sub-tasks, and references within a workflow.
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— Create and update tasks, sub-tasks, and references via a workflow API.

Calyx RIM 6.2 CHF 3 provides the ability to use the combination of Link Type and Link field within a single
Activity for the following entities in a workflow:
— Create/Update Registration Attachment
— Create/Update References

Calyx RIM 6.2 CHF 3 provides the ability to configure a workflow XML file to send e-mail notifications when
creating, updating, or associating entities. The workflow XML file can also be configured to send e-mail notifications
or the workflows/activities to be run at a specified time.

Data Exchange
With Calyx RIM 6.2 CHF 3, it is possible to create and update references via upsert for Data Exchange.

Default Country Value - Global Project Plan
When creating Indication/Intended Use or Species Indications using Global Project Plan, the Country
field now populates by default the value defined for Country from Application level.

XEVMPD - Authorised Product Selection
Additional filters - Product Family Name, Product Name, Application Name, License Code, and EV Code
have been added to the Authorised Product Selection page. Selecting a Product Name or Product Family
Name values in combination with the Product values, displays only the relevant values of other entities in their
respective fields.

With the additions above, the list of Authorised Product columns has been updated as follows: Operation Type,
Product Family Name, Product Name, Application Name, Procedure Type, License Code, Country, Full
Product Name, EV Code, Authorisation Status, Authorisation/Renewal Date, MAH/Organisation,
Information Date, Withdrawn/Invalidated Date, Package Description, Last Updated Date, Date
Submitted to EMA.

In the XEVMPD Submission Wizard, the new Package Set Registration and Full Product Presentation
fields (overrides) can be configured as additional filters and columns in the report layout.

Global Project Plan
Calyx RIM 6.2 CHF 3 includes the Sequence Name option in the Global Project Plan wizard in the Select
values for the new sequence you want to create page. This new option helps include the sequence name when
creating events using the Create New Events Package Set Registration project.

Parallel Submissions
Calyx RIM 6.2 CHF 3 enables you to handle multiple initial assemblies using the Synchronize with the
Submitted View feature.

In-Process Links and Link Applicability
Calyx RIM enables you to create in-process links to documents or document bookmarks from a previous sequence.
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When creating a link, it is now possible to specify the Link Applicability. Links created with Application
applicability will not have a global copy of the link.

Additional Calyx RIM 6.2 CHF3 Enhancements
— Performance improvements for electronic and paper publish.
— Performance improvements for the document assignment function.
— Support for Xerox Color C60/C70 (XPIF) and Xerox Color C60/C70 Postscript (XPIF) printers. Support is

provided for the FreeFlow controller.

List of Enhancements: Calyx RIM 6.2 CHF 3

Requested new features and enhancements are included in each release. The items are listed in descending order by
their tracking numbers. Customer case numbers that were recorded when the enhancements were requested are
included in brackets [#####] following the tracking number.

Calyx RIM 6.2 CHF 3 includes the following enhancements.

Issue Build Hotfix Build Description

26164 6.2.0.3.0062 N/A In Workflows, it is now possible to use the
combination of Link Type and Link field within a single
Activity for the following entities:
— Create/Update Registration Attachment
— Create/Update References

26155 6.2.0.3.0062 N/A The country name Macedonia, The Former Yugoslav
Republic of is replaced with North Macedonia.
Note: The country name Macedonia, The Former
Yugoslav Republic of must be updated manually to
North Macedonia under Data Administration. For
instructions to manually update the existing country
name, see the topic Maintaining an
Application Value.

26153 6.2.0.3.0062 N/A Calyx RIM wizards now supports e-signature
configuration of single entity or sub- set of entities.

26045;
[00060995]

6.2.0.3.0062 N/A Calyx RIM 6.2 CHF 3 now supports Xerox Color
C60/C70 (XPIF) or Xerox Color C60/C70 Postscript
(XPIF) printers.
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Issue Build Hotfix Build Description

26025 6.2.0.3.0062 N/A When creating Indication/Intended Use or Species
Indications using Global Project Plan, the Country field
now populates by default the value defined for
Country from the Application level.

26014;
[00062531]

6.2.0.3.0062 N/A When creating events using the Create New Events
Package Set Registration project, it was not possible to
include the sequence name. To fulfill this requirement,
there is now the option Sequence Name in the Global
Project Plan wizard in the Select values for the new
sequence you want to create page. The Sequence
Name field is specifically added for Create New Events
Package Set Registration flow only.

25932;
[00060177]

6.2.0.3.0062 N/A The Authorised Product Selection page now includes
the following new filters:
— Product Family Name
— Product Name
— Application Name
— License Code
— EV Code

Report layout columns have been updated to
accommodate the additional search results. Also, it is
now possible to configure extra fields for Package Set
Registration and Full Product Presentation as
additional filters and/or columns in the report output.

Note: The Product Name field shows only the products
that are associated with the corresponding Full Product
Presentation via Package Set. If no products are
associated, the Product Name column will be blank.
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Issue Build Hotfix Build Description

25236,
21859;
[00052583,
00054879,
00054873,
00054872,
00054784,
00054871,
00040316,
00052813,
00058011]

6.2.0.3.0062 N/A It is now possible to create in-process links to
documents or document bookmarks from a previous
sequence.

22643;
[00060811]

6.2.0.3.0062 N/A With multiple initial sequence assemblies in an
application, if one of the assemblies was added to a
lifecycle it was not possible to add a second sequence
to lifecycle. This caused the need to recreate an
assembly from the beginning. There is now the option
Synchronize with the Submitted View to synchronize
initial assembly with the latest changes in the
submitted view. Using the Synchronize with the
Submitted View option results in the following:
— Initial assembly converted to Working assembly

along with other views.
— All elements present in initial assembly are added

as a new element in the Working view.
— Resulting folder nodes include a merged list of child

nodes from both the Submitted view and initial
assemblies.

19678;
[000121448F
W,
00056051,
00058456]

6.2.0.3.0062 N/A When creating a link, it is now possible to specify the
Link Applicability to indicate whether the changes
made to a link are Global or limited to the Application
only.
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Entity Fields Added: Calyx RIM 6.2 CHF 3

The following table describes fields that were added with Calyx RIM 6.2 CHF 3.

Identity Provider
Entity Name Field Name Field

Type
Description Business Rules

Security
Administration >
Identity Providers

Provider
Type

Drop-
down
list

With LIQUENT
InSight6.2 CHF 3,
the field Provider
Type has been
added to the
Identity Providers
page.

When SSO is enabled and Calyx RIM
is configured for multiple Identity
Providers (IdPs), the Provider Types
(Okta, Azure AD, and PingOne) are
displayed in the drop-down list. The
Provider Type field is editable only in
the create mode of IdP. In the edit
mode, this field is a read-only value.

Provider
Name

Text With LIQUENT
InSight6.2 CHF 3,
the field Provider
Name has been
added to the
Identity Providers
page.

This is the name assigned by the
Security Administration user to the
Identity Provider. This field provides
the uniqueness of an Identity
Provider.

Active Flag Text With LIQUENT
InSight6.2 CHF 3,
the field Active Flag
has been added to
the Identity
Providers page.

While creating an Identity Provider,
this field is set to "Y" by default. In
the create mode this field is read-
only. Upon deactivation, the flag is
automatically set to "N". Only one
active Identity Provider can exist at a
given time.

Activate/
Deactivate

Button With LIQUENT
InSight6.2 CHF 3,
the Activate/
Deactivate button
has been added to
the Identity
Providers page.

This field is hidden in the create mode
and is displayed only in the edit mode
on the Identity Providers page. The
first time an Identity Provider is
edited, the Deactivate button
appears. Active=the value is still
used. Inactive=the value is not active.
When the IdP is deactivated, the
active flag is set to "N", and when the
IdP is activated, the active flag is set
to "Y".
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Identity Provider (IdP) type is Azure AD
Entity Name Field Name Field

Type
Description Business Rules

Security
Administration >
Identity Providers

Application
Logout URI

Text azure.appLogoutUri Fields appear only if
the Provider Type is
Azure AD.Access Token

URI
Text azure.accessTokenUri

Client ID Text azure.clientId

Client Secret Text azure.clientSecret

Key Discovery
URI

Text azure.keyDiscoveryUri

User
Authorization
URI

Text azure.userAuthorizationUri

Issuer Base URI Text azure.issuerBaseUri

Tenant ID Text azure.tenantId

SSO Trusted
Applications

Text sso.trusted.applications

Graph API URI Text azure.graphUri

Graph API
Version

Text azure.graphApiVersion
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Identity Provider (IdP) type is Okta
Entity Name Field Name Field

Type
Description Business Rules

Security
Administration >
Identity Providers

Application
Logout URI

Text azure.appLogoutUri Fields appear only if
the Provider Type is
Okta.Access Token

URI
Text azure.accessTokenUri

Client ID Text azure.clientId

Client Secret Text azure.clientSecret

Key Discovery
URI

Text azure.keyDiscoveryUri

User
Authorization URI

Text azure.userAuthorizationUri

Issuer Base URI Text azure.issuerBase.uri

Base API URL Text sso.baseApiUrl

Authorization API
Token

Text sso.authApiToken

Identity Provider (IdP) type is PingOne
Entity Name Field Name Field

Type
Description Business Rules

Security
Administration >
Identity Providers

Application
Logout URI

Text azure.appLogoutUri Fields appear
only if the
Provider Type is
PingOne.Base API URL Text sso.baseApiUrl

Authorization
API Token

Text sso.authApiToken

SAML Metadata Text sso.saml.metadata.file

SAML Entity ID sso.saml.entityId

SAML Keystore
File Name

Text sso.cryptographic.store.file

SAML Keystore
Password

Text sso.cryptographic.store.password

SAML Key Name Text sso.cryptographic.key.name

SAML Key
Password

Text sso.cryptographic.key.password
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User/Group Wizard
Entity Name Field Name Field Type Description Business Rules

Security
Administration >
Users and Groups

Identity Provider
Name

Drop-down
list

The field Identity Provider
Name has been added to
the Security
Administration > Users
and Groups > Add User/
Group Wizard to filter
search results based on
the selected IdP.

This field appears
only when SSO is
enabled and Calyx
RIM is configured
for multiple
Identity Providers
(IdPs).
Only active IdPs
are displayed in
the drop-down list.

Database Columns Changed: Calyx RIM 6.2 CHF 3

The following database columns were added or changed in Calyx RIM 6.2 CHF 3.

Field Name Field
Size

Database Column Name Database Column
Size

Database Table Name

N/A N/A IDP_ID NUMBER SEC.GRP

Resolved Issues: Calyx RIM 6.2 CHF 3

The following issues that were reported to Technical Support have been resolved. Issues are listed in descending order
by their internal tracking numbers.

Customer incident numbers that were recorded when the issues were reported are included in brackets [#####]
following the internal tracking number.

Calyx RIM 6.2 CHF 3 resolves the following issues.

Issue Build Hotfix Build Description

26225;
[00064748]

6.2.0.3.0062 N/A The validation rules described for issue 25619 in
the Calyx RIM 6.2 CHF 2 Release Notes have
been changed for US 3.3 submissions. Now, it is
possible to change Submission ID to 0000 with
no errors.

26220;
[00064684]

6.2.0.3.0062 6.2.0.2.0080 Unicode characters were not displayed correctly
in assembly/leaf/folder/document names
when SSO was enabled. This issue is resolved
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Issue Build Hotfix Build Description

26207 6.2.0.3.0062 N/A After migrating from Calyx RIM 6.2 CHF 1 to
Calyx RIM 6.2 CHF 2, the association between
the Filing Type values and the Filing Type eCTD
Codes for legacy specification versions was lost.
This issue is resolved.

26205;
[00064416]

6.2.0.3.0062 N/A An assembly created using the Swiss CH eCTD
Module 1 v1.4 assembly template included a
hyphen in the output file name field for the
sections 1.2.3.4 and 1.2.3.5 leafs. This issue is
resolved by removing the hyphens in the sections
1.2.3.4 and 1.2.3.5 in the Swiss CH eCTD Module
1 v1.4 assembly template.

26157 6.2.0.3.0062 N/A Using the Global Project Plan wizard, it was
possible to create a project using the event name
and code details that were already used within an
application. Though an event was not created, a
project was still created. This issue is resolved.
Now, a project will not be created if the event
name and code are not unique within an
application.

26156;
[00063963]

6.2.0.3.0062 N/A When a submission using the AU NeeS and ICH
XML definition file was published, the folder
structure in the resultant output was incorrect.
This issue is resolved.

26143;
[00063832]

6.2.0.3.0062 N/A The XEVMPD Audit report performance has been
improved in this release.

Note: Due to the complexity of the data that
includes entity joins and volume of the data, we
recommend XEVMPD Audit report to be run as
materialized views until the underlying issue is
fixed.
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Issue Build Hotfix Build Description

26121;
[00063458]

6.2.0.3.0062 N/A When an assembly with leafs with different
statuses was published, some files were missing
in the output. This was because the leaf statuses
were not selected even though they were listed in
the Include Leafs with Status option. Leafs were
published only when the statuses were
highlighted on Publish screen. This issue is
resolved. Now, all leafs with statuses present in
selected list go to published output.

26107;
[00063264]

6.2.0.3.0062 N/A When a new Change with at least two change
details was associated to an Event, and extra
field values were used for Event-Change details,
the event appeared in duplicate on the Related
Events tab. This issue is resolved, and the event
appears correctly on the Related Events tab.

26096 6.2.0.3.0062 N/A Synchronizing a current Working view with a
Submitted View that included a leaf with
operation Append with changed location caused
no message to appear in the Job Requests. This
issue is resolved, and the following message
appears in Job Requests when such an operation
cannot be processed: "Leaf <Name> with Leaf
<ID> with operation New was not synchronized
with the Submitted View."

26083, 26174;
[00063266,
00064161]

6.2.0.3.0062 N/A In Veeva, when a document with a name
containing the following symbols was assigned to
Calyx RIM, the symbols appeared as question
marks in Calyx RIM.
— em dash (—)
— en dash (-)
— ¶Ãö®§©£€?!"()

This issue is resolved.

26069;
[00062757]

6.2.0.3.0062 N/A When attempting to publish a paper submission,
the TOC generation failed if the TOC Title
contained a slash. This issue is resolved. Now,
slashes in a TOC Title are replaced with dashes.
The symbols in the TOC Title that are replaced by
dashes are \/:*?"<>|.
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Issue Build Hotfix Build Description

26060;
[00063046]

6.2.0.3.0062 N/A When a PDF from Veeva was dragged on to an
assembly and its Rendition Identifier was set to a
Viewable Rendition from Standard Rendition and
published as a Native File, the Rendition
Identifier of the output file was still Viewable
Rendition instead of Standard Rendition. This
issue is resolved.

26043;
[00062812]

6.2.0.3.0062 N/A When a Binder from Veeva was dragged on to an
Assembly and its Default Rendition Identifier in
the Publishing Settings Library set to Viewable
Rendition, the Rendition Identifier of the
documents under the Binder was set to Standard
Rendition instead of inheriting the Default
Rendition Identifier value from the assembly's
Publishing Setting Library. This issue is resolved.

26033;
[00062765]

6.2.0.3.0062 N/A The performance of the Prepare to Publish
process when the option Remove Empty Leafs or
Remove Empty Folders is selected has been
improved in this release.
Also, the Prepare to Publish process failed when
the nodes from which the Prepare to Publish was
invoked were deleted during the deletion
process. This issue is resolved.

26024;
[00060098]

6.2.0.3.0062 N/A An incorrect value appeared for the Currently
Marketed column in the following query reports:
— List of Application Countries with Registration

Details
— List of Application Countries with Registration

and Product Details

This issue is resolved. To prevent confusion in the
report results, the corresponding column has
been hidden by default.
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Issue Build Hotfix Build Description

26018;
[00062534]

6.2.0.3.0062 N/A Authenticating API users to Calyx RIM using
secure LDAP resulted in an error. This was due to
the incorrect port routing in the configuration file.
This issue is resolved with the addition of the
configuration options for LDAP Port, Use Secure
LDAP, and Secure LDAP Port in the
insightConfig.bat configuration tool, in the
Identity Provider Settings tab in Data
Administration. See the Calyx RIM 6.2 CHF 3
Installation Guide for more information.

26015;
[00060789]

6.2.0.3.0062 N/A When setting the Event-Country date to the
status which already had a date error regarding
violating the business rules appeared. This issue
has been fixed. It is now possible to set the same
date to the status when progression is enabled.

26011;
[00060969]

6.2.0.3.0062 N/A XEVMPD Submission Wizard: In a Registration
Attachment, despite the Attachment EV Code
missing, the validity declaration flag was
assigned to the Full Product Presentation (FPP)
Registration Attachment and no error message
was displayed. This issue is resolved. Now, when
Validity Declaration is selected manually on a
Registration FPP attachment entity and there is
no EV Code to the attachment, the XEVMPD
Submission Wizard will display a user-friendly
message.

26002;
[00060879]

6.2.0.3.0062 N/A Some users experienced general performance
issues after their upgrade from Calyx RIM 5.1 to
Calyx RIM 6.2. This issue is resolved for Calyx
RIM 6.2 CHF 3. The performance has been
improved.

25970;
[00058630,
00063658,
00056697]

6.2.0.3.0062 6.1.0.5.0027 When using drag-and-drop to move a document
from a leaf to a folder in the Working view of the
same assembly, the document did not appear in
the Publishing view. This issue is resolved.
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Issue Build Hotfix Build Description

25948;
[00060098]

6.2.0.3.0062 N/A An incorrect value appeared for the Currently
Marketed column in the following query reports:
— List of Package Set Registration with

Application and Product Detail Properties
Query

— List of Registrations with Application
Properties Query

This issue is resolved. To prevent confusion in the
report results, the corresponding column has
been hidden by default.

25921;
[00055531]

6.2.0.3.0062 N/A For the following queries, the Active Ingredients
widget showed Active and Inactive values instead
of showing only the Active values from Data
Administration. This issue is resolved. The Active
Ingredients selection widget now shows only
Active values for these queries.
— Applications Sent, Submitted, or Approved -

Searched by INN or Active Ingredient
— Applications Submitted and/or Approved

and/or Terminated within a Date Range
— List of Registrations with Excipient
— List of Excipient Manufacturers

25912;
[00059183]

6.2.0.3.0062 6.1.0.4.0082 When two different sequence assemblies were
added to a lifecycle under the same Event, and
with the same leaf replaced twice, the Approved
View window displayed leafs incorrectly. Two
leafs from the parallel working assemblies
appeared instead of one. This issue is resolved.
Now, the last lifecycled leaf is displayed.

25908;
[00059723]

6.2.0.3.0062 N/A For an EU MRP Application with Concerned
Member and Reference Members assigned to it,
running a query using DM table resulted in the
Concerned Member information missing in the
query output. This issue is resolved.

Calyx RIM 6.2 CHF 3 Release Notes

© Calyx™ 2023. 164 Calyx RIM 6.2 Release Notes
Calyx.ai Resolved Issues: Calyx RIM 6.2 CHF 3



Issue Build Hotfix Build Description

25907;
[00058005]

6.2.0.3.0062 N/A For a document that was added to a sequence
that was not an initial sequence, changing its
version in Documentum updated the new version
in the sequence in the working view when the
DMS synchronization was performed. However,
the change in the document version was not
discernible. This issue is resolved. Now, an icon is
displayed in the Sequence to indicate the change
of the document version.

25905;
[00059142]

6.2.0.3.0062 N/A After running the following query, the EEA and
Switzerland country details were not displayed in
the query report.
— List of Registrations with Local Country Details

This issue is resolved.

25887;
[00059477]

6.2.0.3.0062 N/A Entering multiple lines in a text field for a
workflow resulted in an error. This issue is
resolved.

25697;
[00057606,
00059002,
00059026]

6.2.0.3.0062 N/A The error Invalid Reference or ORA-00957:
duplicate column name appeared when
attempting to create or update a sequence, and
the InSightManager service had to be restarted to
eliminate the issue. This issue is resolved.

25565;
[00054092]

6.2.0.3.0062 N/A Updating a sequence while the submission was
being removed from a lifecycle resulted in an
error. This issue is resolved. Now, a message will
be displayed to indicate that a sequence cannot
be updated while a submission is being removed
from a lifecycle.

25389;
[00054324]

6.2.0.3.0062 N/A Migration failure due to the column size
constraints in the database has been fixed in this
release.

25384;
[00053999]

6.2.0.3.0062 N/A Importing large applications (submission with
large number of leafs under a folder) using the
eCTD Import option could fail. This issue is
resolved.
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Issue Build Hotfix Build Description

25364;
[00053273]

6.2.0.3.0062 N/A When target leafs were updated for output
location, the output location information was not
reflected in the reference leaf attributes. This
issue is resolved when both the reference and
target leafs are in the same assembly. If the
target leaf belongs to another assembly, the
reference leaf will not be updated and this is to
prevent possible performance issues in Calyx
RIM.
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Calyx RIM 6.2 CHF 4 Release Notes

This document describes a certified hotfix (CHF) provided to improve Calyx RIM 6.2. In addition to enhanced
features and functionality, Calyx RIM 6.2 CHF 4 resolves issues that were reported to Technical Support. Our
hotfixes are cumulative packages applied to a named version of our software.

As a certified hotfix, these updates have undergone Quality Control regression testing, certifying the system works as
expected. These changes will not create a new code branch, but will be identified by the updated build number on the
existing codeline of each version affected, not a new release number.

Upgrade Guidelines
The new Calyx RIM 6.2 CHF 4 Upgrade Guidelines describes the upgrade process and provides links to necessary
documents for performing your upgrade installation. See: Calyx RIM 6.2 CHF 4 Upgrade Guidelines in the Calyx
RIM online help.

Overrides Updates
Calyx RIM 6.2 CHF 4 requires overrides updates. Please allow 6 to 8 weeks for XML overrides review and updates.
For details, please contact your Business Development Representative to consult with our Client Enablement team.

Regulatory Updates
Calyx RIM 6.2 CHF 4 includes functionality related to the following regulatory updates for preview and
preparation purposes:
— China (CN) eCTD Module 1 version 1.0 (draft, dated 17 September 2019)
— Eurasian Economic Union (EAEU) electronic submission format version 1.0. The following features are included

as part of this support:
• EAEU template
• Create eCTD wizard
• Lifecycle operations
• Publishing of the output with the resulting xml being separate from the content files

— eCTD import of EAEU submissions is not part of the scope

Note: Providing regulatory updates for preview and preparation purposes means that some features that are part of the
standard regulatory update support scope are not complete (EAEU eCTD import is not part of the release) or
implementation is based on the draft specification from the health authorities (China eCTD specification). These regulatory
updates are made available to provide for early access and feedback. The functionality is subject to the same level of quality
control as the rest of the release.

Non-eCTD Assembly Templates

Calyx RIM 6.2 CHF 4 provides new and updated non-eCTD assembly templates:
— Traditional and Abbreviated 510(k)s
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— Original Pre-Market Application
— MD - IMDRF (HC) IVD Template
— MD - IMDRF nIVD Template

Data Administration
To maintain the submission product types of China region, the Submission Product Type Values table has been
introduced.

Data Administration Table Enhancements
Due to enhancements related to the RMS Term Name field, it is now displayed as a column in the grid view for the
following Data Administration tables:
— ATC Values
— Compendial Designation/Source Values
— Concentration Measure Type Values
— Country Values
— Denominator Unit Values
— Numerator Unit Values
— Dosage/Pharmaceutical Form Values
— EMA Authorisation Status Values
— Language Values
— Legal Basis  Values
— Medical Device Values
— Medicinal Product Type Values
— Procedure Type Values
— Route of Administration Values
— Unit of Measure Prefix Values

DMS Support Enhancements
Calyx RIM 6.2 CHF 4 enables you to configure a field of comma-separated values to be used as search criteria in
DMS Search, for Documentum only. Such configuration may be applied to most of the text-like document
attributes in for Documentum. Please contact your Business Development Representative to consult with our Client
Enablement team.

Veeva Integration Improvements
— API calls consumption has been significantly reduced for the following operations:

• Browsing Veeva repository from DMS Browse
• Searching documents in Veeva repository using DMS Search
• Assignment of a Veeva section from Veeva native UI or DMS Browse/Search

— Two timeout values have been added to insight.var for connections to the Veeva DMS.
— Support for Veeva users configured for SSO authentication has been added.
— Renditions processing has been enhanced.
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Show/Hide Product Family
It is now possible to hide specific product families from being displayed in the Product Family navigation tree. To
show or hide product families, use the new option Show in Tree on the Modify Product Family page.

Workflows
Calyx RIM6.2 CHF 4 provides the following enhancements to the Workflows functionality:
— A link to a specific Activity is sent in e-mail.
— A link to a specific Workflow is sent in e-mail.
— Emails and scheduling are set via the Calyx RIM configuration file.
— A chain of Activities, which covers the XEVMPD XML creation flow for particular Full Product Presentation.

See: Configure Workflows to Create an XEVMPD XML File in the Calyx RIM Workflows online help.
— Options for Workflow Activities to update XEVMPD related fields on selected entities assigned under the same

application, in bulk. See: Configure Workflows to XEVMPD Bulk Update in the Calyx RIM Workflows online
help.

XEVMPD
The performance of the XEVMPD Submission Wizard has been improved in this release.

In the XEVMPD Submission Wizard, the Authorised Product section error messages have been revised for better
understanding of the errors. The wording for some messages has been updated and one new topic for Authorized
Product section has been added: XEVMPD Error Messages for Authorised Product

Queries
On the Entity Audit Trail of the Administration tab, it is now possible to query the following entities:
— Change
— Change Details
— Event Change Details

Assembly Enhancements
Due to a new way of storing assembly tree hierarchy, performance has been significantly improved for the following
operations:
— Assign multiple documents
— Create eCTD wizard
— Import assembly using Import Assembly wizard
— Add to lifecycle/remove from lifecycle
— Study Report wizard
— Duplicate
— Move
— Delete
— Create assembly from xml
— Create assembly from another assembly
— Synchronize with the Submitted view
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Link Inspector
Calyx RIM 6.2 CHF 4 increases speed for the following types of links when refreshing the Link Inspector:
— External links in documents when source and target are within the same tree
— Internal links in documents
— In-Process links in documents

Mass Update Properties
Calyx RIM6.2 CHF 4 provides the ability to set extensions or extension attributes for folders and leafs using
the Mass Update Properties feature.

Leaf Attributes Mapping
Calyx RIM6.2 CHF 4 provides the ability to configure mapping of leaf attributes to document attributes for the
auto-created leafs. This configuration needs to be done in propertyMappings.xml file. By default, this release

Calyx RIM 6.2 CHF 4 Release Notes

© Calyx™ 2023. 170 Calyx RIM 6.2 Release Notes
Calyx.ai Resolved Issues: Calyx RIM 6.2 CHF 3



has the same configuration as previous releases. If you wish to change the default mapping, please consult with our
Client Enablement team.

Usability Enhancements
The following usability enhancements introduced with this release improve your user experience:
— Ability to list comma-separated values in DMS Search for Documentum
— Warning message with hyperlinks in a new working assembly being created under an application with unlifecycled

working assemblies
— XML Definitions field added on the Publish Request window
— Improved formatting of Job Requests messages

See: List of Enhancements: Calyx RIM 6.2 CHF 4 in the Calyx RIM6.2 CHF 4 Release Notes.

User Session Limits
Calyx RIM 6.2 enables a user with administrative permissions to set up the user session limit in the
insightConfig.bat file. By default, this ability prohibits the same user from logging on from multiple
locations at the same time. See: Authentication for Identity Providers (IdP) in the Calyx RIM Administration online
help.

Data Administration Tables: Calyx RIM 6.2 CHF 4

Calyx RIM 6.2 CHF 4 provides the following modifications to Data Administration tables.

Data Administration Section: Submission Maintenance
Data
Administration
Table Name

Entity Affected Field Name Value List Description

ods.DMF_SECTION
_TYPE

— EAEU Leaf
— Drug Registration

File Documents
Section

— Section
Code

— Section
Name

To maintain the drug registration file
documents section of the EAEU region,
the Drug Registration File Documents
Section Values table is introduced. The
values for Section Code and Section
Name can be entered in their
respective fields.

ods.DMF_DOCUME
NT_TYPE

— EAEU Leaf
— Drug Registration

File Document
Values

— Section
— Document

Code
— Name

To maintain the drug registration file
documents of the EAEU region, the
Drug Registration File Document Values
table is introduced. The values for
Section, Document Code and Name can
be entered or selected in their
respective fields.
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Data
Administration
Table Name

Entity Affected Field Name Value List Description

mgr.SUBMISSION
_PRODUCT_TYPE

— CN 1.0 Folder
— Submission Product

Type Values

— Region
— eCTD Code
— Product

Type
— Applicable

DTD/
Schema

To maintain the submission product
types of the China region, the
Submission Product Type Values table
is introduced. The values for Region,
eCTD Code, Product Type and
Applicable DTD/Schema can be
entered or selected in their respective
fields.

New Fields Added: Calyx RIM 6.2 CHF 4

The following table describes fields that were added with Calyx RIM 6.2 CHF 4.

Field
Name

Field Type Entity Name Description Business Rules

Show in
Tree

Drop-down list Modify Product
Family and Product
Family Attributes
pages.

With Calyx RIM 6.2
CHF 4, the option
Show in Tree has
been added to hide
product families from
being displayed
when using the Tree
Filter functionality.

You can use the
Show in Tree to show
or hide the product
families on the
Modify Product
Family page. By
default, this option is
set to Yes.

Database Columns Changed: Calyx RIM 6.2 CHF 4

The following table describes database columns that were added or changed in Calyx RIM 6.2 CHF 4.

Field Name Field Size Database Column Name Database Column Size Database Table Name

Show in
Tree

N/A SHOW_IN_TREE_FLAG VARCHAR2(1 BYTE) MGR.PRODUCT_FAMIL
Y

N/A N/A AS_CLIENT_ID VARCHAR2(200) ODS.DMS_REPOSITOR
Y

N/A N/A AS_CLIENT_SECRET VARCHAR2(200) ODS.DMS_REPOSITOR
Y

N/A N/A ABSOLUTE_ORDER has
been deleted, HID has
been added

RAW(2000) ODS.PUB_READINESS_
REPOR
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Field Name Field Size Database Column Name Database Column Size Database Table Name

N/A N/A CHNG_REASON_CMNT VARCHAR2 (1) has been
changed to
VARCHAR2(4000)

MGR.CHNG_MGMT_IN
CIDENT

N/A N/A CHNG_REASON_CMNT VARCHAR2 (1) has been
changed to
VARCHAR2(4000)

MGR.CHNG_MGMT_IN
CIDENT_DETAIL

N/A N/A CHNG_REASON_CMNT VARCHAR2 (1) has been
changed to
VARCHAR2(4000)

MGR.EVENT_CHNG_IN
CIDENT_DETAIL

N/A N/A HID RAW(2000) ODS.CONTENT

N/A N/A HPATH VARCHAR2(500) ODS.CONTENT

N/A N/A HLEVEL INTEGER ODS.CONTENT

N/A N/A ABSOLUTE_SEQ_NO has
been deleted

NUMBER ODS.CONTENT

N/A N/A NAME_ VARCHAR2 (255) has
been changed to
VARCHAR2(1000)

ACTIVITI.ACT_RU_TAS
K

N/A N/A NAME_ VARCHAR2 (255) has
been changed to
VARCHAR2(1000)

ACTIVITI.ACT_HI_TAS
KINST

List of Enhancements: Calyx RIM 6.2 CHF 4

Requested new features and enhancements are included in each release. The items are listed in descending order by
their tracking numbers. Customer case numbers that were recorded when the enhancements were requested are
included in brackets following the tracking number.
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Issue Build Hotfix Build Description

26437 6.2.0.4.0079 6.2.0.3.0088 To prevent instances when Calyx RIM could freeze due
to an unstable connection to the Veeva DMS, the
following timeout values have been added to the
insight.var file for connections to the Veeva DMS:
— veeva.api.connect.timeout - The maximum

number of milliseconds the application will wait
when attempting to establish a connection to a
Veeva vault.

— veeva.api.read.timeout - The maximum number of
milliseconds the application will wait for a response
from Veeva after already having established a
connection to a Veeva vault.

If these parameter values are missing, the respective
timeouts will be equal to 30 seconds
(veeva.api.connect.timeout) and 60 seconds
(veeva.api.read.timeout).

26421 6.2.0.4.0079 N/A 510k Template and PMA assembly templates have
been updated.

26380 6.2.0.4.0079 N/A The following enhancements have been performed for
the Job Request messages:
— Job Message text is formatted with line breaks.
— Errors displayed in the Job Message column are

presented in bold text.
— For Calyx RIM Rendering errors, with long error

text, the description of the error is presented in
bold text.

— Backbone Generator text that starts with ERROR: is
presented in bold text starting from ERROR: up to
the line break.

26360 6.2.0.4.0079 N/A On the home page, it is now possible to hide specific
product families from being displayed in the Product
Family navigation tree.

26355 6.2.0.4.0079 On the Entity Audit Trail of the Administration tab,
Calyx RIM now provides you to ability to query the
following entities:
— Change
— Change Details
— Event Change Details
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Issue Build Hotfix Build Description

26353 6.2.0.4.0079 N/A The Event-Change Detail associations logic has been
changed. Now, the logic is based on the individual
Event-Change Detail Status. If there are multiple
Change Details associated with one Event and one of
the Change Details has a status of Not Approved or
Withdrawn, it will be available for selection even if the
overall Event is closed as Approved.

26348 6.2.0.4.0079 N/A The number of Veeva API calls has been significantly
reduced for Expand Tree, Assign Binder, and Assign
Document actions in DMS Browse/Search.

26345;
[INC0014459
]

6.2.0.4.0079 N/A The performance of the XEVMPD Submission Wizard
has been improved in this release.

26315,
24020,
22557;
[00063191,
00041781,
00053012]

6.2.0.4.0079 N/A When assigning documents from DMS, the leaf name
and the output file name used for documents required
revisions. It is now possible to define customized leaf
and document attributes in the
propertyMappings.xml file and use them when
documents are assigned from DMS or File Share.

26289;
[INC0012144
]

6.2.0.4.0079 N/A Assigning Veeva sections caused the API burst limit to
be exceeded. The number of Veeva API calls for
assigning the Veeva document sections has been
significantly reduced.
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Issue Build Hotfix Build Description

26200;
[00064469]

6.2.0.4.0079 N/A The RMS Term Name field will now appear as a
column in the grid view for the following Data
Administration tables:
— ATC Values
— Compendial Designation/Source Values
— Concentration Measure Type Values
— Country Values
— Denominator Unit Values
— Numerator Unit Values
— Dosage/Pharmaceutical Form Values
— EMA Authorisation Status Values
— Language Values
— Legal Basis  Values
— Medical Device Values
— Medicinal Product Type Values
— Procedure Type Values
— Route of Administration Values
— Unit of Measure Prefix Values

26181;
[00063727]

6.2.0.4.0079 N/A Calyx RIM 6.2 CHF 4 enables you to configure a field of
comma-separated values for use as search criteria in
DMS Search, for Documentum only. Such configuration
may be applied to most of the text-like document
attributes in for Documentum. Please contact your
Business Development Representative to consult with
our Client Enablement team.

26158;
[00064073]

6.2.0.4.0079 6.2.0.3.0068 The Calyx RIM API authentication process has been
enhanced to incorporate the LDAP configuration
parameters defined in the insight.var file.

26099;
[00063341]

6.2.0.4.0079 N/A When a new working assembly is created under an
application that includes unlifecycled assemblies, the
warning message: "An unlifecycled working
Assembly already exists for this
Application under the following
sequences:" displays the sequence codes for the
working assemblies, with hyperlinks.

26081;
[00063116]

6.2.0.4.0079 N/A Calyx RIM6.2 CHF 4 now supports the International
Medical Device Regulators Forum (IMDRF) assembly
templates for Health Canada.
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Issue Build Hotfix Build Description

25954;
[00060145]

6.2.0.4.0079 N/A In the XEVMPD Submission Wizard, the Authorised
Product section error messages have been revised for
clarity. See: XEVMPD Error Messages for Authorised
Product in the Liquent InSight for XEVMPD online help.

25991,
24795,
23817;
[00060791,
00060643,
00047556,
00039935]

6.2.0.4.0079 N/A When working with Study Tagging Files (STF), generic
updates to extensions and extension attributes had to
be made individually for each STF. It is now possible to
update extensions or extension attributes for STFs in
bulk using the Mass Update Properties feature.

25795;
[00058695]

6.2.0.4.0079 N/A To improve the user experience, the XML Definitions
field, where the appropriate values are displayed, has
been added to the Publish Request window.

23946,
23842;
[00039378,
00039725]

6.2.0.4.0079 N/A When modifying the metadata (for example, 2.3.S,
2.3.P, Node Extension) in an assembly, each node had
to be individually revised and updated. It is now
possible to revise and update the metadata revisions
in bulk using the Mass Update Properties feature.

22824;
[00030514,
00043876,
INC0013821]

6.2.0.4.0079 N/A When assigning multiple documents from DMS or a
File Share, leafs were created with the name of the file
along with the file extensions. It is now possible to
define leaf and document attributes without
extensions in the propertyMappings.xml file and
use them when documents are assigned from DMS or
a File Share.

22581;
[00026219]

6.2.0.4.0079 N/A When assigning documents, if the leaf title field was
blank, the value for it was not retrieved from a DMS. It
is now possible to define a leaf title value that is taken
from a source document in the
propertyMappings.xml file.
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Issue Build Hotfix Build Description

22108;
[000197828F
W]

6.2.0.4.0079 N/A It is now possible to control a user's access from
multiple locations and set up a user session limit
through the insightConfig.bat file with the help
of the following parameters:
— Enable License Enforcement Functionality
— Device Limit Per Named User
— Enable User Session Limits functionality
— Number of Sessions Allowed Per Named User

See: Authentication for Identity Providers (IdP) in the
Liquent InSight Administration online help for more
information.

Resolved Issues: Calyx RIM 6.2 CHF 4

The following issues that were reported to Technical Support have been resolved. Issues are listed in descending order
by their internal tracking numbers. Customer incident numbers that were recorded when the issues were reported are
included in brackets following the internal tracking number.
Calyx RIM 6.2 CHF 4 resolves the following issues.

Issue Build Hotfix Build Description

26452;
[INC0015705]

26383;
[INC0015705]

6.2.0.4.0079 N/A The Concerned Parties values were getting
deleted when the Create eCTD Wizard was used
from the Sequence page of an application
containing multiple sequences as well as from an
application with a single sequence. This issue is
resolved. The information of the Sequence
Concerned Parties is displayed properly.

26447 6.2.0.4.0079 N/A On the Product Family Attributes page, the
following attributes were incorrectly listed after
the Development Sponsor attribute. This issue
was specific to the Pharmaceutical, Veterinary
and Flu Vaccine product family types. This issue
is resolved. Now, these attributes are listed after
the Approved Trade Names attribute.
— Product Family Concerned Parties
— Product Family Keywords
— Product Family Description
— Product Family Comments
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Issue Build Hotfix Build Description

26438;
[INC0020386]

6.2.0.4.0079 N/A The <sequence> value in published .xml output
was not the same as the value defined for
Sequence on the regional or envelope Folder
Attributes page. This issue is resolved. The value
defined under Folder Attributes is displayed in
the <sequence> tag for the versions of EU
3.0.1/3.0.3, JO-1.0 and GCC-1.5.

26422;
[INC0019310]

6.2.0.4.0079 N/A Links with "Application" applicability were mixing
(appeared where not necessary and disappeared
where necessary) after DMS synchronization if
the new minor version of the same document had
been created in Documentum. This issue is
resolved.

26419;
[INC0019054]

6.2.0.4.0079 N/A When a Package Set was associated with a
Registration instead of with a Full Product
Presentation (FPP), the information from the PDS
Active Ingredients of the Package Set was
included in the submission XML. This issue is
resolved.

26417;
[INC0018864]

6.2.0.4.0079 N/A An Application was not updated with the
Withdrawn status despite the Registration
License Status value being internally mapped to
Withdrawn. This issue is resolved.

26409;
[INC0018167]

6.2.0.4.0079 N/A The search functionality did not work in the
Approved Views of an assembly. This issue is
resolved.

26404;
[INC0018012]

6.2.0.4.0079 N/A When a link was created to a bookmark in a
document from a previous sequence, the link
created targeted to the first page of the
document, instead of the bookmark. This issue is
resolved. Now the links target to the correct
page.

26398;
[INC0017367]

6.2.0.4.0079 N/A When using the Copy Registration Wizard, trying
to copy a registration in a multiple country
application such as an MRP or DCP resulted in an
error. The error was due to the constraint on the
Medicinal Regulatory Agency field. This issue is
resolved. After using the Copy Registration
Wizard, the field Medicinal Regulatory Agency
becomes blank and the value must be updated
manually.
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Issue Build Hotfix Build Description

26395;
[INC0016670]

6.2.0.4.0079 6.2.0.3.0084 Folders in the approved view were out of order.
This issue is resolved.

26388;
[INC0016307]

6.2.0.4.0079 N/A In the Create Submission wizard Sequence Code
field, despite entering a code of four digits as
recommended, the following error was displayed:
If this is an eCTD submission it is
recommended you enter a four digit
sequence code. This issue is resolved. There
are no warning messages if the four digits are
entered.

26386;
[INC0016091]

6.2.0.4.0079 N/A A first request to create the parexel__c
rendition for a PDF document from Veeva failed.
This issue is resolved. The source document is
retrieved instead of the parexel__c rendition if
Standard Rendition is selected for a Veeva PDF
file. For another Rendition Identifier value and
non-PDF documents, the corresponding rendition
is used. Now, in some cases two calls instead of
three are sent to Veeva.

26371;
[INC0015303]

6.2.0.4.0079 N/A Gaps in the out-of-the-box (OOTB) Calyx RIM
Reporting Schema for Analytics were identified
during custom report development. This issue is
resolved.

26367 6.2.0.4.0079 6.2.0.2.0091 Calyx RIM retrieved only the first 999 groups
when authenticating a user in Azure. As a result,
users not in one of the first 999 groups were
unable to log on. This issue is resolved.

26361;
[INC0014994]

6.2.0.4.0079 6.2.0.3.0073 Leaf attributes were missing from a leaf in the
Approved View when that leaf was replaced in a
previously lifecycled sequence. This issue is
resolved.

26344;
[INC0014379]

6.2.0.4.0079 N/A On the Add or Edit Page Marker menu, changing
the Page Number to more than 3 characters
caused the error message: Page Number
cannot exceed 3 characters. This issue is
resolved. Now, it is possible to enter 5 characters
in the Page Number field.
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Issue Build Hotfix Build Description

26339;
[INC0014292]

6.2.0.4.0079 N/A Calyx RIM failed to update the following via the
API:
— Historical or future dates in the Event Country

Status Schedule.
— Projected and actual dates in the Sequence

Status Schedule.

The issues are resolved.

26336;
[INC0014237]

6.2.0.4.0079 N/A The XEVMPD Submission Wizard worked
incorrectly for the Invalidate MA operation type
on an Authorised Product when there was more
than one Event for PDS prompting the error
message: No Active Ingredient was
specified. This issue is resolved.

26328;
[INC0014090]

6.2.0.4.0079 6.2.0.3.0070 When the lifecycle operation on the same leaf
across different sequences was performed and
those events were added to the Approved View,
using the Change Status Wizard resulted in an
error. This issue is resolved.

26323;
[INC0013607]

6.2.0.4.0079 N/A Manually adding an event to the Approved view
resulted in the error: The object you are
acting on has been deleted or
modified by another user. Refresh
your object to view the current
information if the assembly had been created
from another assembly and this source assembly
was removed from the system. In the Update
Status Wizard, trying to add an event to the
Approved view resulted in Calyx RIM freezing and
the same error registering in the log file. These
issues are resolved.

26320;
[CS0042776 ]

6.2.0.4.0079 6.2.0.2.0087,
6.2.0.3.0071

Calyx RIM users authenticating with Azure AD
were unable to access Veeva using Single Sign-
On when Veeva was configured to authenticate
using ADFS. This issue is resolved.
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Issue Build Hotfix Build Description

26316;
[INC0012933]

6.2.0.4.0079 N/A Starting from Calyx RIM 6.1 CHF 4, the migration
to Calyx RIM 6.2 and CHFs failed with an ORA
error in logs for some customers. This issue is
resolved by removing the select * from
dv_user_workflow_secure query from the
migration package.

26307;
[CS0027071]

6.2.0.4.0079 6.2.0.2.0091,
6.2.0.3.0074

When Calyx RIM was configured to use Single
Sign-On via Microsoft Azure, a user disassociated
from an Azure group added to Calyx RIM was
unable to be re-associated back to that group.
This issue is resolved.

26306;
[INC0012619,
INC0013266 ]

6.2.0.4.0079 N/A Calyx RIM failed to populate the user name of the
last logged on user on the Login page. This issue
is resolved.

26300;
[00063883]

6.2.0.4.0079 N/A After an EU MRP assembly with an updated folder
structure different from the template order was
lifecycled, the Sequence view displayed empty
folders in the next Working assembly after Create
eCTD was launched. This issue is resolved. Now,
the Sequence view does not include any empty
folders.

26291, 26410;
[INC0012181,
INC0018227]

6.2.0.4.0079 N/A In a Working assembly, the Replace action on a
reference leaf resulted in infinite loading of the
assembly tree. This issue is resolved.

26287;
[00012133]

6.2.0.4.0079 N/A The New menu on the Calyx RIM home page
displayed the following options only when access
was enabled to more than one of the options in
Security Administration. When access was
enabled to only one of the following options, that
option failed to appear under the New menu:
— System Alert
— Publishing Settings Library Template
— Change
— Registration Attachment

These issues are resolved.
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Issue Build Hotfix Build Description

26286;
[INC0012051]

6.2.0.4.0079 N/A Retrieving a list of assembly templates via Calyx
RIM API requests failed. This issue is resolved.

26283 6.2.0.4.0079 N/A When retrieving a full list of PingOne users using
the Add User/Group Wizard, the search result
displayed only 10 users. This issues is resolved.

26278 6.2.0.4.0079 N/A When e-signature was enabled for Azure AD and
Okta users, the system accepted any user
credentials for e-signature instead of the logged
in user credentials. As a result, anyone (including
Read-only users) could sign in and save changes.
This issue is resolved.

26255;
[00065020]

6.2.0.4.0079 6.1.0.6.0016 Creating a standalone assembly using the JO 1.0
assembly template and then executing the
Create Study Report Wizard failed with a cannot
determine region based on dtds error.
This issue is resolved.

26247, 26405;
[00064107,
00016162,
INC0018046]

6.2.0.4.0079 N/A When a document from a Veeva repository was
assigned, the rendition information was
recognized incorrectly by Calyx RIM. This
resulted in an unnecessary extract request: if a
TOC had Calyx RIM bookmarks that were edited,
the edit changes did not appear in the generated
TOC. Also, an extraction request was sent with
each rendition, even when the rendition
parameters were not changed. These issues are
resolved. When documents are assigned from a
Veeva repository, the rendition information is
recognized correctly and edits appear correctly in
the generated TOC. If rendition parameters are
not changed, no extraction request is sent.

26245;
[00065009]

6.2.0.4.0079 6.2.0.3.0068 Calyx RIM authentication via API failed when an
application server was configured with multiple
domains. This issue is resolved.

26240;
[00064944]

6.2.0.4.0079 6.2.0.3.0070 When replacing a leaf in a subsequent sequence
associated with a new event, closing the event
and creating an approved view, both the new leaf
and the replaced leaf were displayed in the
approved view. This issue is resolved. Only
replaced leaf is displayed in approved view.
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Issue Build Hotfix Build Description

26236;
[00064804]

6.2.0.4.0079 N/A When the Procedure Identifier field was
populated during migration by the system user,
the User and Updated Date column values that
were recorded in the XEVMPD Audit Report
were incorrect. This issue is resolved.

26227;
[00064595]

6.2.0.4.0079 N/A If the time of the Approved status was set to a
time that was earlier than that of the Submitted
status, the status in the Event attributes in the
Countries tab changed to Submitted. This issue is
resolved.

26210, 25081;
[00064119,
00064088,
00063968,
00050671]

6.2.0.4.0079 6.2.0.2.0081,
6.2.0.3.0065

Support for Veeva users configured for SSO
authentication has been added to Calyx RIM.

26201; 6.2.0.4.0079 N/A When e-signature is enabled for PingOne users,
the system accepted any user credentials for e-
signature instead of the logged in user
credentials. As a result, anyone (including Read-
only users) could sign in and save changes. This
issue is resolved.

26199;
[00064147]

6.2.0.4.0079 N/A Extractions were generated for each assembly
element containing a special sheet, if it pointed
to the same template, and there was more than
one settings profile with the same template file.
It happened after the template update and the
next Render Generated TOCs and Special Sheet
Templates. This issue is resolved. Now extraction
request is sent once per special sheet template.

26195;
[00064087]

6.2.0.4.0079 N/A When an activity name was longer than 255
characters, trying to complete that activity
resulted in an error. This issue is resolved.

26193;
[00064402]

6.2.0.4.0079 N/A When selecting a file with an uppercase
extension ( For example - .DOC or .PDF) in the
Registration Attachment page, the Attachment
Name and the File Name fields were not
populated. This issue is resolved.
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26163;
[00063867]

6.2.0.4.0079 N/A Folder structure of study reports created when
importing an eCTD application was incorrect. This
issue is resolved.

26142;
[00063604]

6.2.0.4.0079 N/A When using the Volumize feature on an assembly
that contained a volume with a TOC attached to
it, there was an error. This issue is resolved.

26139;
[00063733]

6.2.0.4.0079 N/A Creating a new assembly, or importing using an
existing assembly, took longer than expected.
This issue is resolved.

26137;
[00062685]

6.2.0.4.0079 N/A An invalid reference error occurred when
changing the XML definition file in the publishing
settings from U.S. 2.0.1 to U.S 3.3 if more than
one application type with the same us-3-3
Application DTD/Schema and eCTD code existed.
This issue is resolved.

26127;
[00063568]

6.2.0.4.0079 N/A The URL in the e-mail that was sent to concerned
users when an Event-Country Status was
changed, failed to resolve to the expected target.
This issue is resolved. Now, clicking the URL
navigates to the event country where the status
was created or updated.

26122;
[00063208 ]

6.2.0.4.0079 6.2.0.3.0070 A role was not accessible on the Security
Administration page if the role had all License
Modules settings set to None/Select. This issue is
resolved.

26120;
[00063566]

6.2.0.4.0079 N/A When an assembly section was selected in the
Import Assembly Wizard or when creating an
assembly from assembly, the corresponding
assembly tree sections at the bottom half of the
page were not displayed. Also, the full length of
the scroll bar was not displayed, even on a
maximized browser window. These issue are
resolved.

26063;
[00062715]

6.2.0.4.0079 N/A The query for the List of Product Registrations
with Application and Product Detail Properties
report failed to display the result on the screen.
This issue is resolved.
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26057;
[00063029]

6.2.0.4.0079 N/A The Reset TOC Content button was not enabled
in assemblies unless the Standalone Assemblies
value for Home Page access under Security
Administration was set to Yes. This issue is
resolved.

26046;
[00062700]

6.2.0.4.0079 N/A The performance of refreshing the Link Inspector
took several hours. This issue is resolved. The
performance has been improved in sequence
assemblies with:
— External links in documents when source and

target are within the same tree
— Internal links in documents
— In-Process links in documents

25996;
[00060206]

6.2.0.4.0079 N/A In the Global Project Planning (GPP) wizard,
selecting multiple events that exceeded the
query limit, resulted in the disappearance of the
Update Project Event Country Status field in
some cases. The SQL query limit has been
increased. This issue is resolved.

25990;
[00060779]

6.2.0.4.0079 N/A When trying to create an Event-Country Status
under a closed Event that was created via a
workflow, there was an error. This issue is
resolved.

25941;
[00060258]

6.2.0.4.0079 N/A Unauthorized remote users were able to access
Red Hat JBoss EJBInvokerServlet. This issue is
resolved by commenting the JBoss
EJBInvokerServlet code block in the
web.xml file. For more information, see
Disabling Unauthorized Users from
Accessing Red Hat JBoss
EJBInvokerServlet.

25979;
[00060743]

6.2.0.4.0079 N/A When the screen resolution was set lower than
[X]x1050 format, users were not able to send a
publish request because the OK and Cancel
buttons on the Publish Request and Job Details
windows were not visible. This issue is resolved.
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25862 6.2.0.4.0079 N/A In an assembly tree, after running Prepare to
Publish, deleting a leaf containing a source
document linked to a target document resulted in
a warning: "ORA-02292: integrity constraint
(ODS.R_339) violated - child record found." This
issue is resolved.

25566;
[00054314]

6.2.0.4.0079 N/A When using the eCTD Import process to import
an assembly containing reference leafs and
assigned documents down in the assembly tree,
the reference leafs and the documents were
switched in the imported assembly. This issue is
resolved.

24253;
[00042959]

6.2.0.4.0079 N/A Performance was decreased when updating an
assembly structure and when using the Prepare
to Publish functionality to remove empty leafs
and folders. The decrease in performance
sometimes resulted in failures because of
concurrent activities in progress. These issues
are now minimized improved performance from
Assembly enhancements. See: Liquent InSight
6.2 CHF 4 Release Notes
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Calyx RIM 6.2 CHF 5 Release Notes

This document describes a certified hotfix (CHF) provided to improve Calyx RIM 6.2.

In addition to enhanced features and functionality, Calyx RIM 6.2 CHF 5 resolves issues that were reported to
Technical Support. Our hotfixes are cumulative packages applied to a named version of our software.

As a certified hotfix, these updates have undergone Quality Control regression testing, certifying the system works as
expected. These changes will not create a new code branch, but will be identified by the updated build number on the
existing codeline of each version affected, not a new release number.

Overrides Updates
Calyx RIM 6.2 CHF 5 requires overrides updates. Please allow 6 to 8 weeks for XML overrides review and updates.
For details, please contact your Business Development Representative to consult with our Client Enablement team.

Browser Support Update
Calyx RIM 6.2 CHF 5 adds support of Microsoft Edge based on Chromium. See Calyx RIM 6.2 System Support
Document (SSD) for more details.

Database Server Specification Update
Calyx RIM 6.2 CHF 5 requires one of these Oracle versions:
— Oracle 19c (12.2.0.3) - 12.2.0.3.0 Standard Edition 2
— Oracle 19c (12.2.0.3) - 12.2.0.3.0 Enterprise Edition

Regulatory Updates
Calyx RIM 6.2 CHF 5 introduces functionality related to the following regulatory updates:
— CH eCTD Module 1 Version 1.5
— EAEU 1.0:

• Embed PDF content into submission XML
• eCTD import for submissions with embedded PDF content and submissions with PDF file references from

the submission XML
• Solvent metadata for the submission XML
• Create separate folders based on the Substance and Solvent metadata
• Auto-populate the Output Folder with the metadata values from Solvent and Drug Substance extensions
• Bulk eCTD Import is not supported
• Create Study Reports Wizard is not supported

Data Administration
Calyx RIM 6.2 CHF 5 provides:
— The ability to identify – and then export the results to .xls - historical audit trail data for any value in Data

Administration, including when and by whom values were added. For SPOR Maintenance values, the audit
trail will reflect in addition whether the values were updated from the EMA or manually by a Data
Administration user.
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— The ability to use filter functionality for Data Administration Values. See: Filters for Data Administration Values
— The ability to see the full field value when you create or modify the pick list.
— The ability to simultaneously update a MedDRA Version for multiple indications/intended use values.
— The new System Process Default Flag supports the ability to assign several display statuses to the same

Internal System Status in Data Administration for:
• Application Status Values
• Event-Change Detail Status Values
• Product Status Values
• Product Detail Set Status Values
• Sequence Status Values

When the status of an Application, Product, Product Detail Set, Event-Change Detail, and Sequence is updated as
a result of running a status wizard or manually closing an event, the status set as the System Process Default is
used. Prior to this update, the system would randomly pick a display status to show as the status when multiple
display statuses were set to the same internal system status.

Global Project Plan Wizard
Extra fields can be updated in bulk on the Event Change Detail when the Details are associated to the Event via
the Project > Associate Change Detail(s) to Events wizard. For details, please contact your Business
Development Representative to consult with our Client Enablement team.

XEVMPD Acknowledgement Wizard
Calyx RIM 6.2 CHF 5 enables you to automate the inactivation of registration attachments when the corresponding
acknowledgment is received via the XEVMPD Acknowledgement wizard. This option can be configured through
application setup. By default, this option is disabled. These updates do not appear in the XEVMPD Audit Report.

XEVMPD Audit Report
To make the XEVMPD Audit Report more concise and efficient, the following inconsequential results are removed
from the report:
— Automated updates when an EV Code or the Validity Declaration is assigned
— MedDRA Code and MedDRA Version when changes are made to them
— Rows added for each country when an indication is added or modified for EU CP
— Updates performed by SYSMAINT user

CT Shared Data
In prior versions of Calyx RIM for Registrations, on the Product Family > CT Shared window, the Protocol
Number and EudraCT Number field had to be a unique combination. In Calyx RIM 6.2 CHF 5, the uniqueness
rule is modified and only the Protocol Number must be unique within the Product Family.

Full Product Presentation
In Calyx RIM for Registrations, the Full Product Presentation (FPP) window displays a new field, XEVMPD
Submission Required?, which enables you to categorize the FPPs ready for XEVMPD submission. You can trigger
a system notification when the value of the new field changes.
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Queries
The new List of Events with Change Details query enables you to view events that are associated with change,
change details, and event change details.

Assemblies
In an assembly, you can now update the Folder or Leaf extension value from the Change Type > Extension
without switching to Default value.

eCTD Import
Calyx RIM now retains the site folders in M5 after importing the study reports as node extensions.

Mass Update Properties
Clients with Electronic Lifecycle Publishing (ELP) licenses can use Mass Update Properties functionality.

Job Requests
In the Calyx RIM Publisher, new job statuses are introduced in the Job Request screen:
— Completed with Errors
— Completed with Warnings

Font Optimization in Paper Output
The new option Optimize Fonts in Paper Output minimizes font compatibility issues and provides stability to the
process of printing paper output.

Optimized Memory Usage
Memory usage is optimized when publishing very large submissions in Calyx RIM 6.2 CHF 5.

Performance Improvements
Performance is improved for:

— Add Submission to Lifecycle and Remove Submission from Lifecycle functionality.
— Prepare to Publish with the options Remove Empty Assembly Folders and Remove Empty Assembly

Leafs.
— Updating Folder or Leaf extended attributes using Mass Update Properties functionality.

Database Columns Added/Changed: Calyx RIM 6.2 CHF 5

The following table describes database columns that were added or changed in Calyx RIM 6.2 CHF 5.

Field Name Field Size Database Column Name Database Column Size Database Table Name

Optimize
Font in
Paper
Output

N/A OPTIMIZE_FONTS_FLAG VARCHAR2(1) ODS.PUB_SETTINGS
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Field Name Field Size Database Column Name Database Column Size Database Table Name

System
Process
Default
Flag

N/A SYSTEM_PROCESS_DEF
AULT_FLAG

VARCHAR2(1) MGR.VALID_ENT_INT_
STATUS

XEVMPD
Submission
Required?

N/A XEVMPD_SUBMISSION_
REQUIRED_FLAG

VARCHAR2(1) MGR.FULL_PRODUCT_
PRESENTATION

New Fields Added: Calyx RIM 6.2 CHF 5

The following table describes fields that were added with Calyx RIM 6.2 CHF 5.

Field
Name

Field Type Entity Name Description Business Rules

Created
By

Username All the SPOR
Maintenance values
in Data
Administration

Created By has been
added to ensure the
visibility of who
added the values.

You can use the
Created By field to
define by whom a
SPOR Maintenance
value was created,
either via automated
updates from the
EMA or manually by
Data Administration
users. By default,
this option is read-
only. It is populated
automatically when
updates are made to
the table.

Created
Date

dd-mmm-yyyy All the SPOR
Maintenance values
in Data
Administration

The field Created
Date has been added
to ensure visibility of
when the values are
added.

You can use the
Created Date field to
define when a SPOR
Maintenance value
was created. By
default, this option is
read-only. It is
populated
automatically when
updates are made to
the table.
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Field
Name

Field Type Entity Name Description Business Rules

DMS
Versionin
g Scheme

Radio button Import from eCTD
option, on the
Application page.

DMS Versioning
Scheme has been
added to provide
functionality related
to EAEU regulatory
updates.

You can use DMS
Versioning Scheme
to import EAEU
submissions. See:
Calyx RIM Best
Practice: EAEU
Submissions.

EAEU
XML with
embedde
d PDFs

Drop-down list Import from eCTD
option, on the
Application page.

EAEU XML with
embedded PDFs has
been added to
provide the
functionality related
to EAEU regulatory
updates.

You can use EAEU
XML with embedded
PDFs to import EAEU
submissions. See:
Calyx RIM Best
Practice: EAEU
Submissions.

EAEU
XML
Location

Browse button Import from eCTD
option, on the
Application page.

EAEU XML Location
has been added to
provide the
functionality related
to EAEU regulatory
updates.

You can use EAEU
XML Location to
import EAEU
submissions. See:
Calyx RIM Best
Practice: EAEU
Submissions.

Embed
PDFs into
EAEU
XML?

Check box Embed PDFs into
EAEU XML? option,
on the Export
Published Output
page.

Embed PDFs into
EAEU XML? has been
added to provide
functionality related
to EAEU regulatory
updates.

You can use Embed
PDFs into EAEU XML?
to export EAEU
submissions. See:
Calyx RIM Best
Practice: EAEU
Submissions.

Last User
Updated

Username All the entities and
grids in Data
Administration.

Last User Updated
has been added to
identify historical
audit trails.

You can use the Last
User Updated field to
define by whom the
Data Administration
value was created/
updated. By default,
this option is read-
only. It is populated
automatically when
updates were made
to the table.
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Field
Name

Field Type Entity Name Description Business Rules

Last
Changed
Date

dd-mmm-yyyy All the entities and
grids in Data
Administration.

Last Changed Date
has been added to
identify a historical
audit trail within user
interface.

You can use the Last
Changed Date field to
define when a Data
Administration value
was created/
updated. By default,
this option is read-
only. It is populated
automatically when
updates were made
to the table.

Mass
Update

Action button Indications/Intended
Use

Mass Update enables
you to update a
MedDRA version for
multiple indications/
intended entities
simultaneously.

You can use Mass
Update to enter a
MedDRA version. You
can then use the
option Update and
Overwrite to update
the new version for
all selected
Indications or use
Update and Preserve
to update the new
version for only those
selected Indications
which have no
values.

Optimize
Font in
Paper
Output

Drop-down list Publishing Settings
Library

Optimize Font in
Paper Output has
been added to
Publishing Settings
Library.

Minimize font
compatibility issues
and provide stability
to the process of
printing the paper
output. By default,
the value is No. All
assemblies migrated
from a previous Calyx
RIM version will
have Optimize Fonts
in Paper Output set
to No.
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Field
Name

Field Type Entity Name Description Business Rules

Output
Documen
t Type

Drop-down list Import from eCTD
option, on the
Application page.

Output Document
Type has been added
to provide the
functionality related
to EAEU regulatory
updates.

You can use Output
Document Type to
import EAEU
submissions. See:
Calyx RIM Best
Practice: EAEU
Submissions

System
Process
Default
Flag

Drop-down list The following entities
in Data
Administration
— Application >

Application Status
Values

— Event > Event-
Change Detail
Status Values

— Product > Product
Status Values

— Product > Product
Detail Set Status
Values

— Sequence >
Sequence Status
Values

If you assign several
display statuses to
the same Internal
System Status in
Data Administration,
the System Process
Default Flag enables
you to select the
display status to
show for Application,
Product, Event-
Change Detail, or
Sequence after the
Event is closed
manually or via the
wizard.

You can use System
Process Default Flag
to define the display
status in the Name
field which will be
displayed after the
Event is closed
manually or via the
wizard, provided that
the appropriate
Internal System
Status is mapped to
that display status.

XEVMPD
Submissi
on
Required?

Drop-down list Full Product
Presentations

XEVMPD Submission
Required? enables
you to categorize the
Full Product
Presentations that
are ready to be
submitted to
XEVMPD.

When creating or
copying Full Product
Presentations, the
value of this field is
automatically set to
Yes. This indicates
that the XEVMPD
data is ready to be
submitted.
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Data Administration Fields Updated: Calyx RIM 6.2 CHF 5

This table describes fields that were updated or removed with Calyx RIM 6.2 CHF 5.

Pick List Name Field Name Field Type 6.2
CHF 5

Field
Size
Calyx
RIM 6.2
CHF 4

Field
Size
Calyx
RIM 6.2
CHF 5

Applicant Contact Values Applicant Contact Name Text box

Applicant Contact Type Values Applicant Contact Type Text box

Applicant ID Values Applicant Name Text box

Application Form Type Values Application Form Type Text box

Assembly Repository Variables Variable Value Text box

ATC Values ATC Description Text box

Concentration Measure Type Values Concentration Measure
Type Name

Text box

Custom List Names List Name Text box

Custom List Values List Value Text box

Device Allergenicity Values Code Name Text box

Device Nomenclature Values Code Name Text box

Device Sterility Indicator Values Code Name Text box

Device Type Values Code Name Text box

Device Usage Values Code Name Text box

Dosage/Pharmaceutical Form
Values

Dosage Form (Long Name) Text box

Dosage Form (Short Name) Text box

Description Text box

Drug Registration File Documents
Values

Name Text box 50 500

Drug Registration File Documents
Section Values

Name Text box 50 500

Homepage Display Properties Comments Text box

Indications/Intended Use Values Indications/Intended Use Text box

Language Values Language Name Text box
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Pick List Name Field Name Field Type 6.2
CHF 5

Field
Size
Calyx
RIM 6.2
CHF 4

Field
Size
Calyx
RIM 6.2
CHF 5

Legal Basis Values Legal Basis Name Text box

MAH/Development Sponsor/
Organisation Values

MAH/Development
Sponsor/Organisation
Name

Text box

Organisation Identifier Text box

Address Text box

Comments Text box

Manufacturer Values Manufacturer Name Text box

Organisation Identifier Text box

Address Line 1 Text box

Comments Text box

Keywords Text box

Description Text box

Medical Device Values Medical Device Name Text box

Medicinal Product Type Values Medicinal Product Type
Name

Text box

Packaging Type Values Name Text box

Procedure Type Values Procedure Type
Abbreviation

50 100

Procedure Type Name Text box 50 500

Product Characteristics Values Code Name Text box

Product Family Values Family Name Text box

Product Material Values Code Name Text box

Promotional Material Doc Type
Values

Promotional Material Doc
Type

Text box

Promotional Material Type Values Promotional Material Type Text box

Promotional Material Audience Type
Values

Promotional Material
Audience Type

Text box
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Pick List Name Field Name Field Type 6.2
CHF 5

Field
Size
Calyx
RIM 6.2
CHF 4

Field
Size
Calyx
RIM 6.2
CHF 5

Qualified Person Responsible for
Pharmacovigilance (QPPV) Values

QPPV Name Text box

Quantity Unit Of Measure Values Code Name Text box

Reasons for Termination/
Withdrawal List Values

Reasons for Termination/
Withdrawal

Text box

Region Values Region Abbreviation 50 100

Region Name Text box 300 200

Region Type Values Region Type Name Text box

Regulatory Activity Lead Values Regulatory Activity Lead Text box

Route of Administration Values Route of Administration
(Long Name)

Text box

RMS Values, for SPOR Maintenance
section

Term Name Text box

Short Name Text box

Secondary Event Type Values Name Text box

Sequence Description Values Sequence Description Text box

Shelf Life Type Values Code Name Text box

Special Measure Values Code Name Text box

Sterilization Requirement Values Code Name Text box

Storage Condition Values Storage Condition Text box

Sub Filing Type Values Sub Filing Type Text box

Submission Product Type Values Product Type Text box

Substances Values Substance Name Text box

Molecular Formula Text box

CBD Text box

Description Text box

Comments Text box
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Pick List Name Field Name Field Type 6.2
CHF 5

Field
Size
Calyx
RIM 6.2
CHF 4

Field
Size
Calyx
RIM 6.2
CHF 5

Substance Attachment Values Attachment Name Text box

File Name Text box

Internal Name Text box

Substance Class Values Substance Class Name Text box

Supplement Effective Date Type
Values

Supplement Effective Date
Type Name

Text box

Trade Name Values Trade Name Values Text box

Unit Of Presentation Values Code Name Text box

Volume Unit Of Measure Values Code Name Text box

New Queries Added: Calyx RIM 6.2 CHF 5

This table lists the filters available for the new List of Events with Change Details query that is included on the
Registration Planning and Tracking tab.

Filter Field Type Business Rule

Product Family Type Drop-down Exact match on any selected value.

Product Family Name Multi-select list Exact match on any selected value.

Product Name Product Name Exact match on any selected value.

Application Name Free text Containing the matching text.

Application Country Multi-select list Exact match on any selected value.

Application Status Multi-select list Exact match on any selected value.

Application Type Multi-select list Exact match on any selected value.

Application Procedure Type Multi-select list Exact match on any selected value.

Event Country Multi-select list Exact match on any selected value.

Event Validation Number Free text Containing the matching text.

Event Name Free text Containing the matching text.

Event Type Multi-select list Exact match on any selected value.

Event Secondary Event Type Free text Containing the matching text.
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Filter Field Type Business Rule

Event Action Type Multi-select list Exact match on any selected value.

Event Country Current Status Multi-select list Exact match on any selected value.

Event-Country Current Status Date Date range Containing the matching date.

Event-Country Projected Submittal Date Date range Containing the matching date.

Event-Country Actual Submittal Date Date range Containing the matching date.

Event-Country Projected Approval Date Date range Containing the matching date.

Event-Country Actual Approval Date Date range Containing the matching date.

Event-Country Actual Not Approval Date Date range Containing the matching date.

Event Open Flag Flag Match based on Yes/No selection.

Event Closed Date Date range Containing the matching date.

Event Associations Closed as Multi-select list Exact match on any selected value.

Change Type Multi-select list Exact match on any selected value.

Change Internal Number Multi-select list Exact match on any selected value.

Change External Number Multi-select list Exact match on any selected value.

Change Short Description Free text Containing the matching text.

Change Responsible Person Free text Containing the matching text.

Change Detail Number Multi-select list Exact match on any selected value.

Change Detail Short Description Free text Containing the matching text.

Change Detail Responsible Person Free text Containing the matching text.

Event Change Detail Status Multi-select list Exact match on any selected value.

The extra fields included in the following entities are included in the query list.
— Application
— Event
— Change
— Change Detail
— Event Change Detail

List of Enhancements: Calyx RIM 6.2 CHF 5

Requested new features and enhancements are included in each release. The items are listed in descending order by
their tracking numbers. Customer case numbers that were recorded when the enhancements were requested are
included in brackets [#####] following the tracking number.
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26549,
25730;
[00058042,
00063209]

6.2.0.5.0055 6.2.0.4.0104 Added functionality required to embed PDF content
into submission XML according to the EAEU HA
requirements.

26542 6.2.0.5.0055 6.2.0.4.0104 Added functionality to auto-populate the Output
Folder with metadata values from Solvent and Drug
Substance extensions for EAEU submissions.

26541 6.2.0.5.0055 6.2.0.4.0104 Added the ability to provide Solvent metadata for
EAEU submission XML. Details of the new guidance
can be found at: https://www.regmed.ru/download/
eaeu/
ToEaeuApplicants_DossierUpd_20200323_1.pdf

26519;
[PRB004053
0]

6.2.0.5.0055 N/A When diagnosing issues that required a restart, the
data_exchanger.log and server.log files were cleared
out after the restart. The configuration has been
modified to prevent the log files from being cleared
out after restart, and messages are continually added
to the existing log files.

26512 6.2.0.5.0055 6.2.0.4.0104 Mass Update Properties was available for Calyx RIM
with the SPT license, but not with the ELP license. This
issue is resolved. Mass Update Properties functionality
is now available for clients with Electronic Lifecycle
Publishing (ELP) licenses.

26508 6.2.0.5.0055 6.2.0.4.0104 The eCTD Import wizard now supports the import of
EAEU submissions with embedded PDF content and
submissions with PDF file references from the
submission XML.

26496;
[INC0025048
]

6.2.0.5.0055 N/A When creating a new working assembly using the
Create eCTD wizard in an EU MRP application, the
country metadata for the subsequent countries is
copied as the default country metadata from the first
country page except for the Agency name, Applicant,
and Invented Name values even if a new country was
added to the application.

26480;
[INC0023770
]

6.2.0.5.0055 N/A The new Mass Update feature enables you to update a
MedDRA Version for multiple indications/intended use
data administration values entities simultaneously.
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26450;
[CS0092205]

6.2.0.5.0055 N/A Memory usage is optimized when publishing very large
submissions in Calyx RIM 6.2 CHF 5.

26416 6.2.0.5.0055 N/A The new List of Events with Change Details query
enables you to view events that are associated with
change, change details, and event change details.

26387 6.2.0.5.0055 N/A The uniqueness constraint for the EudraCT Number on
a protocol has been removed in this release. A study
or the clinical trial shared data can now include a
redundant EudraCT Number.

26359 6.2.0.5.0055 N/A You can automate the inactivation of registration
attachments once the corresponding acknowledgment
is received via the XEVMPD Acknowledgement wizard.
This option can be configured through application
setup. By default, the option is disabled. These
updates will not appear in the XEVMPD Audit Report.

26358 6.2.0.5.0055 N/A To make the XEVMPD Audit Report more concise and
efficient, the following inconsequential results have
been removed from the report:
— Automated updates when an EV Code or the

Validity Declaration is assigned
— MedDRA Code and MedDRA Version when changes

are made to them
— Rows added for each country when an indication is

added or modified for EU CP
— Updates performed by SYSMAINT user.

26357 6.2.0.5.0055 N/A You can categorize the Full Product Presentations that
are ready to be submitted to XEVMPD with the help of
the new XEVMPD Submission Required? option.

26356 6.2.0.5.0055 N/A Extra fields can be updated in bulk on the Event
Change Detail when the Details are associated to the
Event via the Project > Associate Change Detail(s) to
Events wizard. For details, please contact your
Business Development Representative to consult with
our Client Enablement team.
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26354 6.2.0.5.0055 N/A The new System Process Default Flag provides the
ability to assign several display statuses to the same
Internal System Status in Data Administration for
Application, Event-Change Detail, Product, Product
Detail Set, and Sequence. You can see the assigned
status after running the wizard or when the Event is
closed manually. Before, the system randomly
selected the first status that was mapped to the
Internal System Status and you could not define which
statuses would show after the updates.

26321;
[INC0013546
]

6.2.0.5.0055 N/A It is now possible to create a folder or a leaf with an
extension other than Default and extended attributes
populated using a single API call.

26265 6.2.0.5.0055 N/A You can identify when any SPOR Maintenance value
was created and by whom. These fields are added:
— Created By
— Created Date

26264 6.2.0.5.0055 N/A You can identify when any Data Administration value
was created/last modified and by whom. These fields
are added:
— Last User Updated
— Last Changed Date

26204;
[00064468]

6.2.0.5.0055 N/A The full field value can be viewed in Data
Administration when you create or modify the pick list.

26095;
[00063365]

6.2.0.5.0055 N/A Calyx RIM 6.2 CHF 5 requires one of these Oracle
versions:
— Oracle 19c (12.2.0.3) - 12.2.0.3.0 Standard Edition

2
— Oracle 19c (12.2.0.3) - 12.2.0.3.0 Enterprise

Edition

24325 6.2.0.5.0055 N/A Calyx RIM now retains the site folders in M5 after
importing the study reports as node extensions.
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24532,
20873;
[00044627,
00037898]

6.2.0.5.0055 N/A New job statuses are introduced for Job Requests:
— Completed with Errors
— Completed with Warnings

23803
[00039687]

6.2.0.5.0055 N/A In an assembly, you can update the Folder or Leaf
extension value from the Change Type > Extension
without switching to the Default value.

Resolved Issues: Calyx RIM 6.2 CHF 5

The following issues that were reported to Technical Support have been resolved. Issues are listed in descending order
by their internal tracking numbers. Customer incident numbers that were recorded when the issues were reported are
included in brackets following the internal tracking number.

Calyx RIM 6.2 CHF 5 resolves the following issues.

Issue Build Hotfix Build Description

26608;
[INC0038408]

6.2.0.5.0055 N/A After migrating to Calyx RIM 6.2 CHF 4, clicking
the Concerned Parties icon resulted in an error.
This occurred if the domain of a user was
changed and there was a NULL value for that user
in the Domain column in the SEC.USR table. This
issue is resolved.

26606;
[INC0038763]

6.2.0.5.0055 N/A The Submission Readiness report took a longer
time to generate than usual and in some
instances the report failed to generate. This issue
is resolved. Now, the Submission Readiness
report generates successfully and with less time.

26597 6.2.0.5.0055 6.2.0.4.0.011
1

When EAEU submissions were published after
performing a Delete operation on one or more
leafs, incorrect leaf attributes and DocID values
were included in the output XML. This issue is
resolved.

26592 6.2.0.5.0055 6.2.0.4.0.011
0

The Export Published Output process did not
support Cyrillic symbols in filenames when
choosing to embed PDF files into the EAEU XML
file. This issue is resolved.
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26588 6.2.0.5.0055 6.2.0.4.0.011
0

The Export Published Output process failed
intermittently when choosing to embed PDF files
into the EAEU XML file when the processed file
path included spaces. This issue is resolved.

26583;
[INC0023438]

6.2.0.5.0055 6.2.0.4.0.011
0

If a workflow was associated to the assembly
root, a folder, or a document in an initial
sequence assembly, and the Synchronize with
the Submitted View option was applied, the
workflow was lost. This issue is resolved.
Associated workflows are kept for each node
after the option is applied.

26582 6.2.0.5.0055 6.2.0.4.0.011
0

The mediaTypeCode attribute was missing from
the embedded PDF nodes of the EAEU XML
output file. Although this attribute is not required
per the schema, the agency validator requires it.
This issue is resolved. The mediaTypeCode
attribute is now included in the EAEU XML file for
embedded PDF nodes.

26574 6.2.0.5.0055 6.2.0.4.0104 When an EAEU submission was published, the
name of the XML index file generated was
incorrect. This issue is resolved. Now, the XML
index file includes the correct name: index-
r-022.xml

26571 6.2.0.5.0055 6.2.0.4.0104 The incorrect codeListId value was generated
in the UnifiedCountryCode of an EAEU
assembly published XML. This issue is resolved.

26565;
[INC0033560]

6.2.0.5.0055 6.2.0.4.0106 Calyx RIM did not recognize some users as
members of their assigned Active Directory (AD)
groups. This issue is resolved.

26556;
[INC0033264]

6.2.0.5.0055 At times, the Synchronize with the Submitted
View option took more time than usual. This issue
is resolved.

26537;
[INC0030024,
INC0033088]

6.2.0.5.0055 N/A If an assembly root was not selected during
publishing, variables failed to be resolved in the
submission output for all the leafs. This issue is
resolved.

26533;
[INC0029832]

6.2.0.5.0055 6.2.0.4.0104 Errors were found when the Publishing Readiness
Query was run for the China eCTD. This issue is
resolved.
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26530;
[INC0029543]

6.2.0.5.0055 6.2.0.4.0104 The Document Creation Date displayed the
current date, even though no value was specified
for that field in the modify mode. This issue is
resolved. Now, Document Creation Date displays
a date only when the field is populated.

26528;
[INC0029467]

6.2.0.5.0055 6.2.0.4.0104 When creating and publishing an assembly with
the new EAEU Assembly Template including
section 2.7.3, the following message appeared:
"WARN : The characters: ? were
removed from the path"." This issue is
resolved.

26527, 26226,
25965;
[INC0029460,
00064445]

6.2.0.5.0055 N/A The options For this Element and Document were
not available on the Update Overlay Settings page
invoked from the Document. This issue is
resolved.

26507 6.2.0.5.0055 6.2.0.4.0104 The EAEU 1.0 assembly template is updated and
now eCTD is used as the assembly type.

26504 6.2.0.5.0055 6.2.0.4.0093 A Vertical Privilege Escalation (Systemic)
vulnerability was reported as a result of
penetration testing. This issue is resolved.

26502;
[INC0025226]

6.2.0.5.0055 N/A Applying the eCTD Import to an AU-3-0 assembly
where the Sequence Description attribute had a
code values different from those provided by the
agency caused the import to fail. This issue is
resolved. Now the import ignores the
mismatches and takes the code value.

26491 6.2.0.5.0055 6.2.0.4.0096 When using Mass Update Properties with the
Update and Preserve option selected to set the
extension value for leafs in a folder, the extended
attributes were erased for child folders or leafs
within the selected range. This issue is resolved.

26487;
[INC0024292]

6.2.0.5.0055 N/A After importing published GCC submissions,
some folders were renamed or missing. This
issue is resolved. Now, the imported assembly
keeps the original structure.
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26486;
[INC0024081]

6.2.0.5.0055 N/A If an application had an Active or Not
Approved or Withdrawn status, and the
application had a registration with a status other
than Withdrawn, it was not possible to update
an event with Withdrawn status. This issue is
resolved.

26469;
[INC0023438]

6.2.0.5.0055 N/A If a Workflow was associated to a leaf in an initial
sequence assembly and the Synchronize with the
Submitted View option was applied, the
Workflow was lost. This issue is resolved.
Associated Workflows are kept for each leaf after
the option is applied.

26458;
[INC0022479]

6.2.0.5.0055 6.2.0.4.0106 Publishing failed for the 2.3.S, 2.3.P, and 2.7.3
folders of ICH Module 2-5 v3.2 when the
metadata field contained a single quote
character. This issue is resolved.

26455;
[INC0022252]

6.2.0.5.0055 N/A Variables with spaces in the Variable Name
field did not resolve in the published output. This
issue is resolved.

26449 6.2.0.5.0055 N/A An InSight API request to retrieve a list of
assemblies for assembly types other than
templates did not work. This issue is resolved.

26446 6.2.0.5.0055 N/A When using the Mass Update Properties
functionality, the time taken for updating the
extended attributes was longer than the time
taken for the common attributes. This issue is
resolved.

26444;
[INC0021105]

6.2.0.5.0055 N/A Incorrect Folder/Leaf names were observed in
sections 1.08, 1.09, and 1.12 in JP eCTD Module
1 v1.0 assembly template. This issue is resolved.
The JP eCTD Module 1 v1.0 assembly template is
updated.
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26439;
[INC0020399]

6.2.0.5.0055 N/A For an eCTD Import, the “Waiting for
InSight” status appeared without updates in
Job Status. There was no indication that the
import failed when the imported submission had
a sequence that failed to lifecycle due to
mismatched Folder Types. This issue is resolved.
"Completed" appears in the Job Status column,
and the sequence is indicated. When the m1-us-
form type folder is imported into submission
with the Submitted view and m1-us-admin-
form type folder is imported into submission
with the Sequence view, the Node type
mismatch is found: a node with m1-us-
admin-form type replaced a node with
m1-us-form type in the Submitted
View. message appears.

26434;
[INC0020054]

6.2.0.5.0055 N/A In Internet Explorer, when using the Delete
(Withdraw) option on multiple leafs from
subfolders of a Working assembly, the process
ran would spin for a long time with no result. This
issue is resolved. The method used to
communicate with the server is changed and now
you can select any number of leafs to withdraw.

26432;
[INC0019888]

6.2.0.5.0055 N/A If it was associated to a Product and Project, an
Event could not be updated using the API . This
issue is resolved.

26425;
[INC0376737]

6.2.0.5.0055 N/A In a Working assembly with documents assigned
from Documentum, the links created to
bookmarks in other documents using Calyx RIM
Linking plug-in (PDF) resolved to incorrect pages
after publishing. This issue is resolved.

26402;
[INC0017878]

6.2.0.5.0055 N/A When an event was closed with a reason using
the Specify Reason for Termination/Withdrawal
option, the same reason was applied to the
parent application. This issue is resolved.

26401;
[INC0017630]

6.2.0.5.0055 N/A When deleting leafs in bulk using Delete
(Withdraw) lifecycle operation in the Working
assembly, the assembly tree refreshed and the
deletion symbol (crossed leaf) appeared only on
one of the leafs instead of all of them. This issue
is resolved.
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26397, 24517;
[INC0017263,
00044443]

6.2.0.5.0055 N/A When deleting an assembly, there was no
indicator of the deletion in progress. This issue is
resolved. A progress indicator shows that the
deletion is in progress.

26370;
[INC0015274]

6.2.0.5.0055 N/A The pagination formulas using Reverse and Bates
types did not resolve properly for paper
publishing. Example:
$Bates($Reverse($Calculate(${ATP}-$
{ARP}+1),"-1"),5).
This issue is resolved. The formula works when
an intermediate variable is used as the first one in
alphabetical order according to Variable Code.
Example:
— Variable Name = someTestName, Variable

code = calcRevPage,Variable Value =
$Reverse($Calculate(${ATP}-${ARP}
+1),"-1")

— Variable Name = someTestName , Variable
code = revBates, Variable Value =
$Bates($calcRevPage, 5)

To experience better performance, we
recommend to minimize the formulas usage and
set up them in Publishing Settings Library, not in
Data Administration.

26346;
[INC0014465]

6.2.0.5.0055 N/A Notifications were not sent even when the mail-
service.xml file included a valid SMTP server
name and port number. This issue is resolved.

26340;
[INC0014300]

6.2.0.5.0055 N/A After reordering leafs in a Working Assembly
using Reorder Child Leafs option, users observed
empty folders in Publishing and Sequence views.
This issue is resolved in Calyx RIM 6.2 CHF 4 as a
result of other fixes.

26310, 19440;
[INC0012460]

6.2.0.5.0055 N/A After performing a DMS Synchronization on an
assembly with an assigned document that was
versioned, the document attributes and assembly
tree were not automatically refreshed by Calyx
RIM. This issue is resolved. Now, the icon 'Newer
version available' is displayed without having to
manually refresh the assembly tree.
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26276;
[INC0011104]

6.2.0.5.0055 N/A The Assembly templates for CH 1.3 and CH 1.4
contained errors that lead to validation issues.
This issue is resolved.

26221;
[00064631]

6.2.0.5.0055 N/A In EU Submissions with MAA in Submission Type
and with the initial value in Submission Unit Type,
the users were able to save the empty INN in
EMA Envelope Information. This issue is
resolved. Now, the users are required to populate
it when needed.

25831 6.2.0.5.0055 N/A When using the Calyx RIM API to convert a leaf to
reference, it could not be targeted to a leaf from a
Sequence view. This issue is resolved.

25487;
[00055381]

6.2.0.5.0055 N/A The Find and Replace option did not function as
expected in the Publishing view of an assembly
and was not available for the folders with new or
lifecycle-operated nodes in the current sequence
in the Working view. This issue is resolved. Now,
in the Publishing view, the Find and Replace
option covers the leafs and documents and is
available for folders with new or lifecycle-
operated nodes in the current sequence in the
Working view.

25325;
[00053635,
00055122,
00059463,
00062975,INC001
6253,
INC0016254,
INC0017802]

6.2.0.5.0055 N/A A GCC valid submission with the language
missing failed to import from eCTD. This issue is
resolved. Now, the eCTD import is completed
with no errors in the Job Requests even if there is
no information about the language. The system
uses English as the default language, and the
language folder name is the same as in the GCC
template.

25263;
[00052834]

6.2.0.5.0055 N/A GCC submissions containing multiple Cover
Letters could not be imported to Calyx RIM. This
issue is resolved.

23864;
[00039884,
00054020,
00055522,
INC0016252]

6.2.0.5.0055 N/A Using the Change Submittal Status wizard after
changing a folder extension in a later sequence
caused a reference error. This issue is resolved.
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Calyx RIM 6.2 CHF 6 Release Notes

This document describes a certified hotfix (CHF) provided to improve Calyx RIM 6.2.
In addition to enhanced features and functionality, Calyx RIM 6.2 CHF 6 resolves issues that were reported to
Technical Support. Our hotfixes are cumulative packages applied to a named version of our software.

As a certified hotfix, these updates have undergone Quality Control regression testing, certifying the system works as
expected. These changes will not create a new code branch, but will be identified by the updated build number on the
existing codeline of each version affected, not a new release number.

Overrides Updates
Calyx RIM 6.2 CHF 6 requires overrides updates. Please allow 6 to 8 weeks for XML overrides review and updates.
For details, please contact your Business Development Representative to consult with our Client Enablement team.

Regulatory Updates
Calyx RIM 6.2 CHF 6 provides the following regulatory updates:
— Support for JO eCTD Module 1 Version 1.1
— EAEU 1.0

• Formatted EAEU submission XML with embedded PDFs
• Output folder values and output file names are updated for the EAEU v 1.0 assembly template

Data Administration
Calyx RIM 6.2 CHF 6 provides the updated System Process Default Flag functionality with the ability to assign
several display statuses to the same Internal System Status in Data Administration for Registration Status
Values. When the status of a Registration is updated as a result of running a wizard, the status set as the System
Process Default Flag is used.

Withdraw Country Updates
It is now possible to withdraw a country from Centralized Procedure (CP) applications via the Product Details
Set.
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New Fields Added: Calyx RIM 6.2 CHF 6

The following table describes fields that were added with Calyx RIM 6.2 CHF 6.

Field
Name

Field Type Entity Name Description Business Rules

System
Process
Default
Flag

Drop-down list Data Administration
> Registration >
Registration Status
Values

If you assign several
display statuses to
the same Internal
System Status in
Registration Status
Values in Data
Administration, the
System Process
Default Flag enables
you to select the
display status to
show for Registration
when the Global
Project Plan >
Withdraw Package
Set Registration is
run.

You can use the
System Process
Default Flag to define
the display status in
the Name field. This
status shows after
the Event is closed,
provided that the
appropriate Internal
System Status is
mapped to that
display status.

List of Enhancements: Calyx RIM 6.2 CHF 6

Requested new features and enhancements are included in each release. The items are listed in descending order by
their tracking numbers. Customer case numbers that were recorded when the enhancements were requested are
included in brackets [#####] following the tracking number.

Issue Build Hotfix Build Description

26644 6.2.0.6.0007 N/A It is now possible to withdraw a country from
Centralized Procedure (CP) applications via the
Product Details Set. The withdrawn country is not
available to associate with a subsequent Event
(Countries list) created for the same Application.

26640;
[INC0044227
]

6.2.0.6.0007 6.2.0.5.0063 An EAEU submission XML with embedded PDFs could
fail validation in the Russian agency validation service
due to the absence of XML formatting. Now, Calyx RIM
Publisher produces formatted EAEU submission XML
with embedded PDFs.
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Resolved Issues: Calyx RIM 6.2 CHF 6

The following issues that were reported to Technical Support have been resolved. Issues are listed in descending order
by their internal tracking numbers. Customer incident numbers that were recorded when the issues were reported are
included in brackets following the internal tracking number.

Calyx RIM 6.2 CHF 6 resolves the following issues.

Issue Build Hotfix Build Description

26628;
[INC0042144]

6.2.0.6.0007 6.2.0.5.0060 The feature to define a leaf title value, configured
in the propertyMappings.xml file, worked for
the Working view but not for the Publishing view.
This issue is resolved.

26625 6.2.0.6.0007 N/A In the EAEU v 1.0 assembly template, some
output folder values were missing and some
output file names were incorrect. This issue is
resolved. Now, output folder values and output
file names are updated as required.

26624 6.2.0.6.0007 N/A After paper publishing an assembly, the View File
option did not work for the selected volume. This
issue is resolved.

26619 6.2.0.6.0007 N/A The System Process Default Flag was not
available for Registrations > License Status. A
workaround required you to use only one display
status (not multiple) mapped to one Internal
System Status value. This issue is resolved. See
New Fields Added: Calyx RIM 6.2 CHF 6.

26501;
[INC0025308]

6.2.0.6.0007 N/A When publishing JP submissions, the Delete
operation with default Folder Attributes: Study
Organization in XML: Leaf elements only - no
differentiation between studies did not show in
the index.xml file. This issue is resolved.

26476;
[INC0029689]

6.2.0.6.0007 N/A After the Product Family information and
metadata were moved from Calyx RIM to D2
LSRD, making changes to Product Family
Indications/Intended Use in Calyx RIM resulted
in the deletion of the Submission Country value
from D2 LSRD. In Calyx RIM, the application
continued to display the Reviewing Country. This
issue is resolved and the D2 LSRD shows all of
the necessary information.
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26424;
[INC0019435]

6.2.0.6.0007 N/A When an MRP or DCP Application country had
more than one associated product, and only one
product strength was being removed from that
country, the system withdrew the country from
the Application, leaving behind actively marketed
products/product detail sets for that country.
This withdrawal made the country unavailable for
selection on new Events. This issue is resolved so
that the countries with active products remain
active in the Application and available for new
Events.

Calyx RIM 6.2 CHF 6 Release Notes

© Calyx™ 2023. 213 Calyx RIM 6.2 Release Notes
Calyx.ai Resolved Issues: Calyx RIM 6.2 CHF 6



Calyx RIM 6.2 CHF 7 Release Notes

This document describes a certified hotfix (CHF) provided to improve Calyx RIM 6.2.
In addition to enhanced features and functionality, Calyx RIM 6.2 CHF 7 resolves issues that were reported to
Technical Support. Our hotfixes are cumulative packages applied to a named version of our software.

As a certified hotfix, these updates have undergone Quality Control regression testing, certifying the system works as
expected. These changes will not create a new code branch, but will be identified by the updated build number on the
existing codeline of each version affected, not a new release number.

Entity Comments
Calyx RIM 6.2 CHF 7 enables you to add comments for create/modify functions on Event - Country Status,
Sequence Status Date, and Task Status Dates:
— Event-Country Status Comments in Event- Country Attributes > Add/Modify-Country Event

Status.
— Sequence-Status Comments in View Sequence > Add/Modify Status.
— Task Status Comments in View Task > Add/Modify Status.

Regulatory Updates
— Support for US FDA eCTD M1 specification v.2.5, submission standards v.4.1:

• http:// is changed to https:// in DTD reference and stylesheets.
• US 3.3 assembly template updated to include additional folders and leafs.
• Application Form Type Values updated to include applicable Regulatory Codes.
• Filing Type updated with additional application types for grouped submissions.
• Form FDA 3988 and Form FDA 3938.
• REMS Supplement enabled for grouped submission in Data Administration.

— Support for Taiwan eCTD Module 1 v1.1 (DTD 1.0).

BREXIT
Calyx RIM 6.2 CHF 7 includes changes and fixes necessary to support BREXIT regulatory processes.
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New Fields Added: Calyx RIM 6.2 CHF 7

The following table describes fields that were added with Calyx RIM 6.2 CHF 7.

Field
Name

Field Type Entity Name Description Business Rules

Add
Comment

Text — Event-Country
Attributes >
Status Dates >
Add Event-
Country Status

— Event-Country
Attributes >
Status Dates >
Modify Event-
Country Status

When you create or
modify an Event-
Country Status, you
can add a comment
to it. These
comments can be
audited.

You can use this
option to record
comments for
create/modify
actions on Event -
Country Status,
Sequence Status
Date, and Task
Status Dates.
— Event-Country

Status Comments
in Event- Country
Attributes > Add/
Modify-Country
Event Status.

— Sequence-Status
Comments in View
Sequence > Add/
Modify Status.

— Task Status
Comments in View
Task > Add/
Modify Status.

— View Sequence >
Status Dates >
Add Status

— View Sequence >
Status Dates >
Modify Status

When you create or
modify a Sequence
Status, you can add a
comment to it. These
comments can be
audited.

— View Task >
Status Dates >
Add Status

— View Task >
Status Dates >
Modify Status

When you create or
modify a Task Status,
you can add a
comment to it. These
comments can be
audited.

List of Enhancements: Calyx RIM 6.2 CHF 7

Requested new features and enhancements are included in each release. The items are listed in descending order by
their tracking numbers. Customer case numbers that were recorded when the enhancements were requested are
included in brackets [#####] following the tracking number.

Issue Affected
Area

Build Hotfix Build Description

26747 Assembly 6.2.0.7.000
6

N/A Calyx RIM 6.2 now supports Taiwan eCTD
Module 1 Version 1.1.
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Issue Affected
Area

Build Hotfix Build Description

26700 Assembly 6.2.0.7.000
6

N/A US 3.3 assembly templates now support eCTD
specification v.2.5 and include:
— the updated xml generation to use https

instead of http in dtd reference and
stylesheet.

— two additional folders with US Forms
extension:
• 1.1.10 Form FDA 3988: Transmittal of

PMR/PMC Submissions for Drugs and
Biologics

• 1.1.11 Form FDA 3938: Drug Master File
— fdaft10 and fdaft11 Application Form Type

Values
— REMS Supplement Filing Type with NDA,

BLA and ANDA application types for
Grouped Submissions.

26698 Assembly 6.2.0.7.000
6

6.2.0.6.002
2

The EU National 3.0.3 template is now enabled
in the Сreate eCTD Wizard for the Great Britain
and United Kingdom regions .

26694 Assembly 6.2.0.7.000
6

6.2.0.6.002
5

User authentication is now introduced for
permission based access to OpenText Content
Server (formerly Livelink), SharePoint,
Documentum, and Secure File System
repositories when the following actions are
performed:
— View File on a document, leaf, or volume
— View File in Link Inspector
— Edit Document Links

If the user does not have sufficient
permissions to access the document in the
DMS, the user will not be able to access the
document via the user interface.

26688 Application 6.2.0.7.000
6

6.2.0.6.002
2

The Application UUID is now unique within a
regulatory region, instead of being unique
within the system.
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Issue Affected
Area

Build Hotfix Build Description

26686 Application 6.2.0.7.000
6

N/A You can record comments for create/modify
actions on Event - Country, Sequence Status
Date, and Task Status Dates.
— Event-Country Status Comments in Event-

Country Attributes > Add/Modify-Country
Event Status.

— Sequence-Status Comments in View
Sequence > Add/Modify Status.

— Task Status Comments in View Task > Add/
Modify Status.

Note: Comments on status are not modified/
deleted by Admin.

26682 XEVMPD 6.2.0.7.000
6

6.2.0.6.002
2

The XEVMPD Wizard is updated to support the
EMA XEVMPD requirement for BREXIT to
generate 'XI' as the Authorisation country code
in the EVPRM message for all United Kingdom
registrations.

26681 Application 6.2.0.7.000
6

6.2.0.6.002
2

The UUID field is now available on View and
Edit Application pages for the United Kingdom
and Great Britain regions.

26674 XEVMPD 6.2.0.7.000
6

6.2.0.6.002
2

The United Kingdom country is now available
for selection in the Country field in the
Authorized Product Selection tab of the
XEVMPD Submission wizard.

Resolved Issues: Calyx RIM 6.2 CHF 7

The following issues that were reported to Technical Support have been resolved. Issues are listed in descending order
by their internal tracking numbers. Customer incident numbers that were recorded when the issues were reported are
included in brackets following the internal tracking number.

Calyx RIM 6.2 CHF 7 resolves the following issues.
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Issue Build Hotfix Build Description

26790;
[CS0401640,
INC0058360]

6.2.0.7.0006 N/A When a Veeva document with overlay was
assigned to an assembly and the Prepare to
Publish query was run with the Generate Missing
Renditions and Extractions option selected, the
extract document data request failed to process
correctly. This issue is resolved. Now, the
extraction request is sent only if document with
overlay is updated since last data retrieval.

26789;
[INC0061160]

6.2.0.7.0006 N/A In FPP for Package Set Registrations with Yes
value for XEVMPD Submission Required? , after
processing the XEVMPD Acknowledgement, the
XEVMPD Submission Required? field did not
change its value to No. This issue is resolved.
After processing the XEVMPD Acknowledgement,
the XEVMPD Submission Required? field shows
as No. After the update of XEVMPD related fields
in FPP, XEVMPD Submission Required? field value
previously set up to No shows as Yes.

26784;
[INC0061598]

6.2.0.7.0006 N/A When nodes were updated in a Working view via
Mass Update Properties, the changes were not
applied to the Sequence and Publishing views.
The issue occurred for both common and
extended attributes of the node. This issue is
resolved. The changes made using Mass Update
Properties show in the Sequence and Publishing
views.

26778;
[INC0057113]

6.2.0.7.0006 N/A If a Veeva document was versioned before the
DMS cache timeout expired, the cached version
of the document was used during a DMS
Synchronization instead of the recently versioned
document. This issue is resolved. Now, the
system takes the recently versioned document
and processes it successfully.

26738;
[INC0056197]

6.2.0.7.0006 N/A For some of the OOTB and extra fields of the
newTextAreaView and adminTextAreaView
types, the length limit was broken in the UI and
after entering, the system showed only 50
characters in the UI. This issue is resolved.
Length in the UI is fixed and corrected for the
OOTB and extra fields to show more than 50
characters.
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Issue Build Hotfix Build Description

26705 6.2.0.7.0006 6.2.0.7.0002 Performance issue related to the Synchronize
with the Submitted View job resulted in a
timeout. Changes have been made to the
synchronization mechanism and now the job
request passes with efficiency.

26692 6.2.0.7.0006 6.2.0.6.0023 A mismatch between a Publishing Settings
database sequence used by the code and the
database sequence used in the corresponding
database function caused the following error:
ORA-00001 : unique constraint
(ODS.PKSLIP_SETTING) violated. This
issue is resolved. The database function is
updated to use the same database sequence the
code uses and ensuring that the sequence values
are unique going forward.

26687;
[INC0033088,
INC0030024]

6.2.0.7.0006 6.2.0.6.0009 The variables specified in the Default Values
section of the Publishing Settings Library failed to
resolve in the submission output if an assembly
root was not selected during publishing.
However, the variables set in places such as leaf
properties resolved successfully. This issue is
resolved. Now, the variables specified in the
Default Values section of the Publishing Settings
Library are resolved.
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Issue Build Hotfix Build Description

26675 6.2.0.7.0006 6.2.0.6.0022 Timeline/Event Plans did not work as expected
when adding or removing a country from an
existing Event Plan for MRP, DCP, or CP Procedure
Types. Countries already associated with the
existing Timeline/Event Plan were incorrectly
listed in the Countries Available box and were not
available in the Copy Default Lead Times from the
following Country drop-down list. Also, when
deleting countries from an Event Plan, no
countries were listed in the Associated with Plan
area. These issues are resolved to support the
requirement for BREXIT. Now, the Timeline/
Event Plans work as expected when adding or
removing a country from an existing Event Plan
for MRP, DCP, or CP Procedure Types. Countries
already associated with the existing Timeline/
Event Plan are correctly listed in the Countries
Available box and are also available in the Copy
Default Lead Times from the Following Country
drop-down list. When deleting countries from an
Event Plan, countries are now listed in the
Associated with Plan area.

26673 6.2.0.7.0006 6.2.0.6.0022 When Northern Ireland (XI) was added to the EU
Region in Data Administration, the XEVMPD
wizard did not recognize it and showed a warning
message. This issue is resolved. Now, the new
Northern Ireland country is recognized as an in-
scope country with a country code of XI for an
XEVMPD submission to support the EMA XEVMPD
requirement for BREXIT.

26672 6.2.0.7.0006 6.2.0.6.0022 After Northern Ireland was added as a new
country for EU CP registrations and an existing EU
CP application, it was not available for selection
when adding a country in the Registration
Package Set. This issue is resolved. Now,
Northern Ireland is listed as a country for
selection for Registration Package Set.

26670;
[INC0045661]

6.2.0.7.0006 N/A An EAEU published submission output contained
incorrect values in the
<hcsdo:RegistrationFileIndicator> tag.
This issue is resolved.
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Issue Build Hotfix Build Description

26477;
[INC0023763]

6.2.0.7.0006 N/A After Product Family information with its
metadata was updated and then moved from
Calyx RIM to D2 LSRD, subforms on the
Properties tab were empty for the Application in
D2 LSRD. When the Application information was
updated separately in Calyx RIM, subforms on
the Properties tab contained the appropriate
information. This issue is resolved. The Properties
tab of D2 LSRD Application shows correct
information when you update a Product Family or
an Application in Calyx RIM.
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Calyx RIM 6.2.8 Release Notes

This document describes the updates in Calyx RIM 6.2.8 for Сhina specification and Microsoft Graph API
implementation.

Regulatory Updates
Support for China (CN) eCTD Module 1 version 1.0 (dated 29 September 2021).

Microsoft Graph API
Microsoft Graph API is implemented for Calyx RIM 6.2.8 and replaces the Azure AD Graph API used by previous
Calyx RIM 6.2 versions to query users and groups from AAD. The Azure AD Graph API is no longer supported. The
changes include the following:
— Removal of all Azure AD Graph API calls from application logic.
— Transition of all Azure AD graph calls to Microsoft Graph API methods for groups and users and any other

methods currently used.

Resolved Issues: Calyx RIM 6.2.8

The following issues that were reported to Technical Support have been resolved. Issues are listed in descending order
by their internal tracking numbers. Customer incident numbers that were recorded when the issues were reported are
included in brackets following the internal tracking number.

Calyx RIM 6.2.8 resolves the following issues.

Issue Build Hotfix Build Description

26825 6.2.0.8 N/A EAEU: If the Drug Registration Document Code
field had a value in a submission, the Drug
Registration Document Name was not included in
the index-r-022.xml file after publishing. The
Drug Registration Document Name was also not
saved in the leaf after an eCTD import. The issue
is resolved. Now, both Drug Registration
Document Name and Drug Registration
Document Code are included in the index-
r-022.xml file after publishing and in the leaf
after an eCTD import.
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Issue Build Hotfix Build Description

26768;
[INC0058320]

6.2.0.8 N/A The /all and /query endpoints did not work via
API for the package set registration, product
registration, full product presentation, package
set - country entities and resulted with an error.
This issue is resolved. The following endpoints
work correctly via API:
— /insight/api/v2/license/packageset-

registration/all
— /insight/api/v2/license/product-

registration/all
— /insight/api/v2/license/full-product-

presentation/all
— /insight/api/v2/license/packageset/all
— /insight/api/v2/license/packageset/country/all
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Calyx RIM 6.2.9 Release Notes

Updates in Calyx RIM 6.2.9 for EAEU.

Regulatory Updates
EAEU v1.0:
— The index-r-022.xml file now includes new checksum attributes to conform to EAEU v1.0 eCTD

requirements.
— Publishing functionality is updated with the checksum information in index-r-022.xml for each document.

The checksum attributes are removed for EAEU XML with embedded PDFs during the export and import of
EAEU submissions.

— The Export Publish Output page is updated to get the copy of submission without checksums with the help of
the XML without checksum option.

Database and Additional Configuration
No changes have been made to the database and Azure AD configuration. Therefore, the Calyx RIM 6.2.9
Database Server Installation Qualification and Azure Active Directory
Configuration IQ scripts are not available on the Calyx RIM 6.2.9 IQ Scripts page.

Functionality and Technology Removed
SharePoint and Open Text Content Server (Livelink) DMSs are no longer supported in Calyx RIM.

Prerequisites
A new Calyx RIM Rendering license file must be installed in order to support the new EAEU request.

Note: For installation assistance, please contact your Business Development Representative.

Entity Fields Updated: Calyx RIM 6.2.9

The following table describes fields that were updated with Calyx RIM 6.2.9.

Field
Name

Field Type Entity Name Description Business Rules

Embed
PDFs into
EAEU
XML?

Box This field is renamed
to EAEU Output and
updated to the list
with the Embed PDFs
and XML without
checksum options on
the Export Published
Output page.

EAEU Output You can use EAEU
Output to export
EAEU submissions.
See: Calyx RIM Best
Practice: EAEU
Submissions.
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Calyx RIM 6.2.10 Release Notes

This document describes a sub-minor release provided to fix one or more defects found in the previous versions of
Calyx RIM 6.2.
The Quality Control team performed first product install and regression testing on this sub-minor release.

Resolved Issues: Calyx RIM 6.2.10

The following issues that were reported to Technical Support have been resolved. Issues are listed in descending order
by their internal tracking numbers. Customer incident numbers that were recorded when the issues were reported are
included in brackets following the internal tracking number.

Calyx RIM 6.2.10 resolves the following issues.

Issue Build Hotfix Build Description

DE28913
[INC0136665,
CS0629164,
PRB0044005]

6.2.0.10.000
1

N/A After updating Oracle from 19.16.0.0.220719 to
19.17.0.0.221018 version, a column ambiguity
error occurred when using the XEVMPD
Submission wizard. This issue is resolved. Now,
you can use the XEVMPD Submission wizard
without errors.

DE28427
[INC0102271,TAS
K0042192]

6.2.0.10.000
1

N/A API: It was not possible to update a PDS that was
already assigned to a new Event. This issue is
resolved. Now, a PDS can be updated even if it is
already assigned to a new Event.
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Calyx RIM 6.2.11 Release Notes

This document describes a sub-minor release provided to fix one or more defects found in the previous versions of
Calyx RIM 6.2.
The Quality Control team performed first product install and regression testing on this sub-minor release.

Resolved Issues: Calyx RIM 6.2.11

The following issues that were reported to Technical Support have been resolved. Issues are listed in descending order
by their internal tracking numbers. Customer incident numbers that were recorded when the issues were reported are
included in brackets following the internal tracking number.

Calyx RIM 6.2.11 resolves the following issue.

Publishing

Issue Build Hotfix Build Description

DE30161 6.2.0.11.000
5

N/A After publishing the EAEU assembly and
recalculating checksums, the index-
r-022/xml file was generated in the //file
system/Folder1 location instead of //file
system/Folder1/Folder2. The checksums
were also not updated for the documents added
to the assembly. This issue is resolved.

DE29791
[INC0088918]

6.2.0.11.000
5

N/A When an EAEU submission was published after a
leaf was deleted, the attributes CHECKSUM and
CHECK_ALG were included in the
<hccd:RegistrationDossierDocDetails> element.
This issue is resolved. Now, the CHECKSUM and
CHECK_ALG attributes are not included in the
<hccd:RegistrationDossierDocDetails> element.
Also, now in the index-r-022.xml file, the
CHECKALG attribute is generated as
CHECK_ALG.
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Clarification of Behavior

Some instances of functionality are reported as an issue, but are in fact working as designed. Information about
system behavior observed during testing that is not an issue, but of which Calyx wants you to be aware, is also
included. The explanations contained here will be added to the product documentation at the earliest opportunity.

The following are clarifications of behavior for Calyx RIM 6.2.

Issue Calyx RIM®

Version
Description

26683;
[INC0042848
, CS0283604]

Calyx RIM 6.2
CHF 5

When publishing a Job Request, the status message Completed
with no errors or warnings shows at the top of the page, even
though the job is still running.
Workaround: While the publish job is in progress, you can see the
Completed column of the table to verify Completed=True for each
row. When the job is completed, refresh the Details window to see the
correct status message.

26642 Calyx RIM 6.2
CHF 4

Assembly files created by exporting an assembly to the Assembly File
(XML) on versions of Calyx RIM starting with 6.2 CHF 4 cannot be
imported to Calyx RIM versions 6.2 CHF 3 and earlier.

26518;
[INC0028282
, CS0199557]

Calyx RIM 6.2
CHF 3

When using the Google Chrome or Microsoft Edge web browsers,
selecting documents in the Browse Documents > Assign Document
window sends the Browse Documents window to the background
(behind the Assembly window), making a user activate the window for
subsequent document assignment.

26418 Calyx RIM 6.2
CHF 3

Duplicating Browser Tabs: Prior to Calyx RIM CHF 3, duplicating a
browser tab of an active Calyx RIM session DID NOT require login for
the duplicated session created on the new tab. From Calyx RIM CHF 3
onward, duplicating a browser tab of an active Calyx RIM session
WILL require login for the duplicated session created on the new tab.

N/A Calyx RIM 6.2
CHF 1

Performing any actions from Calyx RIM 6.2 CHF 1 against a Veeva
repository on limited release version 18R2.2 will result in an
exception caused by an unexpected error response from Veeva Vault.
If you experience this issue, please contact Veeva Support.

25662;
[00057090;
00057174]

Calyx RIM 6.2 For the EU eCTD Module 1 Specification Version 3.0.3, it is
recommended to use the Import Assembly wizard if there is a
working assembly created from the EU version 3.0.1 and the 1.2
Application Form section exists. The Create eCTD wizard will not
update the existing 1.2 Application Form section to be compliant with
the 3.0.3 version structure.

Clarification of Behavior

© Calyx™ 2023. 227 Calyx RIM 6.2 Release Notes
Calyx.ai Resolved Issues: Calyx RIM 6.2.11

https://support.veeva.com/hc/en-us


Issue Calyx RIM®

Version
Description

24987;
[00048397,
00050948,
00054137,
00054290,
00055315,
00055766]

Calyx RIM 6.2 If you are using network security products to scan your local intranet
hosts for vulnerabilities, be aware that these products have a specific
scan used against a JBoss server at TCP/IP port AJP/8009. Scanning
the Calyx RIM server with a network security product will cause an
outage, requiring a restart. To avoid issues caused by network
security scanning products, see Firewall Rule for TCP_IP Port
AJP_8009 in the Calyx RIM Installation Guide.

24513 Calyx RIM 6.2 When searching against a Veeva repository using DMS Search in Calyx
RIM, an error may appear about exceeding the API calls limit. By
default, Veeva Vault has an API burst limit of 2,000 API calls within a
5-minute period, and 100,000 API calls daily. These limits help to
prevent runaway script scenarios (e.g. where the logic creates an
infinite loop that continuously calls the Vault APIs). To request an
increase to this limit, please contact Veeva Support.

N/A Calyx RIM 6.2 For opening and viewing published XML files, Calyx recommends
using the Microsoft Internet Explorer Web browser. Although Calyx
RIM 6.2 supports other Web browsers (Google Chrome and Microsoft
Edge), opening published XML files is best accomplished using
Internet Explorer.
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Known Issues

The following general issues and module-specific issues were known at the time this document was published.

The following are known issues for Calyx RIM 6.2.

Issue Build Resolved in Description

26807
(Added on 20th
Aug 2021)

6.2.0.7.0007 N/A When updating a leaf in an assembly, selecting
OnLoad for the Actuate option results in an error
message. This is because of the default security
settings. Workaround: Update the leaf using API.

26799 6.2.0.7.0003 N/A After you use the Bulk eCTD Import for TW
submission, the Job Status is set to Scheduled
instead of Completed. This is because the tw-
regional.xml file does not contain the application
code.
Workaround: Use Import eCTD to Application
instead of Bulk eCTD Import. See: Import eCTD to
Application.

26784;
[INC0061598]

6.2.0.6.0007 N/A When nodes are updated in a Working view via Mass
Update Properties, the changes are not applied to
the Sequence and Publishing views. The issue
occurs for both common and extended attributes of
the node.
Workaround: Use the same values for the Mass
Update Properties attributes for both Working and
Publishing views.

26637;
[INC0045216]

6.2.0.5.0055 N/A In Data Administration, the Check for Date-based
Notifications menu is not available on the
Notification Specifications grid.

26604;
[INC0037291]

Calyx RIM 6.2
CHF 4

N/A Before Calyx RIM 6.2 CHF 4, a session time-out
would return you to the login window. Now, a
session time-out shows the message, "You do not
have the appropriate privileges to access the
requested resource" instead of the login window.
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Issue Build Resolved in Description

26561;
[CS0156826]

6.2.0.5.0055 N/A After running the GPP Calculate Projected Dates
wizard, the Target Submitted column value is not
updated. This happens if multiple display statuses
are mapped to the same Internal status. As a
workaround, use only one display status (not
multiple) mapped to one Internal System Status
value.

26476;
[INC0029689]

6.2.0.5.0055 6.2 CHF 6 After the Product Family information with its
metadata is moved from Calyx RIM to D2 LSRD,
making changes to Product Family Indications/
Intended Use in Calyx RIM results in the Submission
Country value getting deleted in D2 LSRD. The
application in Calyx RIM continues to display the
Reviewing Country.

25259;
[00052856]

6.1.0.3.0084 N/A When modifying Applicant Contact Values for M1 in
a US 3-3 assembly, if you Deselect a value it does
not re-appear in the selection box. As a workaround,
you must save an entry with other contact values
and then edit M1 again and select the Applicant
Contact Value.

25084;
[00051037,
00052759,
00056925,
00058862]

6.1.0.0.0112 N/A Deleting large applications or removing multiple
sequences from a lifecycle can take much longer
than expected to produce results.

24019 6.0.0 6.0 CHF 2 eCTD import of a US v2.3 (DTD v3.3) application
containing sequences submitted as part of a
grouped submission is not supported.

22716;
[00028730]

5.0.4 N/A A hyphen "-" in the service account name prevents
the ability to use that service account when adding a
SharePoint repository.

20270;
[136797FW]

4.1.1 N/A Links for External Bookmarks are incorrect for split
documents in paper published output.
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Access the Customer Service Portal

If you have issues when working in the system that you cannot resolve with the Help documentation, you can access
the Service Portal to view knowledge articles or log a support ticket.

To access the Service Portal:
1. Navigate to mytrials.com.

The Perceptive MyTrials log in page appears.
2. Enter your user name and password, and click Log On.

If you do not have a Perceptive MyTrials account, click Join Perceptive MyTrials and register. Perceptive
MyTrials confirms your account with an email.
The home page appears.

3. Do one of the following:
— Click Customer Care at the bottom of the page.
— In the My Weblinks portlet, click Customer Service Portal.

The home page for the Service Portal appears. You can browse and search for the information you need.

Access the Customer Service Portal
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